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Specifications

Maximum layer count
Via rules

Materials library
On-line and on-premise

Post press compensation
Finished thickness compensation
Stackup calculation

Drill types
Drill-via fill types

Back drill types

Design rules check

Si8000m/Si9000e integration
Flex-rigid modelling

Controlled impedance structures
Symmetrical stacks
Loss/Frequency dependent

modelling/graphing
Frequency dependent calculations

Causal interpolation of dielectric
constant

Result presentation
Display series

Surface roughness compensation
File import

File export

128+

Conventional, blind and buried

Foils, Cores, RCC foils, Non-copper cores, Prepregs,
Solder masks, Flexible cores, Bondply, Adhesive,
Coverlays, Shields, Ident inks, Peelable masks

Yes (user defined)

Copper coverage / simple percentage

Copper thickness, stackup thickness, dielectric
thickness, solder mask thickness

Mechanical, Laser, Laser stacked, Through plated
Copper, Resin, Solder Mask, Non-Conductive,
Conductive, Sintering Paste, Copper Paste

Pointed, Flat, Router. Capped drills

Back Drill Must Cut Layer N°, Back Drill Must Not Cut
Layer N°, Back Drill Minimum / Maximum Distance from
Cut Layer, Primary Drill Size

Design logic, symmetry, copper balance, board
thickness, manufacturing tests, resin starvation
Bi-directional copy/paste structure parameters
Mesh/crosshatch ground plane modelling in conjunction
with Polar Si8000m/Si9000e

100+ structures supported with impedance goal seeking
and structure validation

Structure mirroring for symmetrical stacks

Differential, Odd mode, Even mode graphed over a user-
specifiable frequency range

Single ended: Impedance, Delay, Inductance,
Capacitance, Effective Dielectric Constant, Velocity of
Propagation

Differential: Differential / Odd / Even / Common Mode
Impedance, Odd Mode Delay, Effective Dielectric
Constant, Velocity of Propagation, Near-end Crosstalk,
Coupling Percentage

Single frequency Er causal modelling — interpolation of Er v
frequency using Svensson-Djordjevic method

Length of line, Inches, Metres

All Losses, Impedance Magnitude, Inductance,
Resistance, Capacitance, Conductance, Alpha, Beta

Smooth, Hammerstad, Groisse, Gradient, Huray,
Simonovich-Cannonball

IPC-2581 Rev B, Ucamco Job file, Ucamco Integr8tor
and Ucam (.ssx), XML STKX and SSX, Zuken CR-8000

CGen Coupon Generator, CITS File, Cadence Allegro
(IPC-2581 Rev B), CSV, DXF, Gerber, IPC-2581 Rev B,
Mentor Graphics, v10.00, Stackup Image (JPEG, BMP,
TIFF), Ucamco Integr8tor and Ucam (.ssx), XML STKX
and SSX, Zuken CR-8000, Zuken DFM Center,

Specifications e i
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Personal Computer Requirements

Computer

Processor

Operating system
Environment

System memory required
Hard disk space required
Video standard

Licensing

IBM PC compatible

Pentium 1GHz or better

Windows 10 ® or later

Requires .NET Framework v4.8 or above
2GB (min) 8GB recommended

200MB (min.)

FHD (1920 x 1080%)
2 FHD (1920 x 1080*) monitors recommended

* Note: refers to effective resolution (some
systems automatically apply scaling to render text
readable — i.e. effective resolution refers to the
screen resolution after scaling.)

Electronic: local FlexNet Publisher license
Fixed: Parallel/USB key

Floating: FlexNet Publisher license
(Windows servers only)
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Guide to the manual

Introduction

Getting started with
Speedstack

Configuring Speedstack

Using Speedstack

Design rule checking

Adding controlled impedance
structures

Frequency dependent
calculations (Speedstack Si)

Si Projects

CITS test files
Speedstack Flex
Speedstack HDI

The Speedstack materials

libraries

Printing stackup reports

Introduces Polar Instruments Speedstack.

Steps through the process of creating a simple stack
from a set of manufacturer's data.

Setting up the Speedstack environment including
license options, crosshatch and structure defaults, goal
seeking parameters and file locations.

Discussion of the Speedstack user interface; creating
and editing stackups.

Using Virtual Material mode; using Material Library
mode

Using the Speedstack Design Rule Checker to correct
stackup design errors.

Working with the Polar Si8000m/Si9000e Field Solvers
to add controlled impedance structures to the stackup
model. Using the goal seeking facilities of the field
solver to obtain the correct impedance for a structure.

Working with frequency dependent calculations to
produce graphs and tables of insertion loss v frequency
for each stack substrate.

Using causal modelling
Using surface roughness compensation

Working with Si Projects in Speedstack with Si8000m
and Si9000e

Creating CITS test files for controlled impedance
structures in the stack

Working with flex-rigid stackups — using the Speedstack
Flex Navigator

Working with HDI builds — sequential lamination

Using the Speedstack materials libraries, creating new
libraries, adding material to the library. Accessing the
online libraries

Printing Speedstack technical reports; using the stack
data tables, drill data tables, controlled impedance data
tables, bill of materials tables and frequency dependent
tables and loss graphs

Guide to the manual e iii
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Introduction to Speedstack

Speedstack PCB Stackup Builder

Polar Instruments Speedstack PCB Stackup Builder is
designed to accelerate the PCB stack design process and
deliver significant reductions in the amount of time consumed
in PCB stackup documentation and control. Given designer
specifications, the PCB fabricator can use the Speedstack
Stackup Builder to create in just a few steps the most cost
effective stack for the range of available materials.

Speedstack offers interconnect designers (PCB layout
engineers), PCB front-end engineers and fabricators a fast
and professional solution to layer stackup creation and
documentation. Speedstack provides formal documentation
for everyone involved in ensuring the correct materials are
used in the build process.

Speedstack PCB

Speedstack PCB is a versatile PCB layer stackup design tool
featuring powerful and easy to use graphical stackup editing
capabilities. For PCB fabricators Speedstack PCB interfaces
with the industry standard Polar Si8000m PCB Multiple
Dielectric Controlled Impedance Field Solver.

Lossless calculations

Speedstack PCB includes a link and license for the Si8000m,
using the proven Si8000m to provide the impedance data for
the stack. In addition, Speedstack PCB licence holders have
full access to the stand alone Si8000m Quick Solver.

Speedstack PCB is especially tailored for PCB fabricators
and PCB brokers — anyone with a requirement to design or
communicate controlled impedance PCB stackups.

Speedstack PCB customers are able to share stackups and
read impedance requirements from designers who are using
Speedstack Si PCB Insertion Loss Field Solver.

Speedstack Si

For electronic engineers involved in stackup design
Speedstack Si interfaces with the Polar Si9000e PCB
Insertion Loss Field Solver. Bidirectional copy and paste
between Speedstack and the Si9000e insertion loss field
solver allows for quick transfer of structure parameters.

Bidirectional copy and paste between Speedstack and the
Si9000e insertion loss field solver allows for quick transfer of
structure parameters.

Introduction to Speedstack ¢ 1
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Loss calculations

Speedstack Si includes a link and license for the Si9000e,
using the Si9000e to provide impedance and loss data for
the stack. Speedstack Si licence holders have full access to
the stand alone Si9000e Quick Solver.

Frequency dependent calculations

Speedstack Si caters for frequency dependent calculations
including insertion loss, which can be graphed over a user-
specifiable frequency range. Frequency dependent structure
properties allow for trace conductivity, frequency range and
US / metric / length of line result presentation modes: Loss
results are in dB/inch, dB/m or dB/LL (length of line.)

Calculations include
Single ended:
e Impedance
e Delay
e Inductance
e Capacitance
o Effective dielectric constant
e Velocity of propagation
Differential:
¢ Differential impedance
e 0Odd mode impedance
e Even mode impedance
e Common mode impedance
e Odd mode delay
o Effective dielectric constant
e Velocity of propagation
e Near end crosstalk (NEXT)
e Coupling percentage.

Calculations are included on printed technical reports which
optionally also include insertion loss graphs for user-
nominated structures.

Causal modelling

Frequency dependent parameters include length of line,
trace conductivity, dielectric constant and loss tangent,
frequencies of interest and causal extrapolation points for
each substrate and also support amalgamated dielectric
structures. Frequency dependent calculations employ causal
interpolation of dielectric constant using Svensson-Djordjevic
modelling. Library materials tables include dielectric constant

2 o Speedstack PCB Stackup Design and Documentation
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and loss tangent fields and substrate causal extrapolation
reference points values may be set either manually or
automatically from the library (virtual material mode supports
loss tangent in laminates and soldermask.)

Surface roughness modelling

Speedstack includes surface roughness compensation in
frequency dependent calculations, supporting Hammerstad,
Groisse, Gradient, Huray and Simonovich-Cannonball-
surface roughness modelling methods.

Creating CITS (Controlled Impedance Test System) files

Both Speedstack Si and Speedstack PCB are able directly to
output controlled impedance test files (CITS) associated with
each stackup for CITS controlled impedance board testing.
The fabricator can link the impedance test requirements to a
particular job. For the OEM this offers a clear method of
sending impedance test specifications out to suppliers or
brokers. Designers and fabricators can then select the best
material combinations for minimising build costs. Fabricators
can share their in-house material libraries with OEMs and
ensure the most effective material choice is used in the build.

Speedstack Flex

Speedstack Flex allows OEM designers to create accurate
and efficient flex-rigid PCB stackups in just a few minutes,
with error-free documentation for tighter control over the
finished board. For PCB fabricators, Speedstack Flex
provides the flexibility to quickly calculate the impact of
substituting alternative materials to improve manufacturability
and reduce cost while maintaining the specified parameters
and performance of the board. Speedstack Flex can be used
in conjunction with the Si8000m and Si9000e field solvers
when modelling and documenting mesh/crosshatch ground.
Structure data and mesh geometry can be readily shared
between Speedstack and the field solvers.

Speedstack Navigator

The Speedstack Navigator provides a clear contextual view
of the rigid and flexible stacks within a flex-rigid build and
allows easy alignment of displayed materials between
stacks. The associated technical report also supports
different materials on the same dielectric layer, improving the
clarity of documentation between the stackup designer and
the fabricator.

Speedstack HDI

Speedstack’s Navigator quickly guides you through the

sequential sub-stack lamination sequence and presents the
complete assembly in a parsed graphical display that shows
each phase of the multi-step lamination sequence of an HDI

Introduction to Speedstack ¢ 3
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PCB. There is no limit to the number of press cycles that can
be documented.

Resin check / excess resin algorithms determine the order in
which the materials are pressed together and return useful
resin percentage information that can be used to determine
potential de-lamination problems.

User-definable settings within the Navigator allow engineers
to display layers in transparent, invisible or 3D mode.
Speedstack HDI makes re-ordering and renaming sub-stacks
quick and easy with the Navigator. This is especially useful
for HDI constructions.

Rapid stackup creation

Users may specify the stackup semi-automatically with the
powerful Stackup Wizard or alternatively build the stack
manually, layer by layer. Speedstack is flexible and allows
full manual editing of stacks created by the Stackup Wizard.

Easy stackup editing

The Speedstack offers 2D and 3D stackup view. Layer and
material annotation is clear and easy to read; each layer may
be selected and queried to display the associated material
type and properties, including the associated data file. Visible
drill information ensures that designers instantly know which
layers support conventional, blind and buried vias.

Speedstack allows you rapidly to build and share stacks and
verify via aspect ratios and track spacing rules. The stack file
contains base material information — with layer description
and a list of all transmission line structures deployed in the
stack. Keeping all stack information in one file ensures that
manufacturing data is accurately shared between original
designer and fabricator.

Speedstack’s Stack Editor provides efficient and time-saving
features such as Copy/Paste Material properties so the stack
designer can copy all properties from a selected material and
then paste user-selectable property groups to other materials.

Speedstack allows the designer to retain and re-allocate
structures when changes are made to the electrical layers of
the stackup. This enables reallocation of structures after the
following stackup changes:

Adding and deleting foils and/or cores — increasing or
reducing the layer count

Moving foils and cores — maintaining the layer count
Exchanging two different thickness cores within the stack
Copying/pasting foils or cores — increasing the layer count

4 ¢ Speedstack PCB Stackup Design and Documentation
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High quality documentation and file format

Speedstack saves the stack in efficient electronic format and
outputs stack graphics in formats to suit your requirements.
Stack data may be output in GERBER, DXF, BMP, JPEG,
TIFF and XML. Stack data can also be exported in comma-
separated form for inclusion in other systems. Speedstack’s
high quality customisable printouts make it easy to discuss
alternate builds and pricing impacts with fabricators.

Applications engineers, front end and production engineers
benefit from receiving stack information in an intuitive, easy
to understand format. The Speedstack .sci file contains full
details of the layer stackup of a particular job. If changes are
necessary or preferred stacks are to be shared with
customers, Speedstack can cut the time for documentation
and information sharing to a fraction of the time taken when
employing traditional methods such as spreadsheet, word
processor or presentation software.

Integration with the Si8000m/Si9000e

Speedstack is fully integrated with the Polar Si8000m
Controlled Impedance and the Si9000e PCB Transmission
Line Field Solvers so the user can quickly add controlled
impedance structures to layers in the stackup. The designer
or board fabricator can use the Goal Seek facility of the
Si8000m/Si9000e field solvers to arrive rapidly at the
controlled impedance structure parameters to produce the
target impedance.

Materials library

Speedstack supports a flexible materials library. This allows
the designer to use standard materials data and also
provides the facility to create new material libraries. PCB
fabricators can also build libraries of commonly stocked
materials to give interconnect designers visibility of the
materials held in stock. Speedstack thus supports three
types of library — custom user libraries of materials, generic
designer libraries of materials of given dielectric
characteristics (for example, thicknesses) along with a
comprehensive set of materials libraries from PCB base
material suppliers who are members of the Polar Speedstack
Material Partner program.

Online / on-premise materials libraries

The Speedstack Material Library includes an online library to
allow users to download material library MLBX files from the
Polar website. The online material library feature provides
the user with a list of available library files from suppliers in
the Speedstack Material Library Partner program.

Introduction to Speedstack ¢ 5
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Library filtering

Materials can be filtered by supplier and by the frequency at
which the dielectric constant and loss tangent (Dk and Df) are
specified. On selection the file is downloaded and is either
appended to the existing data or replaces the existing data.

On-premise material library

Speedstack also includes an on-premise option to allow the
complete online library to be downloaded to a local folder for
on-premise access; customers on Polarcare support who
cannot connect to the online library due to network security
restrictions can request a copy of the most recent library;
contact polarcare@polarinstruments.com with your Polarcare
contract number to obtain the latest material library.

Speedstack’s Virtual Material mode

Speedstack provides Virtual Material mode, allowing you to
build and experiment with stackups (for example, to examine
the effects on impedance structures of different trace widths
or dielectric heights) without requiring real materials to be
entered into a materials library.

In Virtual Material mode you will use the Stackup Wizard to
enter a few details about the stack, the number of layers,
overall board thickness, plane and mixed layers, etc., along
with solder mask and copper thickness and build type (foil,
core or HDI) and drills.

Speedstack will then build a stack to the specified board
thickness by equally distributing the dielectric regions. If a
preferred core thickness is specified the software will
maintain the dielectric thickness for core regions but then
equally distribute prepreg regions to reach the target board
thickness.

Preferred builds

PCB fabricators are able to create and share preferred builds
and exchange the associated information with designers.
Build data also includes blind and buried via specification.
This simplifies the task of sharing stackup and drilling
information between board shops and the design community.

Dimensional information

Finished board thickness is a critical dimension in many
applications; Speedstack keeps track of the finished PCB
thickness and tolerance and allows fabricators the flexibility
of adding in-house post-press thickness for prepreg layers.
Additionally, Speedstack takes into account plating thickness
where appropriate.
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High layer count boards

On boards with high layer counts it can be very easy to make
a change that would produce a non-symmetrical stack. The
Speedstack Design Rules Check monitors symmetry across
the stack, and ensures that material symmetry is maintained.
Speedstack also makes it easy to set the symmetrical build
mode to ensure that any changes you make are applied
equally across the stack.

Supplier management

When multiple-sourcing PCBs or when moving from
prototype to volume production, the stack and fabrication
design rule checks ensure that the manufacturing capabilities
of your chosen suppliers are not overlooked. In addition, the
professional documentation output ensures that layer stack
information is accurately conveyed to PCB suppliers.

Graphical interface

Speedstack offers an easy to interpret graphical interface.
Clearly showing the layers supporting blind and buried vias,
Speedstack also records the data file for each layer
(including ident and peelable mask layers). The graphical
interface is especially designed to simplify the process of
communication between interconnect designer and
fabricator. OEMs who need to manage boards sourced from
multiple suppliers will also find this facility invaluable. In
addition to physical layers Speedstack adds mask and
notation for electrical layers.

Grid View

Speedstack’s Grid View provides a single grid-based dialog
where all materials can be edited from the same screen. This
allows the user rapidly to change the properties of multiple
materials and apply all the changes simultaneously. Editable
fields include Layer Name, Description, Dielectric Constant,
Loss Tangent, Processed Thickness and Copper Coverage.

The tabular data in Grid view can be exported to Microsoft®
Excel® for editing and the edited version imported from
Microsoft Excel into Grid View. Changes made in Grid View
are reflected in the main Stackup Editor and can be saved
back to the original stackup design.

Structure View

Structure View presents an interactive overview of the
controlled impedance / insertion loss structures that exist on the
stack up, offering enhanced visibility of all impedance
structures from the main edit view. Positioned to the right of
the stack up within the Stack Editor window, structures are
aligned with the stackup electrical layers on which they have
been defined.

Introduction to Speedstack o 7
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Interfacing with other systems

Speedstack is able to load an XML file on launch. If an XML
file (.stkx) filename parameter is specified on the command
line it will import this file into Speedstack.

Speedstack can call an external program / utility / script via
the External Utilities menu options. The menu items are
configured within the Configuration option.

Importing and exporting stackup information
IPC-2581 Rev B

Speedstack incorporates Import from and Export to IPC-
2581 Rev B option with interactive interface, supporting
stackup material and structure information

Ucamco

Speedstack incorporates the facility to read in files in XML
format and Ucamco Job File format, providing comprehensive
integration with Ucamco and will import files from and export
to both Ucam and Integr8tor.

Zuken

Speedstack integrates directly with the Zuken CR-8000
Design Force and Zuken Design Force DFM Center PCB
manufacturing pre-processing and CAM system, simplifying
material communication in the supply chain. Designers can
define layers in DFM Center then export to Speedstack to
define materials and provide a fully documented stackup in a
format widely recognised by both PCB supply chain
managers and fabricators.

Stacks may be exported to the Polar CGen Coupon
Generator for subsequent processing into test coupons. The
Export CITS File option will create test files for Polar CITS
controlled impedance test systems. Speedstack can
generate printed output in DXF, Gerber, CSV and XML, as
well as graphic image formats JPEG, BMP and TIFF.

Export options also include Cadence Allegro, CSV, IPC-2581
Rev B and Mentor Graphics.Import / export XML file formats
support frequency dependent structure properties.

Converting imported electrical layers to cores

When importing stackup data from some CAD / CAM
systems only the electrical layers are defined, so copper
layers may appear adjacent each other. Speedstack allows
conversion of two adjacent electrical layers into core or
flexible core materials using the Convert to Core function.

Structure net classes

Speedstack is able to import and store up to five net class
names with each structure. These net class names provide a
link to the matching impedance nets inside the ECAD PCB
layout system.
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Installing Speedstack

Installing and activating Speedstack

File Explorer

Settings

Power

I

m

It will be necessary to install and activate the product license
and set operating options prior to building stacks or
performing calculations with Speedstack.

See Configuring Speedstack|Licensing to select the
associated field solver and purchased options.

Obtaining a Speedstack license

Speedstack is license using the FlexNet Publisher licensing
service. Contact Polarcare@polarinstruments.com for
installation/activation directions.

Download the software from the supplied link. Unpack and
save the installation file to a suitable folder then run Setup.

Uninstalling the software

Caution: Prior to uninstalling, make a copy of the Speedstack
folder structure and data files and store in a safe place.

To uninstall the Speedstack software:
Windows 7/8

Choose Settings|Control Panel; select Programs and
Features and right click Speedstack and choose Uninstall.

Windows10/11
Click The Windows Settings Icon and Choose Apps.

From The List of Apps And Features click Speedstack then
click Uninstall

Installing Speedstack ¢ 9
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Getting started with Speedstack

Online tutorial guides

Polar’s web site provides online downloadable quick start
and version specific user guides to familiarize users with the
operation and features of the software.

From the Help menu choose Speedstack Help to download
the Getting Started guide, along with tutorials for stack
editing, managing materials libraries, manufacturing
constraints and controlled impedance structures:

https://www.polarinstruments.com/help/speedstack/tutorials/

Download the user guide for your Speedstack version:

https://www.polarinstruments.com/help/speedstack/Nrmstart.htm

Stackup Templates

Polar’s web site provides online downloadable prebuilt
sample templates and associated technical reports (suitable
for Speedstack 2019 or higher) to familiarize users with the
operation and features of the software.

https://www.polarinstruments.com/support/stackup/templates.html

The stackup templates listed include both materials and drills
and are typical of standard stacks used in PCB construction
and can prove useful as a starting point when building your
own stacks.

Stackup samples include core and foil build models in both
material library and virtual library modes (see Creating and
editing stackups) for rigid stackups, flex-rigid stackups and
multiple press cycle HDI stackups.

Click on the link above or on the Polar web site navigation
bar click Resources|Stackup Templates and download the
Speedstack template project (.sci) file; save to a convenient
location and the use the Open Project command in
Speedstack to view and edit the stackup.

Note that the sample stackups are shown with dimensions in
microns.
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Using Speedstack Stackup Builder

Speedstack Stackup Builder

Double-click the Speedstack icon to start the Speedstack
program and display the Stackup Editor.

The Stackup Editor

The Speedstack Stackup Editor screen displays all details of
the stack, including copper and prepreg materials, solder
masks and ident layers, drilling information, controlled
impedance structures and design rule check results.

Controlled impedance structure data may be transferred
between Speedstack and the associated Polar Si8000m or
Si9000e field solver to goal seek for the target structure
dimensions.

£IZ Polar Speedstack Stack Up Builder:  Stack: Eval Imperial. with structuressci. Project : Eval Imperial. with structuressci.s

File Edit View Tools Units External Utility Help

EedrQ=sr X0 == =aE

777 LT N E DN E AR

Stack Up Edter | DRC ;4 Controled Inpedence | I Reauts |

EXRTEEEAEL =w@gnT
Al | 1« <I1nﬂi 3|3l

Substrate 1 Height H1 [161.29
Substrate 1 Dielectric Er1(4.2000
Lower Trace \tfidth Wi {194.31
Upper Trace Width W2 [168.91
Trace Separation 81 (20612
Trace Thickness T1 [35.56
Coating Above Substrate C1 [25.40
Coating Above Trace C2 (2540
Coating Betwesn Traces c3[5a0
Coating Dielectric CEr|4.0000
Differcriial Impedance 210025
Target Impedance 100.00
Target Tolerance % 10.00
[Master [Microns [Target Stack Up Thickness = 1524.00  [Stack Up Thickness = 1545.84 |Stack Up Thickness with Soidemask = 1596.64  [Beta V24.04.100 4

Speedstack main screen
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The Speedstack main screen
The Speedstack main screen comprises:

The Stackup Build and Construction Window — where
the board stackup is built and edited. Materials from an
extensive library of cores, prepregs, foils, solder masks,
bondply, adhesives and shields supplied by
manufacturers in the Speedstack Material Partners
program are added to the stackup in the Stackup Editor.
The Stackup Build and Construction Window includes
Structure View which presents an interactive overview
of the controlled impedance / insertion loss structures
that exist on the stackup, offering enhanced visibility of
all impedance structures from the main edit view.
Positioned to the right of the stackup within the Stack
Editor window, in 2D view structures are aligned with
the stackup electrical layers on which they have been
defined.

The Grid View Window — provides a single grid based
dialog view of the stack where all materials’ descriptions
can be edited from the same screen.

The Controlled Impedance window displaying the
controlled impedance structures (if any) for the selected
layer. Structures may be added or deleted and
recalculated after editing. The Controlled Impedance
window also contains a Mirror Structures function for a
symmetrical stack and a Goal Seek function which will
adjust the structure’s trace widths for a target
impedance.

Stackup Editor/Notes tab — a free form text area for
explanatory or commentary notes

Design Rules Check (DRC) tab — allows design rules
and manufacturing constraints to be specified and
violations displayed

Stackup Information properties area — table containing
information related to the whole stackup

Selected Item Information area — properties table
containing the attributes of the layer currently selected
in the stackup

The Controlled Impedance Results tab — summarizing
the controlled impedance structures within the stack

The Menu bar — drop-down context sensitive menus
containing all the Speedstack Editor commands

The Tool bar — incorporating short cut tool buttons to
the most common menu commands
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The Stackup Build and Construction Window

The Stackup Build and Construction Window is where the
board stackup is built and edited. New stacks are created
and existing stacks edited in this window. Stacks are
portrayed as a not-to-scale pictorial representation of the
sequence of materials in the stackup.

Materials from the Speedstack library of products, an
extensive library of cores, prepregs, foils, solder masks,
bondply, adhesives and shields supplied by manufacturers in
the Speedstack Material Partners program, are added and
arranged in the stack via the Build and Construction Window.

1.4000
3.000

Liquid Photolmageable Mask " 20000

o i s 1.4000

L : 3.0000

1.4000

3.0000

6.0000

PrePreg 1651
FR4 Core

PrePreg 1651

Coppe |

Liquid Photolmageabl

Speedstack PCB Build and Construction Window allows the
OEM designer rapid creation of accurate and efficient rigid
and flex-rigid PCB stackups, and provides error-free
documentation for tighter control over the finished board.

The interactive graphical interface also provides the PCB
fabricator the flexibility to quickly calculate the effect of
substituting alternative materials within the stack to improve
manufacturability and reduce cost while maintaining the
specified parameters and performance of the board.

Speedstack Si Build and Construction Window is ideal for the
designer, fabricator or PCB technologist who needs to
manage PCB stackups with both impedance and insertion
loss control. In addition to incorporating Polar’s proven
insertion loss field solver capability, Speedstack Si allows
rapid import and export of insertion loss projects into the
Si9000e Insertion Loss Field Solver so you can analyse your
stack up design in detail.
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Changing the Stackup View

The Stackup Window provides a full representative non-
scale view of the stackup and, optionally, all the controlled
impedance and insertion loss structures in the stack.

The view above presents the combined Stackup View and
Structure View — the labelled stackup and all its controlled
impedance and insertion loss structures,

The View menu allows for zooming in for a detailed view of
sections of the stack. Use the Zoom In (Ctrl & +Key)
command to focus on the section of interest. Zoom in and
out of the view with the mouse wheel.

Panning in the stackup window
Use the mouse drag and drop to pan horizontally across the
stackup editor window.

Vertical panning is enabled when the height of the displayed
stackup exceeds the height of the Editor window

Primary-Side-P...
Primary-Side-I...

Primary-Side-S...
Primary-Side-L...

Ground-Plane/I...

Inner-Tracking-...

= 3V3-Power-Pla...
1V5/2V5-Powe...

/ Inner-Tracking-...

Click into the stackup and drag it up and down into position.

14 o Speedstack PCB Stackup Design and Documentation



Speedstack User Guide

Structure view

Structure View presents an optional interactive overview of all

the controlled impedance and insertion loss structures that
@ exist on the stack, offering enhanced visibility of all
impedance structures from the main edit view. To access
Structure View drag the stackup to the left or use the Show /
Hide Structure View button. Structure View is positioned to
the right of the stackup within the Stackup Editor.

Show / Hide Structure View

FFFF AT AN & 2D & i A
Stack Up Edtor | DRC : 4 Controlied Impedance | ci Reauts |
R R TTR] P IR

Substrate 1 Height H1 [16725
Substrate 1 Dielectric Er1 [2000
Lower Trace Width w1 [194.31
Upper Trace Wicth w2 [168.91
Trace Separstion 1 [206.12
Trace Thickness BT

Coating Above Substrate C1 [25.40

Coating Above Trace C2 [2540
Coating Between Traces C3[25.40

Coating Dielectric CEr[20000
Differential Impedance. zd[100.29
Target Impedance 100.00
Target Tolerance % 10.00
v
[Master [Microns [Target Stack Up Thickness = 152400  [Stack Up Thickness = 1545.84 |Stack Up Thickness with Soldermask = 1596.64  [Beta V24.04.100 4

Structure View — 3D View

"’5 Click the 2D View icon. In 2D view, structures are aligned
with the stackup electrical layers on which they have been
2D View defined — see below.

£ Polar Speedstack Stack Up Builder:  Stack: Eval Imperial. with stru Project : Eval Imperial. with struct

File Edit View Tools Units External Utility Help

Egd TOEDXO =& =

PRE F777 1T @l EsDTNE o B

Stack Up Edtor | DRC 4 Controled Impedance | CI Resuits |

330 (T = o
Al | 1= <|1Dl5 >l

Substrate 1 Height H1

Substrate 1 Dielectric Er1 22000
Lower Trace Width wi [13431
Upper Trace Width w2 [168.91
Trace Separation S1l2612
Trace Thickness T [
Coating Above Substrate C1]2540
Coating Above Trace 2
Coating Between Traces cifzsa
Coaling Dielectric CEr[4.0000
Differential Impedance zd[i0029

' Target Impedance [oos0

= Target Tolerance % [om

v
[Master [Microns [ Target Stack Up Thickness = 1524.00 [Stack Up Thickness = 1545.84 [Stack Up Thickness with Soldemask = 1596.64  |Beta V24.04.100 A

Structure View — 2D View
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Click Zoom Extents from the View menu and drag the
stackup so that the stackup and structure view are both
displayed in the Stackup Editor window

Displaying 7 structures on All Layers
Target Zo : 50 Target Zo: 75 Target Zdiff : 100
Single-Ended Single-Ended Differential

Layer1,8 Layer1,8 Layer1,4,8

Zo | WIW2 | Zo | WIW2

87244
1.4000 1000 il 7574 il mo

3.0000
1.4000
3.0000
1.4000
,3.0000
6.0000
6.0000
1.4000
12,0000
1:4000
,6.0000
6.0000
3.0000
1.4000
30000
1.4000
13.0000
1.4000

Structures are arranged left to right in ascending order of
Target Impedance, (in the stackup above, 50Q then 75Q
then 100Q) then by Structure Type.

All structures of the same Target Impedance and Structure
Type will be positioned in the same column

In this example there are two 50Q) structures in Column 1,
two 75 Q structures in Column 2 and three 100Q structures
in Column 3

The column header contains the Target Impedance, Structure
Type and the stackup layers containing the structures.

Target Zo - 50 Target Zo: 75 Target Zdiff - 100
Single-Ended Single-Ended Differential

Layer1,8 Layer1, & Layer1, 4,8

Zo ' WIW2 Zo WIMW2 Zdiff = WIMW2 S1

The Column Cell displays the structure’s calculated impedance
and Lower / Upper Trace Widths (W1 /W2) and Trace
Separation (S1).

79201 7 82011

7.8020 ' 7.8020

99.94
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Selecting a structure / stepping through the structures

| an [ic] <[10ta >|»| Use the Structure Browse Control to select a structure or
step through the structures. In the graphic below the first
structure is displayed.

Structure Browse
Control

Stack Up Edior | DRC: 4 Controlled Impedance: | CI Resuits |
XX EEEEL =@
| .

Substrate 1 Height H1 [i5129
Substrate 1 Dielectric £r [4:2000
Lower Trace Width Wi 13431
Upper Trace Wicth w2 16891
Trace Separation sifameiz
Trace Thickness T1 [35356
Coaling Above Substrate casa
Costing Above Trace c2[z40

Coating Between Traces C3 [25.40
Coating Dielectric CEr|4.0000

Differential Impedance 7d [10029
Target Impedance 100.00
Target Tolerance % 10.00

Use the Structure Browse Control arrow keys to step though
the structures.

Selecting structures with the structure view

To select a specific structure within the structure view, click
on the structure trace within the column cell. The structure is
selected in the structure view (shown highlighted in blue) and
the stackup and the Controlled Impedance tab.

Stack Up Edtor | DRC:4 Cortrolled Impedance |l Resuts |
XX TEEEEL =@l
Al |I<| <W >| >I|

Substrate 1 Height H1 [161.29
Substrate 1 Dielectric Er1|4.2000
Lower Trace \width it [f1D1.60
Upper Trace 'width W2 [76.20

Trace Thickness T1 |3556
Coating Above Substrate C1 [25.40
Coating Above Trace C2 |2540
Coating Dielectric CEr|4.0000
Impedance Zo[7580
Target Impedance 75.00
Target Tolerance % W
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Filtering by layer
Speedstack can display all the layers and structures within
the stack or just the structures on a layer of interest.

| Al ||<| <J1of6 >|s1i]  The graphic below shows all layers and structures as
indicated by the Filter by Layer button on the Structure
Browse control.

Filter by Layer button

Stack Up Edtor | DRC: 4 Cortrolled Impedance | C1 Resuts |
EFXRCEERENES=wgn<
- <] < I] of 6 > |3l

Zdift |[WiM2 | S1 Wi

Substrate 1 Height 6129
Substrate 1 Dielectric Er14.2000
Lower Trace Width wi 1523
Upper Trace Widih w2 [168.51
Trace Separation stfosz
Trace Thickness T35
Coating Above Substrate cifma
Coating Abave Trace 2z
Coating Between Traces s |
Coating Diclectric cer[a0000
Differential Impedance 2Zd [100.29
Target Impedance 100.00
Target Tolerance % 10.00

To display just the layer of interest click the layer in the
stackup and click the Filter by Layer button

Siack Up Edtor | DRC: 4 Cortrlled Impedance |l Results |
X 3 T (e T
.

> [WiA2 | Zdiff [WiAv2 | S1 Wil

B2 2 £
Yot f 10431 ff REVEY

Substrate 1 Height H1 [161.28
Substrate 1 Dielectric Er1 [42000
Lower Trace Width W1 [194.31
Upper Trace Wicth w2 [i58.91
Trace Separation s1 [aoe 12
Trace Thickness T1 [E5.56
Coating Above Subsirate 1[50
Coating Above Trace c2 [25.40
Costing Betwesn Traces ca[BEam
Coating Dielectric CEr|4 0000
Differential Impedance: zd[100.29
Target Impedance [100.00
Target Tolerance % 1000

Click into an empty area in the Stackup Editor window to
cancel the selection and display the whole stackup.
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Exporting the structure view

From the File menu choose Export and choose Controlled
Impedance Data (image)

Stackup Image

| Controlled Impedance Data (image)

P | Al

Choose the file format (JPEG, BMP, TIFF, or PNG)/

Specify the image quality if appropriate and the background
and supply the path and filename

Format
&+ JPEG " BMP " TIFF " PNG
Low Quality High Quality

J

Iv Yhite Background

Output Path and Filename

Path |J:‘\F‘oIar\,Speedstack\,StacksKM-anrd contral jpg I

SaveFile |  Cancel |

The Structure View is exported with the chosen options.

Single-Ended Differential
Layer1, 8 Layer 1,4

76.20 15891 188.91
17574 Bi5y ™| 100-28 laas - 20602 A
2
3

158.75 158,75

4 101-25 Teas - 21590 SRR
6
7

101,60
87574 o
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i

Grid View

Grid View

The Grid View window provides a grid-based dialog view of
the stack permitting multiple material properties to be
edited from a single screen.

Using Grid View

Using Grid View allows rapid and direct user amending, for
example, of the Finished Thickness / Isolation Distance of
multiple materials without having to open the properties
dialog of each material.

Stack Up
Collection
Index

Material

. Electrical
Material Class s

Material Layer
Type ID

Processed

Loy Thickness

Description Dielectric Ewper

Constant Loss Tangent | colooe %

Liquid Photolmageable Mask

2 CS5TPrePreg Dielectic PP PrePreg 3113 10071 42000 0.0000
3 C5TPrePreg Dielectic PP PrePreg 3113 10071 42000 0.0000
4 CSTCore UpperCopper & 35.56 0.00
4 CSTCare LowerCopper 3 35.56 0.00
5 CSTPrePreg Dielsctric PP PrePreg 3113 87.38 42000 0.0000
3 CSTPrePreg Dislectric PP PrePreg 3113 8738 42000 0.0000
7 CSTCore UpperCopper 4 35.56 0.00
7 CSTCore LowerCopper 5 35.56 0.00
8 CSTPrePreg Dielectic PP PrePreg 3113 8738 4.2000 0.0000
9 CSTPrePreg Dielectic PP PrePreg 3113 8738 4.2000 0.0000
10 CSTCore UpperCopper 6 35.56 0.00
10 CSTCore LowerCopper 7 3556 0.00
1 C5TPrePreg Dielectic PP PrePreg 3113 10071 42000 0.0000
12 CSTPrePreg Dielectic PP PrePreg 3113 100.71 4.2000 0.0000

Use the right-click menu to copy / paste the Grid View to the clipboard - the data may then be edited with Microsaft Excel

Layer Name, Description, Processed Thickness, Dielectric Constant, Loss Tangent and Copper Coverage % columns are editable, other columns are read-only

Processed Thickness = Copper.FinishedThickness, Dielectric.|solationDistance, SolderMask.MaskThickness, Coverlay.FinishedThickness

Apply Cancel

Rebuild and recalculate

Note: the text of the following fields can be edited:
o [ayer Name
e Description
e Processed Thickness
o Dielectric Constant
e [oss Tangent
e Copper Coverage %.
Other fields are read-only.

To edit the text within a field, click on the field to select the
text and amend or supply the new descriptive text for each
material type as required — click Apply to apply the changes.
The new values will be reflected in the Stackup Editor.

Recalculating the impedances

If a field value is edited that would cause the impedance of
a structure to change, Speedstack will request a rebuild to
recalculate the new impedance.

Stack Up Edtor | DRC: 4 Controlled Impedance | CI Resuts |
X SEEOR S = wgto
| ie] - | e - | |
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Using the Controlled Impedance window

The Controlled Impedance window displays all the controlled
impedance structures and associated parameters for the

selected layer.

o 3¢ 3¢ & 5 5 [N IE 2 = e g 2
Al | I< <|W_>|LII

Substrate 1 Height
Substrate 1 Dielectric
Lower Trace \Width
Upper Trace \wfidth

Trace Separation

Trace Thickness
Coating Above Substrate
Coating Above Trace
Coating Between Traces
Coating Dielectric

Differential Impedance
Target Impedance

Target Tolerance %

Erfaz000
W1 [76500
w2 [6.6500
st [8.1150
T1[14000
cifiooo0
c2 [1.0000
€3 [1.0000

CEr]4.0000

Zd (100.29

100.00
10.00

Al | ,<| - |W ,| ,,| Step through the structures with the structure browse

control — structures with the impedance within tolerance are
shown in green, structures where the impedance is outside
the specified tolerance range are shown in red.

The Speedstack menu system

The File menu

Stackups that incorporate controlled impedance structures
are saved as projects.

The File menu allows for:

Creation of new stackups and projects
Opening and saving stackups and projects
Searching for stackup and project files
Generating printed output

Importing and exporting existing stackups and
projects and data files from companies providing data
exchange with Speedstack.

Creating new stackups and projects

New stackups and projects may be created manually or with
the assistance of the Stackup Wizard which steps the user
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through the process of choosing the build type (foil, core or
sequential HDI,) specifying the number of layers in the stack,
the stack target thickness, plane and mixed/signal layers,
drilling type (through plated/non-through plated.) and
selection of materials.

Note: The actual Wizard options available will depend on
whether Material Library mode or Virtual Material mode has
been selected.

See Material Library and Virtual Material modes.

File

| New » | Stackup Wizard Ctrl+N
Open Project Crl+0 Empty Stackup  Ctrl+5Shift+MN
Open Stack Ctrl+5Shift+ 0
Search Ctrl+F
Save Project Ctrl+5
Save Project As  Ctrl+5Shift+5
Save Stack
Save Stack As
Export »
Import 3
Print 3
Properties Ctrl+I
Recent Files 3
Exit Crl+

Using the Stackup Wizard in Material Library mode

Choosing the Stackup wizard in Material Library mode
displays a dialog that allows the user to choose the build
configuration and specify actual materials from the
Speedstack material library
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Stack Up Wizard (Material Library Mode)

—General —Planes and Mixed Layers
Layer count IB vl ¥ Symmetrical
Flane Layers Mixed Layers
Build Type |Core | ] ]
2
3 3
—Materials 4
5
Soldermask ILiquid Photolmageable Mask SM. E Clear | 3 6
. B 7
Foil I | Clear | g 3
Prepreg I | Clear | Clear Clear
Prepreg |PrePreg 7628 PP/005 .| clear |
— Drilli
Prepreg I | Clear | -
T IFH-lCore CO/006 | Tk=s | [V Through-Plated [ Mon Through-Plated

Apply Cancel

Stack Up Thickness: 57 48032 (Mils)

|Stack Up Thickness with Soldermask: 5944882 (Mils)

Stack Up Wizard (Virtual Material Mode)

Stackup Wizard (Material Library mode)

Using the Stackup Wizard in Virtual Material Mode

Choosing the Stackup wizard in Virtual Material mode
displays a dialog that allows the stack designer to build and
experiment with a stackup without requiring real materials to

be entered into a materials library.

Mumber of Layers m Nominal Dielectric Constant lw
Target Stack Up Thickness IGZ.EIBZ‘I MNominal Loss Tangent W
Paositive Tolerance % IH]— Solder Mask Top v o
B [0 Selder Mask Dielectric Constant [0
Symmetrical Ird Solder Mask Loss Tangent IW
laes Mixed Layers Solder Mask Thickness [foo0
1 1 Preferred Core Thickness lm
g 3 Copper Thickness g%%;ggggﬁ 2 W
: | B
i ; [ e
8 8 o Fail " Core 21 25984257 DI
39370078740 ¥
e Next > Finish | Cancel

Stackup Wizard (Virtual Material Library)
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In Virtual Material mode the designer specifies:
e stack details:
e the number of layers,
e overall board thickness,
e plane and mixed layers,
e core or foil build type,
e solder mask
e copper thickness
along with any transmission lines required on a layer.

Supply values for the material and solder mask
thicknesses, dielectric constant and loss tangent to match

@ the required design values. Speedstack will then build a
stack to the specified board thickness by distributing the
Apply Finishing dielectric regions equally.
% Note: In Virtual Material mode the designer is working with
finished dimensions so the Apply Finishing and Reset
Reset Finishing Finishing toolbar icons are disabled and shown greyed out.

Specifying preferred core thickness

555055115 18 If a preferred core thickness is specified, Speedstack will
19685030370 A maintain the dielectric thickness for core regions but equally
3054 distribute prepregs to reach the target board thickness.
Preferred Core Thickness Values can be selected from a drop-down list and modified

and edited as required.

Opening projects

Stackups that incorporate controlled impedance structures
are saved as projects. Click Open Project and navigate to
the project folder; projects are saved as .sci files. The
stackup along with all its design rule checking settings and
controlled impedance information is loaded.

Saving stackups

Click the Save button to save the stackup. Users are
recommended to save the stackup frequently during the
stackup creation process to avoid data loss; stackups are
saved as .stk files.

Saving projects

Use the Save Projects command to save a stackup along
with its controlled impedance structures.

Searching for stackups and project files

When creating new stackups and projects it will often be
found convenient and timesaving to reuse an existing stack
or project, modifying as required and the saving as a new
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Search Existing Stackup Files

stack or project. From the File menu choose Search and
click Change Folder to navigate to the collection of stacks.

§§ Select Search Folder(s) - O X
File Types
Stack [ stk) I
Stack with Controlled Impedance (.sci) ~3
Default Path

C:\Program Files (x86)\Polar\Speedstack\Samples

Change Folder

Search Sub Folders v

Apply | Cancel |

i)

Choose from stacks and/or projects (stacks with controlled
impedance); click Apply. The stackups and projects within
the chosen folder structure are displayed.

Supplying search criteria

By default, all stack and project files in the folder are listed.
The search may be refined by specifying layer count and
board thickness.

For example, to display only 8-layer stacks click the Layer
count check box and in the Number of Layers text box
specify 8.

Filter
Layer Count v Mumber Of Layers 2
Board Thickness ™ Minimum Thickness 0 Maximum Thickness 2000
Clea Filter | Filter
Stack Data
Mumber Of Layers Actual Thickness Flanes 0.50z/18microns loz/35microns Zoz/TOmicrens | File Name

] 164084 4.5 1.8 2,3 4567 APET7 5ci
] 1189.08 2,367 1,23 45678 PCi_8_Layer_2_Doublets_w_hatch.
8 1510.28 3.6 1.8 2,3.4567 Speedstack v20_06 Sample.sci

Similarly, check Board Thickness and specify minimum and
maximum thickness to display only matching stacks.

Click Clear Filter to restore the display to all stack and
project files.
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7|

85| Search Existing Stackup Files - m} *
Filter
Layer Count r Number Of Layers g
Board Thickness r Minimum Thickness 0 Maximum Thickness 0
Clear Filter | Filter |
Stack Data
MNumber Of Layers Actual Thickness Planes 0.50z/18microns 1oz/35microns 2oz/T0microns | File Name Fil =
12 B9.8 2,571 1.2345678 Doublet-Z.2ci CAl
12 59.8 257 11 1.2.3.45678 Doublet-Simple sci Cl
12 59.8 2571 1,23 45678 FlexRigid_12Layer_Stepl.sc C:\l
12 831496 4679 Qualcomm v14 testsci cAl
10 6377 3568 1.2.8.10 345678 10-layer-sequentiallam-mil-i - C:Al
10 62 .5724] 3568 1.2.9.10 345678 10-layer-seguentizllam-mm-i C:\|
0 425197 3,568 1,23.45678 AP523_HDl.sci CA
10 60.8582 3568 1,2,9,10 345678 fred.sci Cul
10 50.8582 3568 1,2,58,10 345678 HOI_PressCycles_mm_CuFi C:\l
10 60.8582 35628 1,2,9,.10 3456728 test.aci Cul
3 646 4,5 1.8 2,3 45867 &-Layer-sample.sci Cul
& 626772 36 2,367 AP528-real sci Cul .
P | o £ ROOA b I | ADETD VIKARA - Al f".-'.
Impedances
Target Value | Upper Signal Layer Single Ended | Differential Coplanar Broadside Trace Width | Trace Thickness -
3 50 1 [¥ ™ ™ B 12 0.7087
100 1 ™ [¥ ™ B ] 0.7087
50 4 [+ I I B 6 1378
100 4 I [¥ I B 4 1.378
50 7 [ I I B & 1.378
100 7 r [v r N 4 1.378
50 10 [v - - N 12 0.7087
100 10 ~ v ~ r g 0.7087 -
Cancel Load File |
Step through the resulting list, choose the matching stack or
project and click Load File.
Importing Stackup information
Speedstack incorporates the facility to read in files in:
IPC-2581 Rev B format
Ucamco Job File format
XML STKX and SSX formats
Zuken CR-8000 format
Ucamco Integr8tor and Ucam format
Import | Ipc-2581 RevB

Ucamco Job File

r | Import

AML File (stho)
Zuken CR-3000

Ucamnco Integritor and Ucarn (.s5%)

Clear Rules
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IPC-2581 Rev B

Speedstack can import Stackup and impedance structure data
using the IPC-2581 Rev B XML file format. Use the IPC-2581
Rev B command to import IPC-2581 Rev B (XML ) files using
the interactive interface. The stack shown below displays
both stackup material and structure information. The foil,
prepreg, core and solder mask material data grid colours are
determined by the Speedstack Configuration,

Import IPC-2581 Rev B - m] X
[ IPC-2581 File Information [ Software Package (that generated the file) o
Filename  [C:\Program Files (x6]\Polar'Speedstack \Samples\AP517.xmi Name Folar Instruments Lt Speedstack ' P _2 581
Revision B Revision 17.1.21725 ﬂl
Hrie Vende CONSORTIU
ni INCH endor Polar Instrmerts Lid — N RTIUM
—Import Options —Display Options
¥ Assign IPC-2581 as Material Supplier Al (Stack Up and Structure Data)
[¥ Assign IPC-2581 Layer Name(s) as Material Type ¥ Stack Up Data only
2 £ Structure Data only
[ Calculate Upper Trace \Widths (W2) using Default Etch Factor (3.000um)
Assign imported Loss Tangent to Notes field Mone - To edit the data displayed below select the row, right-click menu and choose the
appropriate function
Speedstack Layer Resin Dielectric | Loss
Number Layer Name Specification Name Function Side Thickness | Sequence | Material Description Canfent Constant Tangent

STACKUP THICKNESS 0.068600

LEGEND_TOP LEGEND_TOP_SPEC LEGEND OF 0.002000 1| Screened Ident

The dialog above provides user guidance through the import
process.

The IPC-2581 File Information pane displays useful file data
including the file name, revision and units. IPC-2581 supports
inches, millimetres and microns.

The Software Package pane details the application (including
the revision and vendor) that generated the IPC-2581 file.

Setting import options
Set the import options to control how the IPC-2581 data is
allocated in Speedstack:

—Import Opticns
¥ Assign IPC-2581 as Material Supplier
¥ Assign IPC-2581 Layer Name(s) as Material Type
W Calculate Upper Trace \idths (W2) using Default Etch Factor (3.000um)
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The material type can optionally be derived from the layer
name and the upper trace width can be derived from the
given trace width and default etch factor.

Setting display options
From the Display Options dialog pane choose to display all
data or stackup or structure data only

Display Options
" Al (Stack Up and Structure Data)

{* Stack Up Data only
(" Structure Data only

Sorting layer information

The stackup imported from the IPC-2581 file is shown in data
grid form. Data can be sorted by column — click on each
column header to sort in ascending or descending order by
sequence, layer number, layer name, etc.

Assigning layer functions

During the import process it may be necessary to consult the
board authority or design documentation to ascertain the
function of each layer, signal, plane, dielectric, core, etc.; the
Layer Function determines the layer / material type.

Right click each layer and use the Set Layer Function to
assign the layer its designated function.

| Set Layer Function to » | SIGMAL

Set Dielectric Constant / Loss Tangent values PLAME
MIXED

DIELCORE
DIELPREG
DIELADHV

SOLDERMASK

Setting loss values

Dielectric constant and loss tangent values can be set for
each layer; select the layer (it will highlight in blue) and then
right click the layer, the dialog should show the current
values; enter each value and click Apply.

Set Dielectric Constant / Loss Tangent Values n
helectric Constant 4 200 Apply
Loss Tangent 0.035 Cancel

With all the editing completed, click Import to bring the file
into the Speedstack Editor.
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LEGEND_TOP
SOLDERMASK_TOP
L1

DIELECTRIC

DIELECTRIC

L2/ DIELECTRI

DIELECT

DIELECTRIC

L4/ DIELECTRIC_6/L5

DIELECTRIC_7

DIELECT

L6/ DIELECTRIC 9/L7

DIELECTRIC.

DIELECTRIC,
L8

SOLDERMASK_TOP

2.000

1.400
3.400
3.400
2.100
8.000
1.400
3.600
3.600
1.400
8.000
1.400
3.600
3.600
1.400

§.000
2.100

1.400

g 4000

4.200

4.200
4.200

4.200

4.200
4.200

4.200

4.200
4.200
4.200

4.200

4.000

The imported stack can be processed using the Speedstack
editing functions.

Ucamco Job Files

The .Job file format contains a varying amount of stackup
information depending upon the how the system has been
configured by the Ucam user.

Speedstack will import files from both Ucam and Integr8tor.

Choose File|lmport|Ucamco Job File|lmport and select the
.job file and click Open. The Ucamco .Job File Import dialog

is displayed:
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Ucamco Job File Import

Please map each .Job layer / dnll class assignment to the eguivalent
Speedstack matenial type:

1. Select a class from the right-most list
2. Click the button to nominate the matenal / layer type

_Job Extra Assignments
Solder Mask | | |
Idents | |
Peelables | | |
_Job Layer Assignments
Signal | |
Mixed | |
Power | | =]
Hatched | | |

AJob layer classes that are unassigned will be imported a2z Signal

_Job Drill Assignmenis

Laser | J E

Flated | J production
MNonplated | j

Feset Apply | Cancel

The .Job file contains user-definable material / drill class
definitions so it will be necessary to map these definitions to
the various Speedstack material and drill types.

To apply assignments select the class from the drop down
list then click the associated button to nominate the material
or layer type. Click Apply.

Note: Where stack data are not included in the .job file it will
be necessary to include or update properties (for example,
solder mask properties such as thickness and dielectric
constant) before adding impedance structures.
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Integr8torJob files

When Integr8tor files are imported the Ucamco .Job File
Import dialog is displayed as shown below.

Please map each .Job layer / dnll class assignment to the eguivalent
Speedstack matenial type:

1. Select a class from the right-most list
2. Click the button to nominate the matenal / layer type

Ucamco Job File Import

—.Job Extra Assignments
Solder Mask | | > == -
=l 2 e
Peclables | | |
—Job Layer Assignments
Signal | [ ot |
Mixed | | P
rover_| | <]
Hatched | | |
Job layer classes that are unassigned will be imported as Signal
~Job Drill Assignments
Laser | ~| [ -
Plated | | rout
Nonplated | | |
Reset fpply | Cancel

Select the assignment options as described above and click
Apply. Click Reset to clear the assignments.

Clear Rules

The Clear Rules command will delete all previously learned

rules.

XML files

Choose File|Import|]XML File (.stkx), select the .stkx file for
import and click Open.
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Zuken CR-8000

Choose File|lmport|Zuken CR-8000 format, select the .stkx
file for import and click Open.

Ucamco Integr8tor and Ucam format (.ssx)

Choose File|lmport|Ucamco Integr8tor and Ucam format,
select the .ssx file for import and click Open.

Converting imported electrical layers to cores

When importing stackup data from some CAD / CAM
systems only the electrical layers are defined. In this case
copper layers may appear adjacent each other in the
Stackup Editor. Speedstack allows the user to quickly
convert two adjacent electrical layers into Core or Flexible
Core materials using the Convert to Core function.

Select the adjacent layers within the stack — Speedstack
adds the Convert to Core command to the Edit menu.

| Convert To Core J | Core

Flexible Core

Select the Core type — Speedstack displays the core library;
select the core — the layers are converted into the selected
core; note that when converting two foils to a single core
material the lower copper trace will be shown inverted.

Consider the stack below. Using ‘Convert to Core’ alongside
other Speedstack editing functions, an electrical layer only
stackup can be converted into a useful fully defined stackup
containing full definitions of foils, prepreg and core materials.

0.0000
0.0000
0.0000
0.0000
0.0000
0.0000
0.0000

0.0000

Add a prepreg layer between layers 1 and 2.

Repeat for layers 3 and 4, 5 and 6 and 7 and 8.

Select layers 2 and 3 and convert to a core.

Repeat for layers 4 and 5, 6and 7.

The resulting stack should appear similar to the stack below.
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Copper Fail 1.4000
PrePreg 1080 4.200/0.0195 EX
1.4000

FR4 Core 4 200/0.0195 11 8.0000
| 1.4000

PrePreg 1080 4 200/0.0195 . 4 3.0000
0.7000

Flex Core 4 200/0.0195 e 4.0000
0.7000

PrePreg 1080 4 200/0.0195 3.0000
11 1.4000

FR4 Core 4.200/0.0195 ] 8.0000
1.4000

PrePreg 1080 4.200/0.0195 3.0000

Copper Foil 1.4000

Exporting stackup information

Speedstack incorporates the facility to export stack data to
external programs. From the File menu choose Export and
choose the format from the Export sub-menu.

Coupon Generator (CGen)
CITS File

DXF

Gerber

Stackup lmage

Controlled Impedance Data (image)

Cadence Allegro 3
CSV...

IPC-2581 Rev B

Menter Graphics 3
XML File (.sthox) 3
Zuken CR-3000 k
Zuken DFM Centre 3
Ucamee Integr@tor and Ucam (.ssx) 3

Support Informaticn

Exporting to Coupon Generator (CGen)

Stacks may be exported to Polar CGen Coupon Generator
(the stack will be exported via the Speedstack Clipboard) for
processing into test coupons. Click Export To | Coupon
Generator (CGen) — open CGen and from the File menu,
import the Speedstack Clipboard (see CGen User Guide.)

Export CITS File

Use the Export CITS File to create test files for Polar CITS
controlled impedance test systems. Supply board details via
the Board Details dialog.
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Customer ‘Green Park Ccts
Board Type ‘Main Cortroller
Part Number [MC1234
Revision Number ‘Rev 103

Motes

MakeFile |  Cancel |

Click Make File to generate .cif files (CITS test files).

Generating printed output

Speedstack can generate printed output in DXF, Gerber,
CSV and XML, as well as graphic image formats.

DXF, Gerber, CSV and XML files

Choose DXF..., Gerber..., CSV... or XML File and navigate
to a suitable folder, name the file as appropriate and save.
For the XML option, specify the XML/.stkx file format from
the file format dropdown

Mew 3
Coupon Generator (CGen)
Open Project Ctrl+0 CITS File V25.00
Open Stack Ctrl+5Shift+ 0 DXE V24.00
Search Ctrl+F Gerber V22.00
Save Project Ctrl+5 Stackup Image V22,00
save Project As  Ctrl+5hift+5 Controlled Impedance Data (image) V21.00
V20,00
Save Stack Cadence Allegro 3
Save Stack As csy V19.00
V18.00
Export b | IPC-2581RevB
. V17.00
Impert » Mentor Graphics 3 V1600
_ _ | XML File (sthx) b
Print Technical Report  Ctrl+P ¥15.00
Zuken CR-2000 3
Properties Ctrk+| Zuken DFM Centre 3 v14.00
. W13.00
Recent Files ’ Ucarnco Integr8tor and Ucam (.ssx) 3 V12.00
Bt Ctrl+Q Support Information V11.00
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Stackup images

Speedstack can export stackup images in JPEG, BMP, TIFF
and PNG file formats. Select from 2D or 3D displays.

&|= Export StackUp Image

[ Output Selecti Format
¥ Flex-Rigid Overview (All Stacks) & JPEG  BMP  TIFF  PNG
" Current Stack Shown in Editor
Low Quality High Quality
—Mode J
@ 20 3D .
—Output Path and Fil
el -
SaveFile |  Cancel |

Use the Low Quality — High Quality slider to specify JPG
quality. Choose the Flex-Rigid Overview (All Stacks) to
display the master stack and associated sub-stacks or just
the Current Stack Shown in Editor. Specify the destination
folder and file name and save.

Controlled Impedance Data (image)

See Structure View — Exporting the structure view
Cadence Allegro (IPC-2581 Rev B)

Speedstack supports reading/writing in IPC-2581 Rev B
formatted data. Choose the Cadence Allegro/IPC-2581 Rev

B option and supply the file name and destination folder: the
Export IPC-2581 Rev B dialog is displayed.

Export IPC-2581 Rev B _ o %
~IPC-2581 File Information [ Software Package (that generated the file) Export
- I
Filename C:\Program Files {x86)"\Polar\Speedstack’.Samples\Eval Imperial xml Name |Speedstack ’P _2581
Revision B Revision 1227.20 ﬂl
Units Vendor
INCH Polar nsruments Lid — CONSORTIUM
~Export Options Display Options
1+ Export Target Impedance as the IPC-2581 Impedance data @ Al {Stack Up and Structure Data)
" Export Calculated Impedance as the IPC-2581 Impedance data " Stack Up Data only
Assign resin rich Dielectric Constant value : 3 5000 Lpply " Structure Data only
To edit the data displayed below select the row, right-click menu and choose the
appropriate function
Speed::r%ﬂ Layer Name Specflication Mame Lﬁa‘:t;(jm Side: ‘ Thickness | TolPlus TolMinus ‘ Sequence | Material Description E::r;m

SOLDERMASK_TOP SPEC SOLDERMASK TOP 0.001000 | 0.00D000
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Choosing export options

Use the dialog to modify, if necessary, the file information
details and choose the export options.

BExport Options

{* Export Target Impedance as the IPC-2581 Impedance data
(" Export Calculated Impedance as the IPC-2581 Impedance data

Assign resin rich Dielectric Constant value : |3 5000 Lpply

Specify whether Speedstack’s target or calculated
impedance is to be used to populate the IPC-2581 file.

Supply a value for dielectric constant and click Apply.
Click Export.

Mentor Graphics

Choose the Mentor Graphics option, choose the file version
and supply the file name and destination folder. (Note the
.ssx file extension.)

Zuken CR-8000/DFM Centre

The Zuken CR-8000 and DFM Center PCB manufacturing
pre-processing and CAM systems integrate directly with
Polar Instruments’ Speedstack PCB system. Choose the file
version, navigate to a suitable folder and save the file (XML
format).

Ucamco Integr8tor and Ucam

Choose the Ucamco Integr8tor and Ucam option and file
version and supply the file name and destination folder.
(Note the .ssx file extension.)

Assigning properties to projects and stackups

The stack file Properties dialog may be displayed
automatically each time a new stackup is created (see
Tools|Options|General) and provides a range of text fields for
descriptive information, stackup name, stackup author,
company name, file create date, version, etc.

From the File menu choose the Properties command to add
descriptive text fields — information contained in the
Properties dialog will be displayed on stackup printouts.

To display the Properties dialog each time a new stackup or
project is created, from the Tools menu choose Options and
click the check box below on the General tab

[v Display File Properties Dialog for Mew Stackups and Projects
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Backing up stackups and libraries

It is strongly recommended that stackup files (assigned the
.stk extension), project files (assigned the .sci extension) and
library files (assigned the .mlbx extension) be backed up to a
secure location.

Opening recent files

Click Recent Files to select and open a file from the most
recently used file list.

The Edit menu

Edit
| Add > Fail
Add Cl Structure Core
Delete Del RCC
Swap Ins Mon Copper Core
Prepre
Copy Ctrl+C i
Solder Mask
Paste Above Ctrl+V
Paste Below Ctrl+Shift+V Flex Core
. . Bondply
Properties Ctrl+Shift+1
Adhesive
Set To Signal Coverlay
Set To Plane Ident
Set To Mixed Peclable
Set To Hatched
Cirill
Hatch Profile
Move Up Ctrl+Up
Mowve Down Ctrl+Down
FlexMav Move Up Ctrl+5Shift+Up

FlexMav Move Down Ctrl+5Shift+ Down

Undo Ctrl+Z
Redo Ctrl+5Shift+Z

Set Stack Default Colours

Reset All MVDP Attributes

The Edit menu contains the commands necessary to create
and modify board stackups. The designer or fabricator works
within the free-form stackup build and construction window
and in Materials Library mode adds layers of foil, core,
prepreg, etc., from the materials library.

Material Library and Virtual Material modes

Speedstack provides the option to switch easily between
Material Library and Virtual Material modes allowing the
stack designer to build and experiment with stackups (for
example, to examine the effects on impedance structures of
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different trace widths or dielectric heights) without requiring
real materials to be entered into a materials library.

Controlled impedance structures can be added to the stack.
When Add CI Structure is selected Speedstack switches to

the Controlled Impedance pane and allows the designer to

add structures appropriate for the selected layer. The items
that can be edited depend upon whether the StackupEditor
or Controlled Impedance tab is selected.

Layers can be changed to signal, plane, mixed or hatched,
moved up or down or copied and pasted, or assigned
properties as required.

Use the Delete and Swap commands to delete materials or
swap materials from the Materials Library.

The View menu

Use the View menu to change the Stack Editor display whilst
adding or removing materials or modifying or refining the

stack.
Yiew

20 View Ctrl+5Shift+2
30 View Ctrl+ Shift+3
Zoom In Ctrl++
Zoom Qut Ctrl+-
Zoom Extents Ctrl+0
Default View Ctrl+9
Open Mavigator F4

Restore Mavigator
Proportional Stack Viewer F3

Open Material Library  Ctrl+L

Open User AppData Folder

The View menu allows Speedstack to display the stackup in
a 2-dimensional or 3-dimensional aspect.

Zoom In to get a close-up view of the stack or Zoom Out to
see more of the stack at a reduced size. Zoom Extents will
adjust the zoom level to display the whole stack.

Hint: Click the mouse centre button/wheel to Zoom Extents.

With the Flex / HDI option installed choose the Open
Navigator command to view the master and associated sub-
stacks. The floating Navigator window may get covered by
other application windows when switching between
programs; — use the Find Navigator to display a reduced
Navigator window at the top left screen corner.
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Proportional Stack Viewer

Use the Proportional Stack Viewer to display the stack
currently selected in the Stack Editor so the material
thicknesses are shown proportional to each other. This can
be informative as a visual aid, especially when considering
the dielectric thicknesses between electrical layers.

The Tools menu
Use the Tools menu to:

e configure Speedstack

e set manufacturing constraints

¢ set the finishing method

¢ set the target stackup thickness

e enable prepreg and copper finishing

e check the copper coverage percentage set for each layer
e switch between library and virtual material modes

e choose the display language

Tools

Options Ctrl+,
Manufacturing Constraints Ctrl+M
Set Finishing Method Ctrl+Shift+ M

Set Target Stackup Thickness / Enable Finishing  Ctrl+T

Check Copper Coverage Percentage Ctrl+5Shift+C
Virtual Material Mode Ctrl+Shift+Y
Language ]

The Options command displays the configuration options,
manufacturing constraints, target stack thickness and
finishing options. See Configuring Speedstack for details.

The Units menu

Use the Units menu to select the stackup units, Microns,
Mils/Thous, Millimetres or Inches

Units

Microns Shift+F1

Mils/Thous  Shift+F2

Millimetres  Shift+F3
Inches Shift+F4
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External Utility

Use the External Utility commands to start a program
external to Speedstack. The programs are defined in the
Configuration Options|External Ulilities dialog.

The Help menu

Use the Help menu commands to access the User Guide for
the current Speedstack version or tutorials relating to
common Speedstack operations.

Review the licensing terms with the License and About
Speedstack commands.
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Configuring Speedstack

When first run, the Speedstack environment is initialised to
its factory settings. These may require adjustment before
outputting a finished stackup and/or project. Default settings
are changed using Tools|Options, Tools|Manufacturing
Constraints and Tool|Set Finishing Options.

Environment and default settings

From the Tools menu choose the Options command to
display the Configurations Options dialog.

General Options

Default Stack Up View

" 2D

* 3D

Units

" Mils/Thous {* Microns

[+ Open last used file on application start up

I¥ Display File Properties Dialog for Mew Stackups and Projects

Dizplay Data

Display Fields 1 and 2 are reserved for Layer Numbers and Layer Types

| Display Field 3 | Display Field 4 | |Display Field 5
|Descriptiu:un hd |N.:.ne ﬂ |Isu:u|aﬂun Distance hd
" Millimetres " Inches

Choose the Default Stackup View — 2D or 3D; select the data
fields that will appear alongside the stack in the Stack Editor

| Display Field 3 [Display Field 4 | [Display Field 5
|Descriptil:un hd |N|:-ne j |Ease Thickness hd
Supplier Finished Thickness
Supplier Descriotion Base Thickness Copper Coverage
E&b Finished Thickness lzolation Distance

Copper Coverage Dielectric Constant
-?—;;zk humber lsolation Distance Resin Content

Diglectric Constant Tg

Resin Content Colour

Tg ¥ | | Data Filenames hd

Choose the stackup units; Speedstack supports Mils/Thou,
Microns, Millimetres and Inches. Click the Open last used...
check box to specify that Speedstack should open the last
used file on start-up.

Note: Processed Thickness is the Finished Thickness for
copper layers and Isolation Distance for dielectric layers.
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Clicking the Display File Properties Dialog... will display the
File Properties Dialog each time a new stackup or project is
initiated.

Structure Defaults

Structures Eoard Thickness
Default Snap To

Lower Trace \Width (/1) [250.00 [5.00 Erznfll s s 1600.00
Upper Trace \Width [2) [247 00 [5.00 Plus % 10
Lower Ground Strip Width (G1)  [2500.00 [5.00 Minus 2 |10
Upper Ground Strip Width (G2) |24?5.DD |E-.I}D Drilling
Trace Separation (S1) |250.00 |5.00
Ground Strip Separation (D7) |250.00 |5.00 Minimum Hole Size 500.00
Trace Offset (01) j0.00 |5.00

Separation Region Dielectnic (REr)  |4.0000

When adding new controlled impedance structures default
values (shown above in microns) are entered for the
structure parameters. Use the Structure Defaults tab to
specify the default structure parameters, for example trace
widths and separations board thickness and minimum drill
hole size.

The Snap To value may be set for each parameter. Note that
although all Snap To values shown above are set to 5.00
microns, each parameter value can be set individually.

Licensing
Use the Licensing tab to tick the purchased licensing options.

(" Speedstack License Only

License Options:

[+ Hatch Mode License (XFE)

" Enable Speedstack PCE and Si8000m link
{* Enable Speedstack Si and Si3000e link

WV Speedstack Flex / HDI License (SF)

Iv Speedstack Import ! Export License (10)
V¥ Speedstack / Ucamco Integration License (UCAMCO)

To activate the Speedstack controlled impedance function,
ensure that the Si8000 or Si9000 is installed; from the
Licensing tab choose either Use Polar Si8000m License or
Use Polar Si9000e License option as appropriate.
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Choosing default file locations

Select default matenials library file
C:\Program Files (x8E)\Polar\SpeedstackiSamples'\Speedstack Metric mibx Browse. ..

Select default folder to store Stack Up (".stk) files
C:\Program Files (x8E)\Polar\SpeedatackiSamples Browse. ..

Select default folder to store Material Filter (. mlf) files
C:\Program Files (x86)\Polar\Speedstack\Samples'Filters Browse...

Select default folder to store custom print settings (*.prs) files
C:\Program Files (xBE)\Polar\Speedstack\Samples'Filters Browse...

e

Use this dialog to choose which materials library the
Speedstack uses at start-up. Click the File Locations tab and
use the Browse button to navigate to the library (.mlbx) file.

The File Locations tab provides for default locations for
stackup or project files, Material Filter (.mlf) files and custom
print settings (.prs) files. Browse to the target folders and
click OK to confirm (create new folders if necessary).

Specifying goal seeking parameters

Click the Goal Seeking tab to specify the default values for
trace widths and separations used during goal seeking.

1 Maximum Trace Width

1 Minimum Trace Wwidth

51 Maximum Trace Separation
51 Minimum Trace Separation
D1 Maximum Trace Separation
D1 Minimum Trace Separation
H Maximum Value

H Minimum Yalue

W Convergence II}5I}7
W Maximum lterations I'H}i
oo
-
oo
-
.
Er

During goal seeking the calculated value for impedance will
progressively converge upon the target value.

In the Convergence text box specify the difference between
the target impedance and the actual impedance at which
goal seeking will terminate.

Use the Maximum Iterations text box to limit the number of
iterations used during goal seeking.
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Setting user defaults

Information added to the User tab will be transferred to the
File Properties dialog and used on printouts

Enter information as appropriate into the associated text
fields; optionally, select a graphic for use as the company
logo — optimum graphic size is 180 x 32 pixels — the
graphic is printed in the preview box.

Default User Information Company Logo

Used to fill in stack property fields when starting a new stack file.

Author |J Travers

|D:'-.Pu:ular'-.Graphics'-.F'ular Logos“MewPolarl Browse...

Recommended size for the logo is 180 pixels in width.
Department |Engineen'ng Large images will be scaled down.

- T

Company |>WZ Com

Site |North Bridge|

Specifying default CITS test file parameters
Speedstack allows the user to generate a CITS test file for
each controlled impedance structure within the stack.

Select the CITS Test tab to specify the default test
parameters to be used when initiating a CITS test file.

Horizontal Units Channels
Units Inches - Single Ended |Channel 1 -]
Test From |3— Differential |Channe| 142 j
Test To I?—
Test Method |Absolute B
Vertical Scale |'||3I j
Differential Unbalanced Warning Level |15

Each test file contains the test parameters (test units,
distance, number of channels, etc.) to be used when testing
the stack’s controlled impedance structures using a Polar
CITS (Controlled Impedance Test System). The test file may
be edited via the Edit Test Data dialog.

CITS test methods
Note that the preferred test method is Absolute

The Average method should only be used with the express
approval of the specifying authority.

See Polar Application Note AP8515 — CITS Test Methods
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Choosing background and stackup layer colours

Choose the Colours tab to change stackup component
colours from their factory defaults.

|ﬁu:.|hesi'n.res j

Backaground

Bondphy

Coppers

Core Diglectrics
Coverays

Dielectrics

Flexi core

Highlighted Material
|dents ¢ Documentation
Laser Drills NTP

Laser Drlls TP
Mechanical Drills N TP
Mechanical Drills TP
Peelables hd

Base Colour

Change

Reset All

i

i

Click Reset All to return to cancel changes.

Miscellaneous Options

Mumber of Undo Levels 5
Maximum Lazer Drilled Layers 5

[v Drill Validation Check

This option prevents invalid drills from being added to the stack up. For instance, a drill that starts from the lower copper side of core
materials. Uncheck this option if you use a dnlling technology that permits drills to be placed between electrical layers which are not
typically supported by conventional mechanical and laser drills

Use the Miscellaneous tab to:

e Specify the maximum number of undo for editing

actions

e Choose the maximum number of layers a laser drill
can span. (Exceeding this number will produce a Dirill
not Valid error message.)

e Apply Drill Validation Check — preventing invalid drills
being added to the stackup. Unchecking this option
will disable the Speedstack invalid drills check in order
to support the Ormet® Z-Axis Interconnect* technology

* Ormet® Z-Axis Interconnect is a method of connecting
two PCB boards using a conductive paste filled into the

vias of a drilled prepreg.
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Hatch Defaults

Hatch Pitch |433_53
Hatch 'width |-|2j_|}|].
Copper Percentage =T

Use the Hatch Defaults tab to specify the default values for
Hatch Pitch and Width and Copper Percentage when setting
a plane to hatched (see Hatch Configuration.)

Rebuild and Calculate Structures

These options control the way that the Controlled Impedance structure parameters are
updated from the stack up. When new structures are added or the Rebwild and
Calculate option is selected, Speedstack will update all structures based on the
selections below. Default : All options selected.

[+ Substrate Height (H m)

[v Substrate Dielectric (Er n)

[+ Trace Thickness (T1)

[V Coating Abowve Substrate (C1)
[ Coating Dielectric (CEr)

The Rebuild and Calculate Structures tab allows the
designer to specify which parameters are included when
controlled impedance structures are recalculated after
modifying the stack.

Manufacturing Constraints

The Manufacturing Constraints options consist of a collection
of manufacturing capabilities, minimum gaps and trace
widths, buried and blind via and trace aspect ratios, drill
aspect ratios, etc. that can be applied during design rule
checking (see the DRC tab detail below.)

[v Manufacturing Tests (Tools | Manufacturing Constraints)

Active Constraint : Polar Microns

[+ Min. Trace \Width W Min. Gap Width
Aspect Ratios

Iv Mechanical Drill Iv Buried Laser Microvia
I+ Blind Laser Microvia v Trace

[+ Resin Starvation

They will normally refer to differing levels of technology
offered by one or more PCB manufacturers for a range of
prices. The required information (shown in the example
below) can normally be obtained from the manufacturer.
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Manufacturin

Active Constraint : Polar Microns

Manufacturer's Name Elind Laser ViaA R. Buried LaserViaA | Mechanical Drill A R. Minimum Gap Minimum Trace Width Trace A R. Units

Mils
Millimetres
Inches

Polar Mils
Polar Millimetres
Polar Inches

Instructions: Double-Click the Data Grid row to edit, add or delete a constraint

Highlight Set |

"thlight and Set Active Constraint

Click the Highlight button to highlight the current active
constraint; to apply a new constraint select the constraint row
and click Set.

Editing and adding constraints

To modify a constraint or add a new constraint, double click
within the constraint row to be edited. Modify each setting as
required; click Done to confirm settings and close the dialog.

Edit Constraints

Units
 Mils & Microns
" Inches  Millimetres
Option Name IPoIar Microns
Minimum Gap |T-"5
Minimum Trace \width |75
Mechanical Drill AR. |8.5
Blind Via AR. [0.5
Buried Via AR. [0.5
Trace AR. |1

el < 1aof 4 B bl
pdd | Delee | Done | Cancel

Instructions
Add: Press Add, which will add a new blank constraint. Notice the
'n of n' record number will increase. Mow key in the constraint
details and select Dane.
Delete: Press Delete to remove the existing constraint. Motice the
'n of n’ record number will reduce. Then select Done to close the
dialog.
Edit: Edit the existing constraint and select Done to close the
dialog.

To add a new constraint, click the Add button, fill in the
settings fields and click Done to finish. The new constraint
will be added to the table of current constraints. Click the
Delete button to remove the constraint from the list.
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Set Target Stackup Thickness/Enable Finishing

Set the Target Stackup Thickness and tolerances via the
dialog below.

Target Stack Up Thickness / Enable Finishing

Target Stack Up Thickness 60.0000 (Mils])
Tolerance

* Percent " Absolute

Positive Tolerance + 100 G
Megative Tolerance - 100 G

Enable Prepreg Finishing [
Enable Copper Finishing [

Apply | Cancel |

Tolerance may be set in terms of percentage or absolute
values:

Tolerance

" Percent + Absolute

Positive Tolerance + &.0000 (Milz)
Megative Tolerance - &.0000 (Milz)

Note that positive and negative tolerance values can be set
independently. The values should reflect the currently
selected units.

To enable prepreg and/or copper finishing tick the associated
check boxes. Click Apply.

Note: Unchecking the Enable Finishing options disables the
Apply and Reset Finishing buttons. Note that these buttons
are only available in Materials Library Mode — they are
disabled in Virtual Material Mode.
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Reset Finishing

Finishing Options
From the Tools menu choose the Set Finishing Method
command to display the set finishing corrections dialog.

Speedstack offers two methods: Copper Coverage Method
and Simple Percentage Method.

Note: The two methods of finishing, Copper Coverage and
Simple Percentage, are not compatible with each other. The
Copper Coverage method requires that the finished
thickness of prepregs be entered in the material library; that
value stays locked in the stack unless the Simple Percentage
method is set up; if Reset Finishing is then clicked the
finished thickness reverts to the base thickness.

Prior to switching between the Copper Coverage and
Simple Percentage finishing methods use the Reset
Finishing icon to return the stackup to its unpressed state.

= Set Finishing Methed
g

Copper Coverage Method Simple Percentage Method

Simple Percentage Method Currently Selected

Please note: Prior to switching between finishing methods it is
important to return the stack up design to its original
un-pressed state by using the ‘Reset Finishing’ toolbar icon.

i

Each method requires that the amount of copper to be added
where plating is required be set. In addition, where the
Excess Resin design rule check is used the minimum
acceptable value must be set.

Simple Percentage Method

Use the Simple Percentage Method to set the percentage of
prepreg base height, which will be used to determine the
isolation distance. The percentage is set for each electrical
layer type pair.

Specify the IPC-6011 Copper Finishing Class and plating
thickness. Click Edit to specify the Class name and value
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&= Percentage Prepreg Corrections

Preprea
Set Finished Thicknesses of Prepreg materials (% of base material) when
prepreg is pressed between:

Signal and Signal layers 30.00 %
Signal and Mixed layers 35.00 %

Signal and Plane layers foooo %
Mixed and Mixed layers foooo %
Mixed and Plane layers W:’,
Plane and Plane layers 500 =

Copper Finishing

Enter values of thickness according to preference. The selected value will be
the one added to the base thickness of copper layers when plating.

ID | Class Name Value | Active | Edit
1 0.7000 Yes et
2 Class2 0.7000
3 Class3 0.7000
4 Class4 0.7000
5 Class5 0.0000

Excess Resin Test

Minimum Excess Resin 15 %
Cos

Click Set to activate the class.

Copper Coverage method

The Copper Coverage method allows the user to specify the
amount of copper that will be embedded into the prepreg.
The greater the copper coverage the smaller the amount of
copper that is embedded.

This value can be set by layer type — as a single value for
each electrical layer type, or proportional to coverage — the
amount of copper embedded will be calculated on an
electrical layer by layer basis dependent upon the copper
coverage for the layer set in the layer’s Properties window.

£i= Copper Coverage Based Prepreg Corrections

Percentage Copper To Be Embedded in Prepreg
(% Set by Layer type

Signal Layer
Mixed Layer

Plane Layer

o o o
o -t e |
o o

" Proportional to Coverage
This option requires all electrical layers to have the Copper Coverage % property

populated. Use the Tools | Check Copper Coverage Percentage option to verify.
Copper Finishing

Enter values of thickness ding to pref . The selected value will be the one
added to the base thickness of copper layers when plating.

BB Class Name Value | Active |+ | Edit

1 0.7000 Yes || =
2 Class2 0.7000
3 Class3 0.7000
4 Class4 0.7000
5 Class5 0.0000

Excess Resin Test
Minimum Excess Resin % 15

Apply Cancel
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Note: Choosing Proportional to Coverage requires all
electrical layers to have the copper coverage percentage
property populated. (Right click each layer and choose
Properties to view its current setting.)

Copper
Base Thickness 0.7000 Copper Coverage %
Finished Thickness 1.4000 Graphical Colour
Layer Name |Top

To verify all the layers in the stackup use the Check Copper
Coverage Percentage command (see below.)

Specify the IPC-6011 Class and plating thickness.

Checking Copper Coverage percentage

Use Check Copper Coverage Percentage to verify that the
copper coverage percentage has been set for each layer
This option can be selected to determine which electrical
layers, if any, have a Copper Coverage Percentage of 0.

| Check Copper Coverage Percentage Ctrl+Shift+C |

Speedstack displays a message dialog listing the layers
where the Copper Coverage Percentage is set to 0.

Speedstack

@% The Copper Coverage percentage has not been entered for
| /.-' the following layers:

2367,

Virtual Material mode

The Virtual Material Mode command toggles between Virtual
Material and Material Library modes.

Note: Switching to Virtual Material Mode disables the Apply
and Reset Finishing buttons.

Note: Virtual Material mode and the Simple Percentage
method of finishing are not compatible. Speedstack displays
the message below if the two are selected simultaneously.

Speedstack

@8 The Simple Percentage Method of finishing is not supported
'-.\ /.-' when Speedstack is in Virtual Material Mode, Please use the
= Tools | Set Finishing Method and select Copper Coverage
Method.
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Working with external utilities

Speedstack can call an external program / utility / script via
the External Utilities menu options. The menu items are
configured via Configuration Options|External Utilities.

1 Choose |  Clear |
2 Choose |  Clear |
3 Choose |  Clear |
4 Choose |  Clear |
5 Choose |  Clear |

To specify a program click Choose and navigate to the
program and click Open. The program will be added to the
External Utility menu.
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Speedstack main toolbar

The Speedstack toolbar comprises shortcut links to the most
popular commands.

EedTOSI XO=S=sRE 7777 1T el & 290 i HE

Note: toolbar buttons will be enabled/disabled depending on
whether Speedstack is performing stack editing or controlled
impedance calculations. Pause the mouse over each tool
button to display the tool’s screen tip

File operations

= Create new stackup

LM

E Library mode

' M

E Virtual Material mode

A Stackup Wizard

Stack building operations

viw Symmetrical Mode off

Symmetrical Mode on

D Mirroring Mode

| Add layer to the stackup

Click to select the layer type. The list of layer types is
displayed in the associated sub-menu.

Layers available include:

Foll Add foil layer to the stackup
Core Add core layer
RCC Add resin coated copper layer

Non-Copper Core Add non-copper core
Prepreg Add prepreg layer
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Soldermask Add solder mask
Flexible core Add flexible core layer
Bondply Add bond ply adhesive
Adhesive Add Adhesive
Coverlay Add coverlay layer
ldent Add screened ident layer
Peelable Add peelable mask

]I: Add mechanical/laser drill between layers

Editing the stackup
x Delete selected stackup material or drill

@ Swap selected material

Note: the Copy and Paste buttons below are only enabled for
the Stack Editor and DRC tabs — they are disabled for the
Controlled Impedance and Cl Results tabs.

Copying and pasting materials

—= Copy material of the selected layer
fattataty Paste material above selected layer
i Paste material below selected layer

—
'Eu;'f:il Copy material properties

.{_“—lg Paste material properties

Changing plane types

e Set the selected electrical layer as a signal
layer

Set the selected electrical layer as a plane

Set the selected electrical layer as a mixed
signal/plane layer

Set the selected electrical layer as a hatched
plane

NSNS
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Note: Move Selected Layer buttons (below) are only enabled for the Stack Editor and
DRC tabs — they are unavailable for the Stackup Editor in Grid View and disabled for the
Controlled Impedance and Cl Results tabs.

1

Move selected layer up one layer

Move selected layer down one layer

Display properties dialog for the selected layer
or drill

Applying finishing

L

Apply finished thickness

Reset finished thickness

Note: Apply and Reset Finishing buttons are enabled only for Materials Library Mode
with the Prepreg and Copper Finishing Options checked (see Set Target Stack
UpThickness / Finishing Options) — they are disabled for the Virtual Materials Mode.

Changing the stackup view

>
m,

i

i

Display 2-dimensional view

Display 3-dimensional view

Grid View

Proportional Graphics View

Managing the materials library

Go To/Display materials library

Exchanging data with the Si8000m or Si9000e Field solver

oo |l E

Copy controlled impedance data to field solver

Paste controlled impedance data from field solver

Copy to Si8000m or Si9000e Project
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Creating and editing stackups (Virtual Material mode)

Material Library and Virtual Material modes

Speedstack provides the option of switching easily between

Material Library and Virtual Material modes, Virtual material

mode allows the stack designer to build and experiment with
stackups without requiring real materials to be entered into a
materials library.

In Virtual Material mode the Stackup Wizard allows rapid
entry of stack details, the number of layers, overall board
thickness, plane layers, solder mask and copper thickness.
Speedstack will then build a stack to the specified board
thickness by distributing the dielectric regions equally. If a
preferred core thickness is specified Speedstack will
maintain the dielectric thickness for core regions but equally
distribute prepregs to reach the target board thickness.

This section will describe the steps to construct an 8-layer,
symmetrical FR-4 stack to the specification below using
Speedstack’s Virtual Material mode.

Thickness: 60 mil

Signal layers: 1,3,6,8

Plane layers: 2,4,5 7

Er: 4.2

Preferred core thickness: 8 mil

Copper (all layers): 10z. /1.4 mil

LPI Mask: 1 mil

PTH drill passes: Layers1-8

Laser microvia passes: Layers1-2,8-7

Impedance structures: SE 50 Ohm Layer 1, Diff 100 Ohm Layer 1

Using the Stackup Wizard (Virtual Material mode)

WM

From the Units menu choose Mils/Thou

From the Tools menu toggle Virtual Material Mode On (or
toggle the Material Library/Virtual Material mode icon.)

Ensure the Library/Virtual Material mode icon indicates
Virtual Material mode.

From the File menu chose New|Stackup Wizard.

The Stackup Wizard supports up to 128 layers
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Stack Up Wizard (Virtual Material Mode)
Mumber of Layers MNominal Dielectric Constant I-i.ZDDD
Target Stack Up Thickness Nominal Loss Tangent ID.{I‘IB5
Fraiie TefEwes % Solder Mask Top W Solder Mask Bottom v
Negative Tolerance “ Solder Mask Dielectric Constant [+0000
Symmetrical Solder Mask Loss Tangent ID.D'IBE
Plane Layers Solder Mask Thickness |1 0000
1 A 1 A Preferred Core Thickness Select ;I |12.DDDD
2 2
3 3 Copper Thickness 0.7000
4 4
5 5 ]
& [ —Build Type
7 7
8 o 8 v & Fail " Core " Seguential/HDI
<Previous Next > Finish |  Cancel |

In the example below the Stack Editor displays the last few
layers of a 128 layer stack

4.200/0.0195
4.200/0.0195
4 0195
4.200/0.0195
4.20000.0195

4 0135 0.7000

1.0000
4.200/0.0195 i
CLT T T LT T LT TS,

128 Fail

SM 4 000M0.0195

Use the Zoom Extents command to view the entire stack;
navigate quickly to the layer to be edited with the mouse
wheel zoom.

Setting basic stack data

Consider constructing an 8-layer stackup. Supply the
parameters for the stackup as shown in the Stackup Wizard
dialog below.
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Stack Up Wizard (Virtual Matenial Mode)

Mumber of Layers 8 h MNeminal Dielectric Constant 4.2000
Target Stack Up Thickness 60 Meminal Loss Tangent 0.0195
Positive Tolerance % 10 Solder Mask Top v O
MNegative Tolerance % 10 Solder Mask Dielectric Constant 4.0000
Symmetrical v Solder Mask Loss Tangent 0.0155
Plane Layers Mixed Layers Solder Mask Thickness 1.0000
1 1 Preferred Core Thickness Select j |S
2
3 1 Copper Thickness 0.7000
4
5 “
& 3 Build Type
] ] * Fail " Core " Seguential/HDI
Next > Finish Cancel

Step through the Stackup Wizard:
e Choose the number of layers
e Specify the board target thickness
e Specify whether the stackup will be symmetrical

e Designate plane and mixed layers.
Note the symmetrical arrangement of the chosen
plane layers

e Supply the other material parameters. Note that when
in Symmetrical mode, the Solder Mask Bottom
checkbox (shown greyed out) matches Solder Mask
Top when its checkbox is ticked.

e Choose the build type, foil, core or sequential HDI

Foil and Core builds

This most basic 8-layer stackup is the foil build, with a foil on
the outer layer of the stack; it is the most common build for
even higher layer count boards.

Another common type of 8-layer stackup — with core
materials on the outer layers — is called a core build.

Core builds are typically used in microwave applications
where expensive microwave materials are laminated
together with a lower cost internal bonding layer.

Click Finish to display the stackup or Next to add drills.

The graphics below illustrate typical 8-layer foil and core
builds before drills are added.
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8-layer foil build 8-layer core build

Sequential HDI builds

Choosing a Sequentail HDI build displays the Define
Sequential Build dialog where the HDI build may be
constructed.

Define Sequential Build

NNN*N*1E;: £ EB CB

1]
i

< Previous Mext = Finish Cancel
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The structure of the HDI is by construction type. (See IPC-
2315, IPC-2226.) The Speedstack wizard supports Types |,
Type Il, and Type Ill as shown below

N N N N === |8 &

*

N Type | Stack

N Type Il Stack

N Type |l Stack

N Set number of foils added to foil build

i— Foil build sub-section with one core

2 Foil build sub-section with two core

Foil build sub-section with three core

(W],1TT

* Set number of cores in foil build sub-section

=] | Reset to foils and prepregs

FB | Reset to foil build

CB

Reset to core build

Use the toolbar to define the sequential HDI build.

Click Next to add drills or Finish to add the (optional) stackup
file properties and display the stackup. View the stackup
sequence in the Navigator; right click and choose HDI
Build|Sequential Plan.

HOI Build -] Sequential Plan
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Adding drills

Drill information is assigned to drill columns (up to 11
columns are available) Select Column 1 and specify the First
Electrical Layer as Layer 1 and the Second Electrical Layer
as Layer 8; choose Mechanical, Through Plated with No Fill
and click Add to add the first drill to the stack.

Add Drills

—Electrical Layers

~
First Electrical Layer  Second Electrical
Stack Up Column No (Start Layer) Layer No (End Layer)
i > =l s < |
; —Hole Inf
6 Fill Type Hole Count Minimum Drill Size
7
2 N Fill - o Jo.0o
?ﬂ Different Hole Sizes Minimum Drill Size Tolerance (fbs)
1 o |0.00
Minimum Hole Size Minimum Barrel Wall Thickness
J0.00 Jo.00
Minimum Pad Size :
0.00 ‘
Delete Last Delete All Add .
<Previous Finished | Cancel -

Adding microvias

Choose Column 2, specify the First Electrical Layer as 1 and
the Second Electrical layer as 2; choose Laser with No Fill
and click Add. Repeat the process to add another microvia to
Column 2 between electrical layers 8 and 7 (shown below.)
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Click Finished.

The Stackup Wizard displays the New Stackup File
Properties dialog; enter the (optional) stackup properties.

MNew Stackup File Properties = B
The fields below are optional
Descriptive Stackup Name II'U'I-Board W Stack
Steck Top Side Label |
Stack Bottom Side Label |
Date Created jo7A10/2m3
Version |F~!ev 000
Revision Show/Hide Revision Information
Buthor jam
Company IF‘oIar
Department IEngineering
Site Morth Ind Estate
Associated Documents
ok | Skip |

Click OK to close the dialog and edit the stack. Speedstack
builds the stack to achieve the specified board thickness.

2 Click the See 2D View button to assist in visualisation while
editing the stack.

See 2D View
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Use the View menu to zoom in and out of the stack.

Zoom In
Zoom Out
Zoom Extents
Default View

Hint: Click the mouse wheel in the Stack Editor (Zoom
Extents) to view the entire stack.

The Stackup Editor displays summary information for the
whole stack and for items within the stack as they are
selected.

Stack Up Information

Field Value
Electrical Layer Count 2

Stack Up Cost 0.00
Copper Thickness 11.0236
Dielectric Thickness 51.9685
Solder Mask Thickness 1.9635
Target Stack Up Thickness &Z.9521
Stack Up Thickness BZ.9521
Stack Up Thickness with Soldermask  64.9606

Selected Item Information : Dinll

Field Walue
First Electrical Layer Mo 2
Second Electrical Layer No 7
Mechanical Diill Falze
Laser Drill True
Fill Type Ma Fill
Diata Filenames

Hole Count 0
Different Hole Sizes 0
Minimum Haole Size 0.001
Minimum Allowable Hole Size 152000

Editing the stack

With the “virtual” stack in the Stack Editor the stack can be
changed as required.

Changing material properties

To change the properties of a material, right click the
material in the stack and choose Properties; fill in the text
fields with the associated information and click Apply. Most
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material properties can be changed, including the material
descriptions, base and finished thickness, dielectric
constants, drill parameters along with the graphical colours.

Choosing Symmetrical mode

Stackups are often designed symmetrically to prevent
(LS warping and twisting — using similar materials in the top

| Symmetrical OFF and bottom halves of the stack.

Clicking the Symmetrical button will toggle the Symmetrical
mode on or off. In Symmetrical mode the stack editing

“* | Symmetrical ON  functions will process materials in the upper and lower
halves of the stack simultaneously.

Changing the material description

In this example stack, ensure symmetrical mode is selected
then right click the solder mask material in the stack to
display the Solder Mask Properties dialog.

Solder Mask Properties

Main l Notes ] Attributes

General Information Apply
Supplier |PD|EIF Samples Close
Supplier Description |5M/001
Description ||Jquic| Photolmageable Mask Cost W
Stock Number |500-001
Type [Solderlask LeadTime [0.00

Solder Mask
Thickness W Mask Caolour m
Dielectric Constant IW Graphical Colour _

Loss Tangent IF
|

Data Filename

Change the Solder Mask Description to Liquid Photo
Imageable (LPI).

Description ||Jquid Photo Imageable (LPI)

The change on the Description in both solder masks is
reflected in the Editor window.

Liquid Photo Imageable (LPI) 1.000

Liquid Photo Imageable (LPI) 1.000
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Changing electrical layers

Electrical layer types may be changed from plane to signal,
mixed and hatched. Right click the layer to be changed and
choose from Signal, Plane, Mixed or Hatched.

Set to Signal
Setto Plane
Set to Mixed
Set to Hatched

Speedstack will take the designated layer type into
consideration when adding controlled impedance structures.

Setting hatched planes

With the XFE option Speedstack supports hatched planes,
e implementing the same crosshatch calculation technique
7 used in the Si8000m / Si9000e. If a crosshatch plane is

Set Layer to Hatched  required click Set Layer to Hatched Plane —use the Hatch
Plane Configuration dialog to set hatch pitch and width or set the
hatch width by percentage copper area. Click Apply.

Hatch Configuration Hatch Fitch wp  [17.0701 ——
‘\H = HW Hatch Width W[5 —(—

“\ —Set Hatch \width for desired Copper Area %

.00

Mon Copper frea %

A
Connagiiea Cancel

Adding controlled impedance structures

To add controlled impedance structures, click the Controlled
Impedance tab, select the copper layer (in this example,
Layer 1) and click the Add New Structure button.

Stack Up Editor | DRC - 3 [ Controlled impedance || C1 Resutt |

+

|Add Mew 5tructure|

Speedstack suggests structures valid for the layer based on
the plane layer types.
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Structure Control

—Mumber Of Signal
Tracks oo |
& Single Trace E Apply Al |
" Differential ECDETEC'_IrgiCmSt“PE
E Advanced |
Coated Coplanar
Strips With Low...
Target Impedance Iﬁﬂm
Target Tolerance % Im_ﬂ.
Total of Structures Added ID
Reference Flane Iz Done I
Cancel |

For this example, choose a 50 Ohm single ended coated
microstrip; leave the tolerance at 10%; click Apply then Done.

- The new structure is shown in the stack, highlighting the
Structure on Layer materials employed by the structure.

Adding a controlled impedance structure will activate the
Controlled Impedance toolbar.

Stack Up Editor | DRC: 4 Controlled Impedance | CI Resuits |

The structure appears in the Controlled Impedance panel,
along with its parameters.

66 e Speedstack PCB Stackup Design and Documentation



Speedstack User Guide

More Calculations

Stack Up Editor | DRC :4 Controlled Impedance | CI Resuits |
330 (= 5 S
L:1 | I=:| =:|_ >| >I|

Coated Microstrip 1B

Substrate 1 Height H1 [3.0000
Substrate 1 Dielectric Erl|4.2000
Lower Trace Width W1 |9.8425
Lpper Trace Width W2 (97244
Trace Thickness T1 |1.4000
Coating Above Substrate C1 [1.0000
Coating Above Trace C2 |1.0000
Coating Dielectric CEFIW
Impedance Zo W
Target Impedance IW
Target Tolerance % IW

Calculating the structure impedance

Parameters calculated from the stack materials, such as the
substrate height and dielectric are read only and shown
greyed out; other parameters may be edited. If the editable
parameters are known they may be entered directly.

For example, modify W1 to read 4.5 and W2 to read 3.5 and
click the Rebuild and Calculate All Structures.

The impedance is calculated as 50.09 Ohms

Displaying more calculations

Click the More Calculations button — more calculations
provide additional field solver results for the selected
structure within the stack.

Results displayed depend upon the structure — single-ended
or differential.

Single ended calculations include

Creating and editing stackups (Virtual Material mode) ¢ 67



Speedstack User Guide

impedance,

delay,

inductance and capacitance,
effective dielectric constant and
velocity of propagation

See single-ended dialog below

Maore Calculations

Impedance Zo |5D.DE? | Cloze |
Delay (ps/in) D |156.701

Inductance (nHfin) L IW

Capacitance (pF/in) C W

Effective Dielectric Constant EEr 3471
Welocity of Propogation (CITS) Vp 0541

More single-ended calculations

Differential calculations include:

differential impedance,

odd mode delay,

odd mode and even mode impedance,
common mode impedance,

effective dielectric constant,

velocity of propagation,

near-end crosstalk and

coupling percentage

See differential dialog below.

More Calculations

Differential Impedance Zdiff [99.673 | Close |
Delay (Odd Mode) (psiin) D |152_5E,1

Odd Mode Impedance Zodd [49.837

Even Mede Impedance Zeven ER.725

Commaon Mode Impedance Zcommen W

Effective Dielectric Constant EEr 3247
Welocity of Propogation (CITS) Vp 0.555
Mear-End Crosstalk (MEXT) Kb 2. 78591E-02

Coupling Percentage CP 2739

More differential calculations

Goal Seeking the target impedance

= |Goal Seek button

Speedstack can adjust one or more structure parameters to
achieve a specified target impedance. Leave the Target
Impedance at 50 Ohms and click the Goal Seek button
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From the Set Up Goal Seek dialog choose W1/W2 only

Set Up GoalSeek

N

Goal Seeking Farameter(s)

* W12 only
~

H1 Cnly

i I B T B B

oK | Cancel |

Click OK — Speedstack adjusts trace width (below) to
achieve the target 50 Ohm impedance.

Substrate 1 Height H1 |6.2000
Substrate 1 Dielectric Erifa2000
Lower Trace \Width W1 10.7037
Upper Trace \width w2 7037
Trace Thickness T1 |1.4000
Coating Above Substrate Ci W
Coating Above Trace C2 |1.0000
Coating Dielectric CEr|3.0000
Impedance Zo W
Target Impedance W
Target Tolerance % W

With the impedance in tolerance the navigation buttons
display green.

Mirroring structures

This example stack is symmetrical so structures may be
copied to the lower half of the stack (i.e. on the lower outer
layer.) Click Mirror Structures if Stack Symmetrical.

The impedance structure on Layer 1 is copied to Layer 8.

Rebuilding the stack

During stack editing changes to the stack (for example,
inserting prepreg materials into a layer or altering the existing
material thickness) will affect the impedance value of one or
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more structures. If Speedstack senses that an impedance
structure has changed it issues a Rebuild alert.

Stack Up Editor | DRC: 0 Controlled Impedance | CI Resits |
* +. IJ I.”I I ~ - GHI
-I-X)t»&!&ﬂ =g
All -
Rebuild and Calculate All Structures

Click Rebuild and Calculate All Structures — Speedstack
recalculates the impedance for the new parameters. If the
impedance value is out of tolerance the structure browse
control changes colour to red.

Virtual Material mode allows the designer to experiment with
material properties to examine the effects on impedance
structures of different trace widths or dielectric heights, etc.
Materials may be added, moved, copied, pasted or removed
and the properties of materials changed — Speedstack will
sense the changes and allow the “generic” stack to be rebuilt
and recalculated.
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Creating and editing stackups (Material Library mode)

This section describes creating stackups using the Material
Library mode. Stackups may be created manually using the
Stackup Wizard or using the editing window. Ensure Tools|
Virtual Material Mode is toggled Off.

Using the Stackup Wizard (Material Library Mode)

p:

Stackup Wizard button

The Stackup Wizard guides the user through the process
of creating complex stackups in only a few steps. Click the
Stackup Wizard button or choose Stackup Wizard from the
File|[New sub menu. The stackup editing window is cleared
and the Stackup Wizard displayed.

Stack Up Thickness: 0 (Mils)

A& stack Up Wizard (Material Library Mode) - O d
General Planes and Mixed Layers
Layer count hd ¥ Symmetrical
Plane Layers Mixed Layers
Build Type | -]
Materials
Soldermask |
Foil |
Prepreg | Clear Clear
Prepreg |
Dirilling
Prepreg |
Core | [ Through-Plated I Mon Through-Plated

Apply | Cancel |

Stack Up Thickness with Soldermaskc: 0 (Mils)

Using the Wizard the user can specify the layer count and
build type, stackup materials, planes and drill types in a
single operation.

Electrical layer count

Begin by specifying the electrical layer count — up to 64
electrical layers may be specified. Choose the number of
layers from the drop down list box.

Build type

Choose the build type (Foil or Core) from the drop down list
box. Core builds contain only core materials; most builds will
be foil builds — containing internal layers of cores with two
outer foils.
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General

Layer count R -
Build Type | Fail =] @

Choosing stackup materials
Note; if Core build type has been specified the Foil material
control will be disabled.

The Wizard allows for a stack comprising solder mask, foil,
and cores with up to three prepreg materials between.

Stack Up Thickness: 59 2 (Mils)

AL stack Up Wizard (Material Library Mode) - O *
General Flanes and Mixed Layers
Layer count 8 hd v Symmetrical
Flane Layers Mixed Layers
Build Type |Foil | ] ]
2
3 3
Materials 4
5
Soldermask |Liq|_|id Photolmageable Mask SM: Clear 5 6
Fail |Copper Foil FO/002 Clear ] é
Prepreg |PreFreq 1080 PP/001 Clear Clear Clear
Prepreg |PrePreg 1080 PP/O01 Clear
Drilli
Prepreg | Clear —
Core |FH4Core o7 Clear [+ Through-Flated I Mon Through-Plated
Apply | Cancel |

Stack Up Thickness with Soldemask: 61.2 (Mils)

The Wizard displays a running total of the stackup thickness
in the Wizard’s status bar.

Adding layers

To include a layer (in this example a foil layer) click the Foll
Add Material button; the library of foil materials is displayed.
Choose the foil material from the list and click the Add
Material Above button; the material is added as a foil layer
to the stackup.

3 = Vi Yi

Supplier Supplier Description| Description Stock Mumber | Cu Base Thickness | Type

| d PolarSamples FO/004 CopperFoil0.7  100-004 0.7 Copper
PolarSamples FO#002 CopperFoil1.4 100-002 1.4 Copper
PolarSamples FO/003 CopperFoil2.8 100003 2.8 Copper
PolarSamples FO#005 CopperFoil0.7 100-005 0.7 Copper
PolarSamples FO4005 CopperFoil1.4  100-005 1.4 Copper
PolarSamples FO/006 CopperFoil2.8 100-006 2.8 Copper

Repeat the procedure for prepreg and core materials and the
(optional) solder mask layers. Use the Clear button to
remove a layer from the stackup.
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Materials

Soldermask |IJquid Photolmageable Mask SM: | Clear |
Foil [Copper Foil FO/002 .| Clear |
Prepreg [PrePreg 1080 PP/001 | Clear |
Prepreg [PrePreg 1080 PP/001 | Clear |
Prepreg | | Clear |
Core [FR4 Core CO/017 .| Clear |

Nominating power planes and mixed layers

Use the list boxes to specify planes as power planes or
layers as mixed layers. Select all planes as required. To
remove a plane from the list select the plane number from
the list and click Clear.

Planes and Mixed Layers
v Symmetrical
Flane Layers Mixed Layers
1 1
2
3 3
4
3]
& &
8 8
Clear Clear

The dialog above shows Layers 2, 4, 5 and 7 specified as
power planes

Adding drill information

To add a drill between electrical layer 1 and the last layer
click the Through-Plated and Non-Through-Plated check
boxes as required.

Drrilling

W Through-Plated [ MNeon Through-Plated @

With all build options specified click Apply to complete the
stackup. The finished stackup appears in the Editor window.

The example stack below includes two prepreg materials
between layers.
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1.000

3.000
Liquid Photolmageable Mask
Copper Foil 3.000

PrePreg 1080 8.000
PrePreg 1080

3.000
FR4 Core 3.000
PrePreg 1080 5.000
PrePreg 1080

3.000
FR4 Core 3.000

PrePreg 1080 8.000

PrePreg 1080

3.000
FR4 Core 3.000
PrePreg 1080

1.000
PrePreg 1080

Copper Foil

Liquid Photolmageable Mask

Summary information is shown in the Status Bar and
includes the units in use, the target stackup thickness and
the stackup thickness without and with soldermask.

MilsiThous

Target Stack Up Thickness = 60.0000 |Stack Up Thickness = 59.2000 |Stack Up Thickness with Seldermask = §1.2000
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Changing the stackup view

ar For many editing operations changes to the stack may be
_ easier to visualize when shown two-dimensionally. Click
See 2D View the See 2D View button

Liquid Photolmageable Mask 1.000
Copper Foil
PrePreg 1080

PrePreg 1080
FR4 Core , 6.000

PrePreg 1080 3.000

PrePreg 1080 3.000
FR4 Core 8.000

PrePreg 1080 3.000

PrePreg 1080 3.000

FR4 Core 8.000

PrePreg 1080 . 3.000
PrePreg 1080 3.000
Copper Foil

Liquid Photolmageable Mask 1.000

Filtering Materials

When adding or swapping materials, available materials
(foils, prepregs, etc.) are listed in the associated material
library dialog.

Lists can be filtered for materials matching desired
parameters (dielectric thickness, Er, etc.) See Using
Speedstack Materials Libraries.

Saving stackups

It is strongly recommended that users save work frequently and
maintain safe backups of stackups and projects.
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Creating stackups manually

Speedstack allows the designer to add or edit stackup layers
in any order, from top to bottom, bottom to top or from the
centre layer outwards. This example will create a four-layer
stackup, starting at the centre core layer and adding layers
above and below.

Consistency of units

When defining dimensions for a stackup (for example, layer
thicknesses) ensure that all measurements are defined using
the same units (mils, mm, etc.) throughout the structure and
its libraries.

Note: the libraries supplied for these examples are preloaded
with sample data only.

Click the File|[New command and choose Empty Stackup —
creating a project will clear the stackup screen and notes and
information text areas — click OK.

Speedstack

You are about to start a new project, Clicking OK will discard all data in
the current project. Click Cancel if you do not wish to continue,

OK | Cancel

Supply the descriptions in the New Stackup File Properties
dialog.

Click the File|]Save Stackup or Save Project command to save
the stackup or project. Users are recommended to save
stackups or projects frequently during the stackup creation
process to avoid data loss. Stackup files, project files and
library files should be backed up to a secure location.

Editing the stack

When editing the stack, it will probably be most convenient to
right click an object in the stack and select the associated
command from the context menu. The menu will reflect the
commands available for the selected object — commands
that are not appropriate for the object are greyed out.
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i

Open Materials Library

Add

Add C.l. Structure

Set to Signal
Set to Plane
Set to Mixed

Set to Hatched

View Hatch Profile

Full Stack Up Editor Mode

Foil

Core

RCC

Flexible Core
Bondply
Adhesive

Prepreqg
Men-Copper Core

Seldermask

Edit Hatch Profile Coverlay

Copy Ident

Paste Above Peelable

Paste Below Drrill

Delete

Swap

Move Up

Move Down
Properties

Flexi-Rigid >

Alternatively, select the object (copper, prepreg, core, etc.)
with the left mouse button and choose the command from
the Speedstack toolbar.

Adding layers to the stackup

Note, when adding layers to the stackup, the Speedstack
alert that adding materials to the stackup can invalidate
existing structures

This action will invalidate some or all existing structures, You
' will be able to check and re-allocate them afterwards using

the Structure Validation and Structure Layer Properties
options. Do you wish to proceed?

Yes Mo |

Items added to the stackup are added from the currently
open materials library. Speedstack opens Program
Files\Polar\Speedstack\default.mlbx if it exists; if a different
library is required, open it via the Open Materials Library
button. The Materials Library toolbar is displayed

"TTY YN 2 e

[

Open Library

[iP

Open and Append Library

Note: Speedstack does not ship with the default.mlbx library.

For this discussion open one of the two sample library files,
Speedstack Imperial.mlbx or Speedstack Metric.mlbx.

Use the Open Library icon to navigate to the Program
Files\Polar\Speedstack\Samples folder, created at
installation time.

To add the library to the current library, use the Open and
Append Library icon
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Adding a core layer

é Click the Add Layer Material button and choose Core...the
= Core library is displayed
Add Layer Material Y play
The Core library contains full details of the core material,
including base and finished thicknesses, dielectric constant,
and upper and lower copper thicknesses.
Supplier Description | Description | Stock Mumber Dielectric Base Thickness | Dielectric Finished Thickness | Dielectric Constant UpperCu Base Thickness | Lower Cu Base Thickns
SO0 FR4 Core 2 400-001 2 2 4.2 0.7 07
Covo02 FR4 Core 2 400-002 2 2 42 1.4 1.4
Coio3 FR4 Core 2 400-003 2 2 42 2.8 2.8
COi004 FR4 Core 3 400-004 3 3 42 0.7 0.7
C0/005 FR4 Core 3 400-005 3 3 4.2 1.4 1.4
Click on any of the column buttons to sort the library list by
the selected column.
— Choose a core type from the list of cores and click the Add
i Material Above button. The core is added to the stackup
Add Material Above screen. When editing a stack this button adds a core above

the selected layer.

Stackup core layer

PR Layers may also be added below the selected layer. The
— Add Material below button adds a core below the selected
Add Material below Iayer'

As each layer is added the stackup information table is
updated to reflect the current status of the stackup.

Stack Up Information

Field Value
Electrical Layer Count 2

Stack Up Cost 0.00
Copper Thickness 11.0236
Dielectric Thickness 51.9685
Solder Mask Thickness 1.9635
Target Stack Up Thickness &Z.9521
Stack Up Thickness BZ.9521
Stack Up Thickness with Soldermask  64.9606

Stackup information table

Note: The Stackup Information is printed in red when the
stack thickness is outside its tolerance.

With the core selected, the Selected Item table displays the
properties of the core.
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Selected Item Information : Caore

Field Walue -
lJpper Cu Base Thickness 35.00
Upper Cu Finished Thickness 35.00
|Ipper Copper Coverage 0
Minimum Trace Width 75.00
Data Filenames

Diglectric Base Thickness 100.00
Dielectric Fimshed Thickness 100.00
Dielectric Constant 42
Loss Tangent 0.0155
Resin Content 83

Ta 180
Td 0

CAF Resistance 1]

Z Buis BExpansion 0
Excess Fesin 0.00
|zolation Distance 100.00
Lower Cu Base Thickness 35.00
Lower Cu Finished Thickness 35.00
Lower Copper Coverage 0
Minimum Trace Width 75.00

Core layer information

To observe the properties of any material, click the material
in the stack and read off the properties in the Selected ltem
Information panel.

Editing the selected layer properties

To change the properties of the selected object (for example,
to modify the dielectric constant or the value for the finished
thickness of the dielectric), right click the object in the
stackup and choose Properties from the shortcut menu; in
this example the Core Properties dialog is displayed.

Note that the Enable Finishing setting in the Tools|Set
Stackup Thickness/Enable Finishing dialog must be
unchecked to enable the dielectric and copper Finishing
Thickness to be specified manually.

Target Stack Up Thickness / Enable Finishing

Enable Preprag Finishing [
Enable Copper Finishing [

Apply | Cancel |

In the dialog below, the Finished Thickness settings are
shown greyed out.

Change the value to the corrected value and click Apply.
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Core Properties
Main | Notes | Atributes
General Information Apply
Supplier |POIar Samples Exchange Copper | Close
Supplier Description [coso0s
Description |FF~!£ Core Cost ’W
Stock Number |iCC-CCS Tolerance 10.00
Type [FRe lead Time  [0.00
Upper Copper
Base Thickness ’W Copper Coverage % ’W
Finished Thickness W Graphical Colour ,7
Data Filename |
- Remove Copper ) r
(dizabled if structures or sub-stacks exist)
Finizhing Applied N
Dielectric
Base Thickness 100.00 Td oo
Finished Thickness [to000 CAF Resistance oo
Dielectnic Constant W Z fas Expansion ’CCi
Less Tangent ’W Excess Resin 0.00
Resin Content % ,W |solation Distance 100.00
Tg 180.0 Graphical Colour [
Lower Copper
Base Thickness ’W Copper Coverage % 0.00
Finished Thickness ’W Graphical Colour ,7
Data Filename |
=l Remove Copper ) w
(dizabled if structures or sub-stacks exist)
Finishing Applied N

Adding data file names

If available, add the data file name(s) to the upper and lower
copper layers and click Apply.

Close the dialog when all changes are completed.
Changes will be reflected in the Stackup Information table.

Changing a layer function
In this example both the signal layers above and below the
core dielectric are changed to planes.

Click the lower signal layer and click the Set Layer Plane
’ button. Repeat for the upper signal layer.

Set Layer to Plane

The changes are reflected in the stackup window
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Exchanging layers

To change just the core dielectric (leaving the copper layers
unaffected), right click the core material (for example the FR4
in the graphic above) and choose Swap from the context

@ menu or left click the core material and click the Swap
Selected Material button. Choose the new core type from the
Swap Selected Material library and click the Swap button. The layer properties will

change to reflect the new material and changes appear in the
Stackup Information table.

Adding prepreg layers
" With the core selected, click the Add Material button and
—_— choose Prepreg...; the Add Prepreg library is displayed.
== | Add Material
Supplier Supplier Description Description Stock Mumber Dielectric Base Thickness | Dielectric Finished Thickne| Dielectric Constant Loss Tangent Resin Content
PolarSamples PPi005 PrePreg 106 300-005 50 50 42 0.0195 a0
PolarSamples PPi001 PrePreg 1080 300-001 75 75 4.2 0.0185 60
PolarSamples PPi004 PrePreg 1651 300-004 150 150 42 0.0195 47
PolarSamples PPi002 PrePreg 3080 300-002 75 75 4.2 0.0185 60
PolarSamples PPi003 PrePreg 3113 300-003 100 100 42 0.0195 53
PolarSamples PPi005 PrePreg 7628 300-005 200 200 4.2 0.0185 45
The Prepreg library contains details of the prepreg material,
including base and finished thickness, dielectric constant and
loss tangent, resin content and excess resin.
T Choose the Prepreg material from the database and click the
e Add Material Above button.
Add Material Above

PrePreg 1080 e anaaanann 3 000

The prepreg layer is added above the core.

To change the properties of the prepreg material right-click
the layer and choose Properties from the short cut menu.
Items with a white background can be modified.

Dielectric
Base Thickness 125.00 Td oo
Finished Thickness 12500 CAF Resistance o
Dielectric Constant ’W £ foas Expansion Iﬂi
Loss Tangent ’W Excess Resin 0.00
Resin Content 3 ’T Isclation Distance W
Tg 180.0 Graphical Colour r

Select the Core material and click Add Material|Prepreg to
display the prepreg library and click the Add Below button. The
layer of prepreg is added below the core.

=

Add Prepreg Below
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PP

Core

PP

PrePreg 1080

FR4 Core

PrePreg 1080

Modify the properties as necessary.

Choosing the Display Data fields

The Speedstack Stack Editor provides a range of useful data
fields for optional display alongside each material. Base and
Finish (Display Field 4) refer to thicknesses and weights and
appear to the left of the stackup graphic.

Hatch Defaults | Extemal Utilities | Rebuild and Caleulate Structures |
General | Structure Defaults I Licensing I File Locations I Goal Seeking I Auto Stack I User I CITS Test I Colours I Passwords | Miscellaneous I
—Default Stack Up View ——— [ Display Data
fals Display Fields 1 and 2 are reserved for Layer Numbers and Layer Types
Display Field 3 Display Field 4 | Display Field 5
& 3D Description ;I Base Thickness LI Finished Thickness ;I
Finished Thickness A
. Finished Thickness Copper Coverage
[~ Units Copper Coverage Isolation Distance
Isalation Distance Dielectric Canstant
¥ Mils/Thous ™ Microns ™ Millimetres {| Dielectric Constant Resin Contert
Resin Cantent Tg
Tg Calour
Processed Thickness ¥ Data Filenames b
[¥ Open last used file on application start up
¥ Display File Properties Dialog for New Stackups and Projects
Apply | Cancel |

Display Field 5 appears to the right of the stackup graphic.
Choose the data of interest from the dropdown lists.

Note: Processed Thickness is the Finished Thickness for
copper layers and Isolation Thickness for dielectric layers.

Adding a foil layer

Select the upper layer of prepreg and click the Add Layer
Material button and choose Foil to display the copper foil

library.
Supplier Description | Description | StockMumber | Cu Base Thickness | Type | Cost | Lead Time
FCWoo1 Copper Foil  100-001 0.7 Copper 1 a
Fowoo2 Copper Foil  100-002 1.4 Copper 2 a
FCWOo3 Copper Foil  100-003 2.8 Copper 3 a

Choose the foil type and click Add Above, the copper foll
layer is added above the selected prepreg layer.
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FR4 Core

PrePreg 1080

Copper Foil

PrePreg 10580

FR4 Core

PrePreg 1080

Copper Fail

Repeat the procedure for the lower prepreg layer: select the
lower prepreg layer and add a layer of copper foil below the
layer (shown below as layer 4 in the 3D view).

3.000

To alter the foil properties, right-click the foil layer and
choose Properties. Using the Properties dialog the user can,
for example, specify that the trace is shown inverted.

—Copper
Base Thickness IW Copper Coverage % IF
Finished Thickness Iﬁ Graphical Colour _
Data Filename |
Trace Inverted v :___. b N o ne _ - |
Finishing Applied v _ '

Note that the stackup is being built symmetrically about the
centre layer.

Adding solder mask layers

With the upper layer of foil selected, click the Add Layer
Material button and choose Soldermask to add a layer of LPI
solder mask above the foil.

Supplier Description | Description | Stock Mumber | Mask Thickness | Dielectric Constant | Colour | Type Cost
SMa01 Liquid Photolmegesbe Mesk 500-001 1 4 Green SolderMask 0.5
SMao2 Liquid Photolmegesbe Mesk 500-002 1 4 Green SolderMlask 0.6
SM003 Liquid Photolmagesbke Mask 500-003 1 4 Blue SolderMaszk 0.5
SMO04 Liquid Photolmagesabke Mask 500-004 1 4 Red SolderMask 1
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Repeat the process for the solder mask material below the
lower foil layer.

Ligud Photolmageable Mask

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080
Copper Faoil
Liquid Photolmageable Mask

Adding the Ident layers

Select the lower LPI Soldermask layer and click the Add
Layer Material button and choose Ident to add a layer of
Screened Ident below the layer. The sample Ident library
includes ink thickness and colour

Supplier Description | Description | Stock Mumber | Ink Thickness | Colour | Type | Cost

1DvD01 Screened ldent §00-001 2 White Ident 0.1
1Dvon2 Screened [dent &00-002 2 Yellow Ident 0.1
1DV003 Screened |dent &00-003 2 Black Ident 0.1

Repeat for the upper layer.

Screened Ident
Liguid Photolmageable Mask
Copper Foil

PrePreg 1080
FR4 Core

PrePreg 1080

Copper Foil

Liquid Photolmageable Mask

Screened |dent
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X

Delete Selected Material

=

Copy Selected Material

m] [m]
CORY

PP

Caore

PP
PP

PP

Copy Material Properties

Adding notes

Click the Notes tab and click Add to supply descriptive and
explanatory notes.

Deleting a layer

To remove a layer from the stackup select the layer and
click the Delete button.

Copying a layer
With layers defined it will often be found more convenient to

copy an existing layer and paste it into the stackup than to
create a new layer “from scratch”.

Select the layer to be copied and click the Copy Selected
Material button.

Click the layer nearest the destination location and choose
Paste Above or Paste Below as appropriate

Note: when modifying the stackup it may be necessary to
redefine the drill information to reflect the changes.

Copying material properties

Speedstack can copy material properties from one material
in the stackup and paste them onto multiple materials
simultaneously.

For example, to replace the three prepreg materials below
Layer 3 in the stackup below with the Layer 1 material,
PrePreg 1080, select the source material (shown
highlighted below) and click Copy Material Properties

1.100

1.950

Liquid Photolmageable Mask

Copper Foil C

FR4 Caore

PrePreg 3080

PrePreg 1651

PrePreg 1651

3.100

2776

12.000

Select the three target layers

Creating and editing stackups (Material Library mode) ¢ 85



Speedstack User Guide

1.100

e "~ 1950
Liguid Photolmageable Mask

Copper Foil C & = OO : 3100

PP PrePreg 1080

Core FR4 Core

B PreP

{.’gg Click Paste Material Properties — the Paste Material

Paste Material Properties dialog is displayed.
Properties

Paste Material Properties

Please select the Property Groups that you wish to paste to the selected matenals:

General Properiies (Al Matenals)
[v General Information (Supplier, Description, Stock Mumber etc)

[v Notes (5 x Mote properties)

[v Colour (Draw colour)

Conductor Properties (Foil. Core, RCC, Flex Core)
v Copper (Base and Finished Thickness, Copper Coverage etc See Note 1)

MNote 1: Layer Numbers and Layer Types assigned to Copper layers are not copied.

Dielectric Properties (Core, RCC, Prepreg. Flex Core, Bondply, Adhesive)
[v Dielectric (Base and Finished Thickness, |solation Distance, Diglectric Constant etc)

Solder Mask Properbes (Solder Mask)
[v Solder Mask (Thickness, Dielectric Constant etc)

Coverlay Properties (Coverlay)
[v¥ Coverlay (Base and Finished Thickness, Dielectric Constant etc)

Ident Properties (ldent)
[v |dent (Thickness etc)

Peelable Properhes (Peelable)
[v Peelable (Thickness tc)

¥ Select/ Deselect All pply | Cancel |

Select the property groups that are to be applied to the target
materials and click Apply. Properties that do not apply for a
material type are ignored.
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1.100

. F 1950
Liquid Photolmageable Mask

Copper Foil C 3.100

PrePreg 1080

FR4 Core

PrePreg 1020

12.000

In this example all material properties have been applied to
the three target materials.

Note: When changing multiple materials simultaneously it is
important to review the resulting stackup.

It will probably be necessary to recalculate any associated
controlled impedance structures, especially if dielectric height
and copper thickness parameters have changed.

Moving materials

1‘ To move materials within the stackup click Move Selected
Material Up and Move Selected Material Down.
Move Selected
Material Up
T When a material is moved it is exchanged with the layer
Move Selected above or below, respectively.

Material Down

Applying finishing
To apply the finished thickness factor throughout the board,
click the Apply Finishing button with no material selected.

@é To reset the finished thickness back to the original base
Apply Finishing thickness of the materials throughout the board, click the
Reset Finishing button with no material selected.

% Note: when applying or resetting finishing, if a material is
selected it will be necessary to specify whether finishing is to
be applied to the selected material only or the whole stack.

Reset Finishing
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Adding drills

To add a drill between layers, click the Add Drill button; the
Add Dirill dialog is displayed.

9
AddDrill

E[= Add Drill

Main INntes I
— Elecincal Layers

First Electrical Layer Second Electrical Back Drill Must-Cut Back Drill Must-Not-Cut

Stack Up Column

MNo (Start Layer) Layer No (End Layer) Layer No Layer No
I = =l s = =i =
— Drill Information — Hole Information
" Mechanical Fill Type Hole Count Minimum Drill Size
' Laser No Fil - o jo.0o
" Laser (Stacked) Different Hole Sizes Minimum Dinll Size Tolerance (Abs)
" Back Drill o {0.00
¥ Through Plated I™ First Layer Capped Minimum Hele Size Minimum Barrel Wall Thickness
. " Second Layer Capped Iﬂ_m Iﬂ,_m
Data Filenames
Minimum Pad Size
0.00

— Back Drill Information

Minimum Distance From
Must-Cut Layer

Minimum Distance From
Must-Mot-Cut Layer

nnn
Uy

Maximum Distance From
Must-Cut Layer

n nn
(TR

Maximum Distance From
Must-Not-Cut Layer

nnn n nn
Uy (TR

Primary Drill Size

nnn
Uy

pd | Close |

Drill information is stored in columns. Select the column in
which to place the drill. Choose the first and second electrical
layer numbers (layers 1 and 4 in the example).

Specify the drill type, mechanical or laser and whether
through plated and whether the layers are capped.

Note that with laser drills the order of drill layers is important,
e.g. layer 1 and 4 is different from layer 4 and 1.
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Specifying the drill fill type
Choose the Fill Type from the dropdown list of fills.

No Fill Copper Fill Conductive Epoxy | Solder Mask Fill
Fill

Adding the drill data filenames

Optionally, add the NC drill data filenames.

Optionally, add the hole count, number of different hole sizes
and the minimum hole size. Click Add and close the dialog.

The drill information is added to the stackup. The example
below contains through plated and laser drill information.

Note: The drill properties (i.e. Drill Information and Hole
Information) are retained between each Add Drill operation.
This can speed up the process of adding drills, especially
when multiple drills of the same type are being added to the
stackup.

The finished stackup is shown below

Screened [dent
Liguid Photolmageable Mask
Copper Foil

PrePreg 1080
FR4 Core

PrePreg 1080

Copper Foil
Liguid Photolmageable Mask

Screened [dant

Drill capping

The Drill Cap feature documents when via holes are
capped, i.e., where a conductive ‘cap’ is added to the via
hole during fabrication. Capping is often applied to buried
vias, (plated holes that start and end on inner layers of a
stack up.)
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Mechanical drills Drill Cap option

Dl Informahion

{* Mechanical Fill Type

e -
" Laser (Stacked)

" Back Drill

[+ Through Flated Iv First Layer Capped
Iv Second Layer Capped

Mechanical drills offer four drill cap states: (the default state
is no drill cap when adding a drill.)

e Neither first or second layer capped
e First layer capped

e Second layer capped

e Both layers capped

Laser drills Drill Cap option

Drill Information
" Mechanical Fill Type

(+ | aser |N|:| Fill
" Laser (Stacked)
" Back Drill

I+ Through Plated Iv First Layer
[

Laser drills offer two states (as with mechanical drills the
default state is no drill cap when adding a drill.)

¢ Not capped
e First layer capped
Note that the Second Layer Capped checkbox is disabled.

Specify the Drill Cap option and click Apply — the capping
specified is reflected in the Drill Information pane.

Selected ltem Information : Dnll

Field Walue
First Electrical Layer Mo 4
Second Electrical Layer Mo 7
Mechanical Drill True
Laser Drill Falze
Back Drill Falze
Through Flated True
First Layer Capped True
Second Layer Capped True
Fill Type Ma Fill
Data Filenames
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PP

Core

Deleting drills

To delete a drill right click the drill and from the context menu
choose Delete. To delete all drills choose Delete all Drills —
confirm via the dialog below.

Speedstack *

You are about to delete ALL drills from the stack. Do you wish to continue?

Yes MNo | Cancel

All drills will be cleared from the stack.

Adding stack vias

Speedstack can add stack vias to the stackup in a single
operation. To add stack vias between layers 1 and 5 in the
stackup below, select layer 1 and click Add Drill.

1.000

Liguid Photolmageable Mask

Copper Foil

PrePreg 3113

Copper Foil
PrePreg 1651
Copper Foil
PrePreg 1651
Copper Foil

PrePreg 1651

FR4 Core

5627

8.000

5627

Specify the column number — (Column 1)

Specify electrical layers 1 and 5 (Note: drills cannot have the
first electrical layer on the underside of a core material)

Choose Laser (Stacked)
From the Fill Type drop down list choose Copper.
Click Add.
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PP

Core

&= Add Drill
Main |No‘teg |
—Electrical Layers
Stack Up Col First Electrical Layer  Second Electrical Back Drill Must-Cut Back Drill Must-Not-Cut
tack Up Column Mo (Start Layer) Layer Mo (End Layer) Layer Mo Layer No
I = h s = h =l =
r—Drill Inf —Hole Inf
" Mechanical Fill Type Hole Count Minimum Drill Size
C Laser - o fo.00
% Laser (Stacked) Different Hole Sizes Minimum Drill Size Tolerance (&bs)
" Back Drill Jo [0.00
I Through Plated I First Layer Capped Minimum Hole Size Minimum Barrel \wall Thickness
] " Second Layer Capped Iﬂ_m Iﬂ_m
Data Filenames
Minimum Pad Size
0.00
—Back Drill Infc

Must-Cut Layer

Minimum Distance From

Minimum Distance From
Must-Not-Cut Layer

Must-Cut Layer

Maximum Distance From

Maximum Distance From
Must-Not-Cut Layer

Primary Drill Size

add | Close |

The stack vias are added to the stack (below.)

1.000

Liquid Photolmageable Mask

Copper Foil
PrePreg 3113

Copper Foil

PrePreg 1651

Copper Foil
PrePreg 1651
Copper Foil

PrePreqg 1651

FR4 Core

5627

3.000

5627

Via stub removal (controlled depth drilling / back drilling)

PCB vias provide a conductive path to allow the transition of
electrical signals between circuit layers through the walls of
plated holes.

The most common method of connecting two signal layers is
to create a plated through hole through the entire board and
then remove the unwanted portion of the plated through hole
— the stub, the unused portion of via extending further than
the last connected inner layer — by back drilling.

Stubs can lead to reflections, discontinuity errors that
become critical with increasing propagation speed, so are
commonly removed.
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Peelable Mask
Screened Ident

The stackup below shows a plated through hole back drilled
from layer 8 to 6, resulting in a via between layers 1 and 6.

Liquid Photolmageable Mask

Copper Faoil
PrePreg 3113

PrePreg 3113

FR4 Core

FR4 Core

PrePreg 3113
PrePreg 3113

Copper Foil

Liquid Photolmageable Mask

|y
Add Drill

Specifying back drills
To add a back drill click Add Drill to display the Add Drill

dialog.

203.2000
50.8000

35.5600
86.3600

3.3400
203.2000
35.5600

91.4400

91.4400

91.4400

91.4400

EI= Add Drill
Main |No‘teg |
— Elecincal Layers
First Electrical Layer  Second Electrical Back Drill Must-Cut Back Drill Must-Not-Cut
Stack Up Column Mo (Start Layer) Layer No (End Layer) Layer No Layer No
E =l s =l = s =l s =
Dl Infor —Hole Information
" Mechanical Fill Type Hole Count Minimum Drill Size
" Laser Mo Fir - o 000
" Laser (Stacked) Different Hole Sizes Minimum Drill Size Telerance (Abs)
{* Back Drill jo j0.00
[T Through Plated Minimum Hole Size Minimum Barrel Wall Thickness

Data Filenames

™ First Layer Capped
[T Second Layer Capped

Jo.0o

Minimum Pad Size

Jo.00

J0.00

—Back Drill Infor

Minimum Distance From
Must-Cut Layer

Minimum Distance From
Must-MNot-Cut Layer

|n.00

Maximum Distance From

|0.00

Maximum Distance From

Must-Cut Layer Must-Not-Cut Layer

|0.00 |]

Primary Drill Size Back Drill Type

[o.00 | Pairted |

g

add |

Close |
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To specify the controlled drilling depth, from the Add Dirrill
dialog:

Choose Back Drill from the Drill Information pane
Choose the drill column and specify the start layer.
Choose the layer number from the Back Drill Must Cut

Layer No.
Choose the layer number from Back drill Must Not Cut
Layer No.
Elecincal Layers
First Electrical Layer Second Electnical Back Dnill Must Cut Back Dnll Must Mot
Stack Up Column Mo (Start Layer) ayer No (End Layer) Layer Mo Cut Layer Mo
7 =l s =l =l I3 =l -

Specifying back drill information
Many drill machines are capable of modifying drill depth to
accommodate inner layer thickness variations.

The Back Drill Information fields allow designers and suitably
equipped board shops to specify controlled stub lengths.

Back Drill Information

Minimum Distance From
Must-Cut Layer

Minimum Distance From
Must-Mot-Cut Layer

|0.00

Maximum Distance From
Must-Cut Layer

|0.00

Maximum Distance From
Must-Mot-Cut Layer

|0.00

|0.00

Use the Back Drrill Information fields to specify the Minimum
and Maximum Distances from Must-Cut Layer and Minimum
and Maximum Distances from Must-Not-Cut Layer.

Choosing a back drill type

Back drill types can be pointed, flat or router as shown below.

From Back Drill Information, specify the back drill type from

the Back Drill Type dropdown

Back Drill Type

| Router

=]

Pointed
Flat
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Pointed Flat Router

Choosing back drill capping

Capping may be applied to the first layer of each back drill
type.

Note that the Second Layer Capped checkbox is disabled.

— Dirill Imformation

" Mechanical Fill Type

" Laser [No Fil -l
& Back Drill

[ Through Plated ¥ First Layer Capped

From the Drill Information pane choose Back Drill and click
on First Layer Capped

From Back Drill Information specify the back drill type

Capping is applied as shown.

The stackup below includes a router type back drill with
capping applied
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25.4000

100.7110
Liquid Photolmageable Mask 4.000/0.0000
Copper Fail 100.7110
PrePreg 3113 4.200/0.0000

PrePreg 3113 4.200/0.0000

FR4 Core 4.200/0.0000

PrePreg 3113 4.200/0.0000

PrePreg 3113 4.200/0.0000
FR4 Core 4.200/0.0000
PrePreg 3113

PrePreg 3113 4.200/0.0000
100.7110

FR4 Care 4 200/0.0000 100.7110

PrePreg 3113 4.200/0.0000 600

25.4000
PrePreg 3113 4.200/0.0000

Copper Foil
Liquid Photolmageable Mask 4.000/0.0000

The drill information is reflected in the Technical Report
From the File menu choose Print Technical Report
The Stack Data Table includes the drill and back drill

Copper Layer Base Processed
Layer Stack up D p Type Thick Thick Resin Content | &r
L e ixuid Fhotolmageatie Mask 25400 4000
1 S A A [ A A A B B B & B Coel signal 17780 25560
e ] PrePreg3113 101.800 100711 53.000 4.200
[ ] PrePreg3113 101600 100711 53.000 4.200
2 A A L & A A A /B 5 A signal 35560 35560
[ | FR4 Core 203.200 203.200 45.000 4.200
3 | | Plane 35.560 35.560
[ ] PrePreg3113 101600 87378 53.000 4.200
[ | PrePreg3113 101.600 87376 53.000 4.200
1 B 9 5 LA O & & & & 8 & 0 5 Signal 35.580 35.360
= =| = | ~ | FR4Core 203.200 203200 45.000 4.200
s Bl 2 B T W Il W W W v v v Signal 35560 8550
[ | PrePreg 3113 101.600 87378 53.000 4.200
[ | PrePreg3113 101.500 87378 53.000 4.200
[ [ | Plane 35,560 35560
| | FR4 Core 203.200 203.200 45.000 4.200
’ v v v v v v vV signal 35580 35560
[ ] PrePreg3113 101.600 100,711 53.000 4.200
¥ | PrePreg 3113 101.600 100.711 53.000 4.200
3 Y w W W W W W W W W W CopperFui Signal 17.780 35.560
VN L4 Photoimageable Mask 25400 4.000
Copper Thick = 284480 | Dielectric Thick = 1361.948 | Solder Mask Thickness = 50,800 |
Stack Up Thickness = 1646.428 | Stack Up Thickness with Soldermask = 1697.228
Stack Up Cost = 77.00
Simple Percentage Finishing Class: ‘Class 1'= 17.780

Page 2 of the Technical Report displays the Drill Data Table

1st | Znd | Column Must-Cut | Must-Not-Cut
Layer | Layer | Position|  Drill Type Layerblo| Layer No

5 3 Mechanical PTH - -

Dvill

Image

I__E L

L

Z 2 . 3 Back Drill 8 5
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D
SM

Displaying the stackup in 2-dimensional view

To change the view of the stackup from its default 3-
dimensional aspect, click the See 2D View button. The
See 2D View stackup is displayed in 2-dimensional view.

Screened |dent
Liguid Photolmageable Mask
Copper Foil

PrePreg 1080
FR4 Come

PrePreg 1080

Copper Foil

Liguid Photolmageable Mask

Screened [dent

Click the View 3D button to restore the 3 dimensional view.

See 3D View

Mirror Builds

Mirror Build allows the designer to consider the stack in two
halves, designing and building, for example, just the top half
and mirroring the structure into the lower half.

Build the top half of the stack, including any controlled
impedance structures and click the Mirror Build button;
specify whether the current set of layers is the upper or lower
half of the stack. To maintain symmetry, Speedstack will add
a layer of material as appropriate to the stack;

Mirror Build
Top
Which half of the new stack is this?
Bottom
[t will b2 necessary to add another prepreg to Cancel |
complete the Mirrored stack.

the stack is reflected symmetrically into the lower half.
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Symmetrical Builds

In Symmetrical Build mode the Speedstack maintains stack
symmetry as the stack designer creates or edits a stack.
Changes in one half of the stack are reflected in the opposite
half of the stack to ensure a symmetrical stack.

This example considers an 8-layer stack — beginning with
three cores and then using Symmetrical Build.

Creating a new stack
Create a new empty stackup and add three cores.

FR4 Core

FR4 Core

When constructing complex structures, it will often be found
easier to use the two-dimensional aspect.

= To change the view of the stackup from its default 3-
d dimensional aspect, click the See 2D View button. The
View 2D button stackup is displayed in 2-dimensional aspect.

Adding a prepreg layer in Symmetrical Mode

In this example it is necessary to add prepreg layers
between cores to achieve the required dimensions.

Switch to Symmetrical Mode and work in the top half of the
stack — in Symmetrical Mode as layers are added to the top

~ | Symmetrical OFF half of the stackup Speedstack will add layers to the lower half
of the stackup to maintain stack symmetry.

Symmetrical ON

To add a layer of prepreg between Layers 2 and 3 select
Layer 3 (the selected layer is shown highlighted in the figure
below.)
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FR4 Core

FR4 Core

FR4 Core

Click the Add Material button and add a layer of prepreg
above Layer 3 (shown highlighted in the figure below).

In Speedstack’s symmetrical mode the prepreg layer is
automatically reflected in the lower half of the structure.

FR4 Core

FR4 Core
PrePreg 1080

FR4 Core

Adding a second prepreg layer

Now add a second layer of PrePreg 1080 above the layer
just added; the new prepreg layer is reflected in the lower
half of the stack as shown below.

FR4 Core

PrePreg 1080
FR4 Core

PrePreg 1080

PrePrg 1080

FR4 Core

Next, add a layer of prepreg above layer L1 in the upper half
of the stackup.

Speedstack in symmetrical mode automatically maintains
stack balance by adding the corresponding layer below L6.
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FR4 Core

PrePrg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080
FR4 Core

PrePrg 1080

Adding foil, LPI Mask and Ident layers

Next, add a foil layer (L1 below) which is mirrored as L8; as
part of the process Speedstack inverts layer L8.

FR4 Come

PrePrag 1080

Copper Foil

Next, LPI solder mask is applied to the top side of the
stackup and reflected on the bottom side.

Copper Faoil
FrePreg 1050

PrePreg 1080

Copper Foil
Liguid Photolmageable Mask

Ident layers (which are not considered components of
electrical symmetry) will not be automatically reflected by
Speedstack as they are added and must be applied
separately to each side of the board.
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Select the upper solder mask and add an Ident material
above; select the lower solder mask and add an Ident
material below.

Screened |dent
Liquid Photolmageable Mask

Copper Fail

Copper Foll
Liquid Photolmageable Mask

Assigning ground planes

With all the material in place, assign ground planes; begin
with layer L2 — it’s reflected in layer L7. Right click the
Set Layer To Plane  copper (L2) in the top core and choose Set Layer to Plane.

PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

Repeat the process for the other ground plane layers; layer
L4 is designated a ground plane, the change is reflected in
L5 in the lower half of the stack.

PrePreg 1080

FR4 Caore

PrePreg 1080
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The completed stack is shown below

Screened |dent
Ligud Photolmageable Mask
Copper Foil

PrePreg 1050
Core FR4 Core

PP PrePreg 1080
PP PrePreg 1080

FR4 Core

PP PrePreg 1080
PP PrePreg 1080

Core FR4 Core

PrePreg 1080

Copper Foil
Liqgud Photolmageable Mask

Screened Ident

Using Ormet® Z-axis Interconnect

Speedstack provides support for Ormet® Z-Axis Interconnect
— or other Any Layer Interstitial Via Technology. Z-Axis
Interconnect provides a method of connecting two PCB
boards using a conductive paste filled into the vias of a
drilled prepreg.

In Speedstack, Z-Axis Interconnects may be incorporated
into a stackup to connect two cores or foils together.

Ensure the Tools|Options|Miscellaneous|Drill Validation
Check box is unticked

[~ Dl Validation Check

This option prevents invalid drills from being added to the stack up. For instance, a dnill that starts from the lower copper side of core
matenals. Uncheck this option if you use a drilling technology that permits drills to be placed between electrical layers which are not
typically supported by conventional mechanical and laser dnlls

With this validation check disabled, Ormet® Z-Axis
Interconnects can be placed between electrical layers which
are not typically supported by conventional mechanical and
laser drills. The Speedstack graphic below shows
interconnects (highlighted in red) bonding adjacent cores.

102 o Speedstack PCB Stackup Design and Documentation



Speedstack User Guide

=H|

N WY N B

|

Adding Ormet® Z-Axis Interconnects

Adding a Z-Axis Interconnect to a Speedstack stackup
consists of adding the specified prepreg between the two
cores to be connected and then adding the drills with the
sintering paste fill.

With the Drill Validation option disabled as described above,
add the prepreg between layers 4 and 5 as shown below.

1.9685
0.7087

Add mechanical drills between layers 4 and 5 and specify the
fill type as Sintering Paste.

0.7087
Core FR4 Core 1.9685

80 1.9685
0.7087
. . B . B AR A R RRRRRRRRrREE—r——E—————————————————————

Edit the Prepreg Properties to reflect the interconnect.

Supplier Description IF‘repreg H035 + Ormet 701
Description [1035 + Omet 701
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Design rule checking

Speedstack includes facilities to check for errors in stackup
design, such as layers placed in invalid order or
asymmetrical structures. The condition of the design rule
checkboxes is carried over from session to session.

The Design Rule Checker (DRC) displays results in the DRC
dialog. As each design rule is broken Speedstack increments
the error count on the DRC tab.

Viewing design rule errors
Click the DRC tab to view errors.

Stack Up Editor DRC: 20 lCl:nntn:ulled Impedance ] C| Results ]
DRC Test Selection
[¥ Design Logic W Symmetry [v¥ Copper Balance
[v Board Thickness
|v Manufacturing Tests (Tools | Manufacturing Constraints)

Active Constraint - Polar Microns

¥ Min. Trace Width v Min. Gap Width
Aspect Ratios

v Mechanical Drill [+ Buried Laser Microvia
[+ Blind Laser Microvia v Trace

I+ Fesin Starvation

The Design Rule Checker checks include checking for:
Two adjacent copper layers
Resin coated copper on internal layer
External prepreg layers
Internal solder mask material
Internal ident material
Internal peelable mask
Symmetry — different material types
Copper not balanced

Board thickness (if the board is outside tolerance the
Stack Information in the Stack editor is displayed in red)

Manufacturing tests

Minimum trace width (the test is carried out when
calculating controlled impedance)

Minimum trace separation (the test is carried out when
calculating controlled impedance)

Drill aspect ratios for plated holes
Track aspect ratio
Excess resin test (Resin Starvation)
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If the Resin Starvation check box is ticked, values are shown
as below; scroll through the layers as required

Excess Resin

2757.1%

Note: If the Resin Starvation check box is ticked, all prepregs
must include valid values for the excess resin field.

Polar Application Note AP509 includes a discussion on
calculating excess resin.

Users can choose to display all errors or to select from a
combination of design errors, symmetry errors and copper
balance errors, etc.; check the boxes as required.

Click on the errors shown in the list to highlight the errors in
the stackup screen.

Resin Level Low: -100.0%

Resin Level Low: -100.0%
Resin Level Low: -100.0%
Resin Level Low: -100.0%

Errors are highlighted in red.

Faoul Copper Fol
PP PrePreg 1080

- Core FR4Core

Correcting design rule errors

Users are strongly recommended to work through and
correct errors in the order in which the errors are listed. Note
that clearing each error may clear other errors in the
process.

Manufacturing tests should be fixed before sending the PCB
for manufacture. Hole sizes should be adjusted to comply.
Failures with track and gap should be corrected, possibly by
changing prepreg thickness and/or dielectric constants.

A collection of manufacturing constraints can be defined and
the required one selected.

Creating and editing stackups (Material Library mode) ¢ 105


http://www.polarinstruments.com/support/stackup/AP509.html

Speedstack User Guide

Creating and using manufacturing constraints

From the Tools menu, select Manufacturing Constraints: the
Manufacturing Constraints window opens, displaying any
manufacturing constraints added. By default, there will
always be at least one.

Manufacturing Constraints

Active Constraint : Fabricator A"

Manufacturer's Mame Blind Laser ViaA R.| Buried Laser ViaA | Mechanical Drill A. R. Minimum Gap Minimum Trace Width Trace A R. Units
| Polar Microns 0.5 0.5 85 75 75 1 Microns
|| Polar Mils 05 05 8.5 3 3 1 Mils
| Polar Millimetres 05 05 8.5 0.075 0.075 1 Millimetres

Polar Inches 0.5 0.5 8.5 0.003 0.003 1 Inches

Instructions: Double-Click the Data Grid row to edit, add or delete a constraint

’—Himim and Set Active Constraint ——————

Highlight | Set ]

Close

4
It is important to always have one constraint set active.

To set the active constraint, select the required data grid row
and click Set. The active constraint is shown above the grid.

The Active Constraint name in the example Manufacturing
Constraints list above is displayed as shown below so the
current selected set of Manufacturing Constraints is easily

identifiable
Stack Up Edtor DRC: 1 | Controlled Impedance | C1 Rests |
—DRC Test Selection
¥ Des=ign Logic ¥ Symmetry ¥ Copper Balance

¥ Board Thickness
¥ Manufacturing Tests (Tools | Manufacturing Constraints)
Active Constraint : Fabricator "A

W Min. Trace Width [¥ Min. Gap Width

Aspect Ratios
¥ Mechanical Drill ¥ Buried Laser Microvia
¥ Blind Laser Microvia ¥ Trace

[” Resin Starvation

Maximum DOrill Aspect Ratio Excesded
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DRC errors are listed below the rules. Clicking the error will
highlight the problem graphically on the stackup

1.0000
1.4000
1.9500
1.4000
3.0000
1.4000

i 2 7760
55520

. 5.5520
1.4000

12.0000
1.4000

g 5.5520

55520
. 2.7760
1.4000
3.0000
1.4000
1.9500
1.4000
1.0000

In the above example the Design Rule Checker reports:
Fabricator A Maximum Drill Aspect Ratio Exceeded

The associated drill is highlighted in the Stackup Editor
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Editing constraints

Double-click on a constraint row will bring up the Edit
Constraints dialog; use the dialog to add, delete or edit
constraints (gaps, trace widths, aspect ratios, etc.)

Edit Constraints

LInits

i+ Mils " Microns

" Inches = Millimetres
Option Name |Fa|:uricat|:ur A
Minimum Gap |3
Minimum Trace Width 13
Mechanical Drill A.R. 3

Blind Via A.R. 0.5

Buried Via AR. 0.5
Trace AR. I

€L < Bof &
Add | Delete | Daone | Cancel

Instructions
Add: Prezs Add, which will add a new blank constraint. Notice the
'n of n' record number will increase. Now key in the constraint
details and select Done.
Delete: Press Delete to remove the existing constraint. Motice the
'n of n' record number will reduce. Then select Done to close the
dialog.
Edit: Edit the existing constraint and select Done to close the
dialog.

To edit a constraint set, use the navigation buttons to select
the set to be modified, change the values as required and
then press Done.

To delete a constraint set, use the navigation buttons to
select the set, then press Delete.

To add a new constraint set, press the Add button, this will
add a new (empty) constraint row, enter the name and
constraint values and press Done.
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Adding controlled impedance structures

Speedstack incorporates the facility to add controlled
impedance structures to a layer in the stackup.

Each structure can be assigned up to five net class names.
These net class names provide a link to the matching
impedance nets inside the ECAD PCB layout system.

Speedstack Si caters for frequency dependent calculations,
adding comprehensive insertion loss capability into
Speedstack.

Speedstack is integrated with the Polar Instruments
Si8000m/9000e controlled impedance field solvers so
impedance values for a structure may be calculated at the
click of a button.

Structure parameters may be copied to the field solver for
processing (for example by the Si8000m/9000e Goal Seeking
function) and calculated values pasted back into Speedstack
for insertion into the stackup.

Bidirectional copy and paste from Speedstack Si into
Si9000e includes all the relevant loss tangent, roughness
and roughness modelling methods along with frequencies of
interest.

Shield materials and controlled impedance / insertion loss

Please note:

Speedstack is capable of supporting many shield types for
stack up design and documentation. For controlled
impedance and insertion loss applications, however, it is
important to use the correct type of shield material.

Shield materials are often designated by the shield vendor as
For high speed signal transmission applications.
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Adding a controlled impedance structure

For the example stack below, add a controlled impedance
structure to signal layer 4.

2.000

/s 1.000
Screened ldent 21000

3.000
Liguid Photolmageable Mask 1.000 —y

Copper Foil 0.7 8.000

PrePreg 1080
3.000

FR4 Core

8.000

PrePreg 1080
P 3.000

FR4 Core
2.000

PrePreg 1020

9" 3.000

FR4 Core

PrePreqg 1080 0 7 000

2 Copper Foil L7 E 7 ¥ 5
- Liguid Photolmageable Mask
- ID Screened |dent

Sample stackup (showing signal layer 4 selected)

Note that in this example Layer 5 is a mixed signal/plane
layer. Potential reference planes for Signal Layer 4 are
therefore Plane Layer 2, mixed Signal/Plane Layer 5 and
plane Layer 7.

With Layer 4 selected, click the Controlled Impedance tab.
The Add Structure button is displayed.

Stack Up Editor | DRC: 1 Controlled Impedance | CI Resuts |

+

Click the Add Structure button; the Structure Control dialog is
displayed containing the controlled impedance structures
applicable to the selected layer in the stack. Choose values
for the target impedance and tolerance. If necessary, resize
the Structure Control dialog to view all structures.
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—Mumber Of Signal ——
Tracks

™ Single Trace
¥ Differential

" Broadside

Target Impedance
Target Tolerance %

Total of Structures Added
Primary Reference Flane

Secondary Reference Plane

Edge Coupled
Offset Stripli...

Edge Coupled
Offset Stripli...

Click the Single Trace, Differential or Broadside option button
as appropriate (in this case, choose Single Trace|Offset
Stripline 1B1A with a 50 Ohm impedance.)

Note: Broadside only appears as an option where the signal
trace is between two reference planes and Differential is

selected.

Specify the values for Target Impedance and Tolerance.

Note that attempting to add structures that would break
design rules will result in the error message below:

Speedstack is unable to add structures to this stack up as it
requires a structure type that is unsupported.

This could be due to a DRC error that can be overridden by
unchecking the ‘Design Logic' selection on the DRC tab.

Please note: unchecking the 'Design Logic option will require
you to check the suitability of the structures used in your
stack up design.
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Choosing reference planes

As there are multiple reference planes available (layers 2, 5
and 7, it will be necessary to specify which planes to use for
this structure. Click Advanced.

Plane(s) Above Signal Layer

Signal Layer = 4

Plane(s) Below Signal Layer

-
i

Caution: When using this option,
please ensure that the electncal
effects of any intervening power |
mixed planes are taken into
consideration

Ok | Cancel

Choose a reference plane from the list of available planes. In
the example structure plane layer 2, mixed plane 5 and plane
layer 7 are available for reference.

Note: if plane layer 7 is chosen as reference, it will be
necessary to take into account the electrical effects of mixed
signal/layer plane 5.

In this example choose mixed signal/plane layer 5. Press OK
to confirm. The chosen reference planes are shown below.

Total of Structures Added |1
Primary Reference Plane |2 Done |
Secondary Reference Flane |5 Cancel |

Repeat for all structures to be added. Click Apply for each
structure then click Done to finish. In this example, choose a
single structure.

- Layers with controlled impedance structures are indicated
by a red Ohms symbol.
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8.000

3.000

Core FR4 Core

&.000
PR PrePreg 1080

Core FR4 Core

The stackup window changes to reflect the selected signal
layer and its associated reference planes. The applied
structure is displayed in the Controlled Impedance pane.

Substrate 1 Height H1 |8

Substrate 1 Diglectric Erl

Substrate 2 Height H2

Substrate 2 Dielectric Ez[az000 |
Lower Trace \width wi[59055
Upper Trace Width w2 25213
Trace Thickness T1 |0.7000
Impedance ZoloOO
Target Impedance W
Target Tolerance % W

The window displays the parameters of the controlled
impedance structure. Fields shown "greyed out" are values
derived from the choice of materials in the stackup. For this
structure, enter the appropriate values for lower and upper
trace widths.
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Controlled impedance toolbar

Controlled impedance operations are performed via the
Controlled Impedance toolbar — activated when a controlled
impedance structure is added to the stackup.

FXR S EEEEE = @58

Add controlled impedance structure to current layer

Delete structure from current layer

Clear all structures from current layer

Rebuild and recalculate all structures

Calculate displayed structure

Snap parameters and calculate structure

B S e 8 X |

More calculations — provides additional field solver
results for the selected structure within the stack. Results
depend upon the structure — single-ended or differential.

IJ Mirror structures

i
| Goal seek
B Set CITS test

nates

Free hand notes

Structure layer properties

Structure validation

v B L

Structure Net Classes

o
I
[

Frequency Dependent Properties
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A+
11

Calculate Displayed

&

e

Structure

Snap Parameters and
Calculate Structure

Structure Browse Control

Use the structure browse control to display the structure on
each layer and navigate through the structures

L4 | I« =:'1Gf1 = | =l

Calculate Displayed Structure

Click the Calculate Displayed button to display the impedance
value of the structure with the current parameters. The
parameters may then be varied to alter the value of the final
impedance. In the example above the trace width can be fine-
tuned in order to approach the value of the target impedance;
other parameters are changed by modifying the stackup
dimensions (for example, core thickness, H1.)

Hint: clicking Apply All in the Structure Control dialog adds a
single instance of all structures matching the stackup layer
and the chosen criteria; the designer can then choose the
structure producing the value nearest the target impedance
and delete the structures that are not needed.

Snap Parameters and Calculate Structure

The Snap Parameters and Calculate Structure button snaps
or rounds parameters to practical values that are more
appropriate for fabrication.

The Snap feature supports the following structure
parameters:

e Lower Trace Width (W1)

e Upper Trace Width (W2)

e Lower Ground Strip Width (G1)
e Upper Ground Strip Width (G2)
e Trace Separation (S1)

e Ground Strip Separation (D1)

e Trace Offset (O1)

The Snap To value for each parameter is held in the
configuration settings (in the example below, 0.25 mils.)
See Configuring Speedstack — Structure Defaults.

+ -]

are

Lower Trace \nfidth w1 [7.6500 Lower Trace Wwidth w1 |7.7500
Upper Trace \Width W2 |6.6500 Lpper Trace Width W2 |6.7500
Trace Separation 51 (8.1150 Trace Separation 51 |8.0000

Original parameter values Snapped parameter values

Displaying More Calculations

Click the More Calculations button — more calculations
provide additional field solver results for the selected
structure within the stack. Note that the More Calculation
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More calculations

option is an on-demand calculation that will only be run if
the More Calculations results are requested.

Results displayed depend upon the structure — single-ended
or differential.

Calculations include
Single ended:
e Impedance
e Delay
e Inductance
e Capacitance
o Effective dielectric constant
e Velocity of propagation
Differential:
e Differential impedance
e 0Odd mode impedance
e Even mode impedance
e Common mode impedance
¢ Odd mode delay
o Effective dielectric constant
e Velocity of propagation
e Near end crosstalk (NEXT)
e Coupling percentage.

Note: The Delay, Inductance and Capacitance results will be
presented per inch or per metre based upon the Speedstack
units selected

More Calculations are included on printed technical reports
which optionally also include insertion loss graphs for user-
nominated structures.

Single ended calculations include impedance, delay,
inductance and capacitance, effective dielectric constant and
velocity of propagation — see single-ended dialog below

Impedance Zo |?5.BD2 | Close |
Delay (ps/m) D 5994.939

Inductance (nH/m) [ IW

Capacitance (pF/m) C IW

Effective Dielectric Constant EEr 1730
Welocity of Propogation (CITS) Vp 0556

More single-ended calculations
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Differential calculations include differential impedance, odd
mode delay, odd mode and even mode impedance, common
mode impedance, effective dielectric constant, velocity of
propagation, near-end crosstalk and coupling percentage —
see differential dialog below.

Differential Impedance Zdiff [100.289 | Close |
Delay (Odd Mode) (ps/m) D 15814.283

(Odd Mode Impedance Zodd 50144

Even Mode Impedance Zeven W

Common Mode Impedance Zcommen (33 543
Effective Dielectric Constant EEr 1038
Velocity of Propogation (CITS) Vp 0.574

Mear-End Crosstalk (NEXT) Kb 7 ZIRTEDZ
Coupling Percentage CP 7226

More differential calculations

Presentation of the More Calculation results match the Polar
Si8000m and Si9000e products

The More Calculation results have been added to the
Technical Report (File|Print Technical Report) as user
selectable Controlled Impedance Table columns. Including
these columns will entail on-demand field solving
calculations that will only be run if required.

Changing parameter values

Clicking the Calculate function yields a value for impedance.
parameters (for example, the dielectric height may be
amended to yield a value for impedance closer to the target
impedance.)

As an example, select the core layers; click the Swap
Selected Material button and choose a different core (ensure
the same dimensional units are used throughout the
structure) and click the Refresh and Calculate Impedance
button. The impedance is recalculated to its new value.

To achieve an impedance acceptably close to the target
impedance, use the goal seeking function of the field solver
to alter other parameters (in this case, change the upper and
lower trace widths).

Goal seeking with Speedstack

Speedstack provides the facility to solve for horizontal
parameters (e.g. trace width and separation, ground strip
separation, etc.) to produce the target impedance (or
calculate that the target impedance is unachievable with the
current values).
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Click the Goal Seek button to display the Set Up GoalSeek
B dialog; the options available will depend on the controlled
impedance structure.

Set Up GoalSeek
Goal Seeking Parameter(s)
" W2 only
~
~
~
" H1 Only

" H2 Only
~

~

0K Cancel

Click OK; the Speedstack attempts to arrive at the target
impedance by iteratively modifying the specified parameters.
It may be necessary to add or delete prepregs to achieve the
target impedance.

Goal seeking with the Si8000m/9000e

Speedstack Stackup Builder is fully integrated with the
Si8000m/Si9000e Controlled Impedance Field Solvers.
Users can transfer Stackup layer dimensions to the Field
Solver, solve for stackup parameters to produce the target
impedance (or calculate that the target impedance is
unachievable with the current values) then transfer the
solved dimensions back to Speedstack.

Ensure the Field Solver is running and that its units match
the Speedstack units.

With the stackup parameters displayed in the Controlled
ﬁ Impedance window, click To Field Solver to transfer the
To Field Solver current Speedstack parameters to the Si8000m/Si9000e.

Switch to the field solver and click the Paste from

= Speedstack button to load the parameters into the
— Paste from associated field solver fields. The field solver reflects the
Speedstack structure and parameters of that selected in Speedstack.
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Offset Stripline 1B1A

Tolerance  Minimum — Maximum

Substrate 1 Height H1 F.0000—+[ 00000 [ 60000 [ 60000 Calculate
Substrate 1 Dielectic Ern 4.2000 j :| 0.0000 | 42000 | 42000 Calculate
Substrate 2 Height H2 9.0000 j | 00000 | 90000 90000 Caloulate

|
|
|
Substrate 2 Dielectric Bz | 4.2uunjt| 00000 | 42000 42000 Caloulate
|
|
|

Lower Trace Width w1 59978 = *[ w.oooo [ 5ag7e [ 5ase

Upper Trace Width W2 5.0 3sj‘t| 00000 | 50136 | G0136  Caleulate
Trace Thickness ™ 07000 = *[ 00000 [ 07000 [ 07000 Caloulate
Impedarice Zo 50.00 50.00 50.00 Calculate

Moare. ..

For the data shown above seek a final value for impedance of
50 Ohms; H1, Er1 and T1 are fixed, so goal seek on W1,W2.

Click the Upper Trace Width (W2) Calculate button to goal
seek on trace width. The field solver returns new values for
trace width to produce 50 Ohms final impedance.

Lower Trace Width
Upper Trace Width

w1 | 5.990?j1| 00000 | 59907 | 59907
W | 4.aan?j't| 00000 | 49907 | 49907

Copy to Speedstack

“ 1IN

From Field Solver

Click the Copy to Speedstack button, switch to Speedstack
and click the From Field Solver button to display the solved
parameters for the target impedance.

Note: it may be necessary to round some dimensions (for
example, the dielectric heights) to the nearest practical
values and recalculate the impedance.

Changing layer functionality

It is often convenient to base a new design on an existing
stackup and then add or remove electrical layers to create
the new stack, leaving the previous existing structures intact
or to switch between layer types (Signal, Plane, Mixed,
Hatched) without removing structures.

Speedstack allows the designer to retain and re-allocate
structures when changes are made to the electrical layers of
the stackup. This enables reallocation of structures after the
following stackup changes:

Adding foils and/or cores — increasing the layer count
Deleting foils and/or cores — reducing the layer count

Moving foils and cores up and down, even beyond
another copper layer — maintaining the layer count but,
for example, exchanging two different thickness cores
within the stackup

Copying and pasting foil or core — increasing the layer
count

Changing layer type — signal to plane, plane to signal,
mixed to signal or plane, signal to hatch, hatch to signal
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PP

Caore

PP
PP
PP

Core

PP
PP
PP

Core

PP

Deleting a rigid core and adding a flex core — to maintain
layer count but swapping material type

Deleting a rigid core and adding two foils — to maintain
layer count but switching to an HDI type build

For the following examples, consider the stack below.

Liquid Photolmageable Mask 4000

Copper Foil 0.700
PrePreg 1080 4 200 1850
FR4 Core

PrePreg 3080

PrePreg 1651

PrePreg 1651

FR4 Core 4200

PrePreg 1651 4200

PrePreg 1651 4200

PrePreg 3080 4200

FR4 Core 4200

PrePreg 1020 4200
Copper Foil 0.700

Liguid Photolmageable Mask 4.000

Switching layer types and reallocating structures

== =a= ===  Switch signal layer 2 to a plane layer and plane layer 3 to
a signal layer. Speedstack issues a warning indicating that
continuing with the change will require the existing
structures to be re-allocated.

Set Layer Te Plane

Speedstack

@=% This action will invalidate some or all existing structures. You will be

| .

WY ableto check and re-allocate thern afterwards using the Structure
Walidation and Structure Layer Properties options. Do you wish to
proceed?

Yes Mo

Select Yes to confirm the change to the stackup. The stack
editor reflects the change in the stackup, layer 2 is a plane
layer and layer 3 a signal layer.
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Liquid Photolmageable Mask 4.000

Co pper Foil 0.700

PrePreg 1020

PrePreg 3080

PrePreg 1651

Speedstack also displays a flashing Rebuild indicator; due to
the changes to the stackup it is necessary to refresh the
structures.

Stack Up Editor | DRC : 5 Controlled Impedance | CI Resuits |
R S RN F T R
Al |I=:| <|_ >|:>I|

- Click the Rebuild
> and Recalculate
Rebuild icon — Speedstack
and displays an
Recalculate information dialog

indicating which
structures need re-
allocating.

I.-”' & The following structures require attention. Please re-allocate each

"W structure using the Structure Layer Properties option.

Layer: 1, Edge Coupled Coated Microstrip 18, 100 ochms
Layer: 1, Coated Microstrip 1B, 73 chms

Layer: 4, Edge Coupled Offset Stripline 1814, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 50 chms

Click OK then click the Structure Layer Properties icon to
reallocate the structures to the correct signal and plane
layers.

Stack Up Edtor | DRC :4 Controlled Impedance | €1 Resuts |

303 i 6 (V2 = s &
i'i'_{l 10f4 _}|j Sirur:ture Layer Properties

The Structure Layer Properties dialog includes two layer
columns, the Current layer column and the New layer
column. The Current column shows the Signal / Plane
stackup layers assigned to the structure before the stackup
was changed.
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The New column allows the structure to be re-allocated to
reflect the new stackup layer types.

Structure Layer Properties

pper Signal Layer |1 |-|

Lower Signal Layer I I

|Ipper Plane Layer |3 |2

Lol Lef L e

Lower Flane Layer I I

Structure Inverted IFalse
Mumber of Structures on same Ig [+ Maove All

Signal ! Plane Layers

Apply | Cancel |

In this case notice the Upper Plane Layer is changed from
layer 3 to layer 2.

In many cases multiple structures will have the same Signal /
Plane layer assignments. In the example above Speedstack
indicates that there are two structures affected. Click the
Move All check box to re-allocate all matching structures in a
single operation then click Apply.

o~ Rebuilding the stack indicates that other structures (i.e., the
| Rebuild and two structures on layer 4) also require layer reallocation.
Recalculate

PP PrePreg 1651

Core FR4 Core

PP PrePreg 1651
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&J Structure Layer
Properties

I.-”' _"\-.I The following structures require attention. Please re-allocate each
W' structure using the Structure Layer Properties option.

Layer: 4, Edge Coupled Offset Stripline 1814, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 50 chms

Use the structure selection arrow keys to step through to
the structures on layer 4 then click Structure Layer
Properties.

Structure Layer Properties

Edge Coupled Offset Stripline 1B1A

T

Upper Signal Layer [a E -]
Lower Signal Layer | | B
Upper Plane Layer 3 2 -]
Lower Plane Layer G |6 |
Structure Inverted [False
Number of Structures on same 2 ¥ MoveAl

Signal / Plane Layers

Reallocate the layers as required then click Apply. With the
structures re-allocated Rebuild and Calculate the structures
as describer earlier.

Note that structure Trace Width and Separation parameters
are retained at their original values together with the Target
Impedance and Tolerance. (Depending upon how the
structures have been re-allocated it may be necessary to
goal seek the trace width and separation parameters to meet
the target impedance.)
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Increasing the layer count

It is a common requirement for designers to base a new
design on an existing proven stackup and then add or
remove electrical layers to create a new stack, leaving the
previous existing structures intact.

Consider the 8 layer stack below.

Liquid Photolmageable Mask 4.000
Copper Foil 0700
PP PrePreqg 1080 4200 1950

Core FR4 Core 4200

PP PrePreqg 3080 4200
PP PrePreg 1651 4200
PP PrePreg 1651 4200

Core FR4 Core 4200

PP PrePreg 1651 4200

PP PrePreg 1651 4200

PP PrePreg 3080 4200

Core FR4 Core 4200

PP PrePreg 1080 4200 1.950

Copper Foil 0.700

Liquid Photolmageable Mask 4.000

For this example, add a core between layers 5 and 6.

Speedstack will display a warning that proceeding with the
change will require the existing structures to be reallocated.

'e This action will invalidate some or all existing structures. You will be

WY able to check and re-allocate thern afterwards using the Structure
Validation and Structure Layer Properties options, Do you wish to
proceed?

es Mo

Click Yes to proceed.

In order to maintain a symmetrical stack, delete the Prepreg
3080 materials and add Prepreg 1651 materials to create a
symmetrical 10 layer stack.
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Liquid Photolmageable Mask 4.000

Copper Foil

= PrePreg 1020

Core FR4 Core

PP PrePreg 1651
PP PrePreg 1651

Core FR4 Core

PP PrePreg 1651

PP PrePreg 1651

Core FR4 Core

PP PrePreg 1651
PP PrePreg 1651

Care FR4 Core

PP PrePreg 1080

Copper Foil

0.700

1.950

6.000

6.000

1950

0.700

Liquid Photolmageable Mask 4.000

Rebuild and Recalculate

Click Rebuild and Recalculate

Speedstack displays an information dialog indicating the
structures that need reallocating.

Speedstack >

Layer: 4, Edge Coupled Offset Stripline 1B14A, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 50 ohms

oK

Click OK.

Use the structure navigation buttons to select the structure
layer then click the Structure Layer Properties button to
display the Structure Layer Properties dialog.
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S

Net classes

Structure Layer Properties

Edge Coupled Offset Stripline 1B1A

21 w2
LN

Upper Signal Layer |4 |4 j
Lower Signal Layer | | J
Upper Plane Layer |3 |3 j
Lower Plane Layer 6 | g j
Structure [nverted Falze
Mumber of Structures on same 2 v A
Signal / Plane Layers R
Apply | Cancel

Note that for the modified stack the lower plane layer has
been reallocated to layer 8.

Click Apply and then Rebuild and Recalculate.

If necessary, goal seek on line widths to bring the impedance
within specification.

For the above stack edit the Drill Properties to finalise the
stack changes.

Repeat the procedure for each structure as necessary.

Structure net classes

Speedstack allows up to five Net Class names to be stored
with each structure. These net class names provide a link to
the matching impedance nets inside the ECAD PCB layout
system. Net classes are supported in Speedstack’s import /
export file formats.

Net class columns can be selected for display on the
technical report.

To display the Structure Net Classes dialog click the Net
Classes button
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Enter the net class names in the text boxes and click Apply.

Structure Met Classes nl
Met Class 1 TXD
Met Class 2 TX1
Met Class 3 R0
Met Class 4 Rx1
Met Class 5
Apply | Cancel |

Up to five net class names may be stored with each structure.

1= Click the Select Impedance Columns button and Select the
; Select Imped Net Class columns to display the net classes on the
elect Impedance .
Columns Speedstack technical report.
&= Select Controlled Impedance Table Columns — O *

Selected Columns Awailable Columns

impedance Signal Layer n <
Ref. Flane 1in Layer —l Broadside Znd Layer

Ref. Plane 2in Layer . Trace Pitch {51+ W1)

Lower Trace Width (W1) = | Lower Ground Strip Width (1)

Upper Trace Width (W2) Upper Ground Strip Width (G2)

Trace Separation (51) Up Trace Offzet {01)

Target Impedance 4' Ground Strip Separation (D1)

Tal {+/- %) Substrate 1 Height (H1)

Calculated Impedance — | Substrate 2 Height (H2)
Net[]ass'l Substrate 3 Height (H3)

MNetClass2 Delete Substrate 4 Height (H4)

NetClass3 —l Substrate 1 Dielectric (Erl1)

NetClass4 Substrate 2 Dielectric (ErZ)

NetClass5 v ﬂl Substrate 3 Dielectric (Er3) v

ok | cancel |

The chosen columns are displayed in the selected order.

Lower | Uppar
impedance | Fed. Fof. | Trace | Trace | Trace /
Impadance | Structure Sigral Plana 1 | Plane 2 | Widlh | Width | Separation Targel Tol (/x| Cabculatad

] Imags Layar I Layar | in Layer | (W1) W2y [Ghl] [ - ) L d NotClassl | NeaClasaZ | HeiClasad | NetClasad | MeiClasas

1 m 1 3 a 84 TaM a8.3m 100.000 10,000 SHS30 THO ™ RX0 RX1
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Working with Si Projects in Speedstack and Si8000m/Si9000e

Si Projects

The Si Projects feature incorporated in Speedstack and
Si8000m/Si9000e allows for easy transfer of controlled
impedance structures from the Speedstack stackup design
tool into the Si8000m and Si9000e field solvers.

Si Projects allows groups of structures to be saved and
recalled in Si8000m/Si9000e and entire stackups of
structures to be pasted from Speedstack into Si8000m and
Si9000e with just a few clicks of the mouse.

The To Si Project toolbar icon copies a group of structures
from Speedstack and places them onto the clipboard, these
structures can then be pasted directly into the Si8000m or
Si9000e Project group

do

To Si Project

Transferring structures from Speedstack to the field
solver

The stackup below in Speedstack's Stackup Editor contains

controlled impedance structures in the layers indicated by
the Ohms symbol.

Liquid Photolmageable Mask 4.000
Copper Foil 0700

PrePreg 1080 4200 Lo 1.950

FR4 Core 4.200

PrePreqg 3080 4200
PrePreqg 1651 4200

PrePreqg 1651 4200

FR4 Core 4200 12.000
1400

PrePreg 1651 4200 5552
PrePreg 1651 4200

PrePreg 3080 4.200

FR4 Core 4.200

PrePreg 1080 4200

Co pper Fail 0.700

Liguid Photolmageable Mask 4000

Click Speedstack's Controlled Impedance tab and use the
structure navigation controls to step through and display the
structures.
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b

To Si Project

Al | 1= ::'1014 :l}ll

Use the Si Project toolbar buttons in the Speedstack and
the Si8000m/Si9000e interface to transfer the structures via
the Windows clipboard to the field solver.

Switch to the field solver and paste the structures from the
clip board into the field solver Si project.

=\

|Paste??-:um Speedstack into 5i Project

The complete set of structures appears in the field solver’s
Project window.

The Si Project window lists the transferred structures in layer
order, showing the layer number and value along with a
thumb nail graphic indicating the structure configuration.
Right click on a structure in the structure list to view the
structure options.

Add Structure to Project
Delete Structure from Project

Rename Structure within Project

Move Up

Mowe Down
Duplicate Selected Structure

Clear Project

Demo Mode : Load Sample Structures into Project

Adding/deleting and modifying structures

Selecting each structure displays its associated graphic in a
grey background.
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L1 100 ohms [1]

L1 75 ahms [£]

L4 100 ohs [3]

L4 50 ahms 4]

L& 75 ahms [5)

Click the + and — buttons in the structure graphic to add
additional structures from the Si structure library or remove
selected structures from the Project folder. Click the Rename
Structure (the pencil icon) to assign the structure a
descriptive name.

-2

L1 100 ohms (1)

With a structure selected the structure parameters can be
modified as required and the impedance recalculated.
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Frequency dependent loss calculations (Speedstack Si only)

=H

(2]

Frequency Dependent

Properties

Note: Frequency dependent loss calculations are available in
Speedstack only when used in conjunction with the Si9000e
Insertion Loss Field Solver.

Speedstack Si (Speedstack Stackup Builder plus Si9000e
Insertion Loss Field Solver) provides for calculations of
frequency dependent loss given the information applicable to
loss in the transmission line structure. The information
includes material properties, comprising dielectric constant and
loss tangent, conductor properties such as trace conductivity
and surface roughness and the frequency range over which the
transmission line structure will operate

Graphing against frequency is provided for impedance
magnitude, conductor loss and dielectric loss (with or without
roughness compensation,) inductance, capacitance,
resistance, conductance and skin depth. Graphing for
differential structures include differential, odd and even
modes.

Each structure in the stack includes a set of frequency
dependent properties.

Click the Frequency Dependent Properties icon to load the
Frequency Dependent Properties dialog.

Frequency Dependent Properties

Edge Coupled Coated Microstrip 1B

Graph | 0dd Mode | Even Mode

- o x
Result Presentation
Lzl i 101600.0000) (& Length of Line  fin Cim S
Trace Conductivity (Sim) ~ TC [5g00E-07
. M e Em 5 300E+0; Substrate Causal Extrapolation Reference Points Pt
requency Minimum (MHz)  FMin  [500.0000 ¥ Set Dielectric Canstant (Er) from Stack Up materizls _Clear R |
Frequency Maximum (GHz)  FMax 100000 Set. ¥ Set Loss Tangent (TanD) from Stack Up materials
Freq (Hz) Ref Er Ref TanD
Frequency Steps FStep [20 L1
H1  [1.000E-09 [4.2000 0.0195
Frequency of Interest (MHz)  Frea  [1000.0000 H2
2 | -F q
Calculate H3
e ,—feﬁe trate
R [ dieléctric region
Frequency dependent parameters | .. Fiooees [ T
Surface Roughness Compensation
£ Smooth
& Hammerstad
 Groisse 7 _ e |
£ Huray ————— _ Edt.
Print Settings

¥ Include Loss Graph for this structure on the report

Surface roughness compensation models

N oL LS
o m o o

o
TR

All Losses with Roughness - dB/line
b o T
2

bk
& 2

&
o

Graph Setiings

Edge Coupled Coated Microstrip 1B

Display Series

Differential All Losses A
| E— Conductor Loss B Dielectric Loss EEEEEE Aftenuation [—— Conductor Loss with Roughness [E=——"43 Attenuation with Roughness Differential
Differential -
o
e _ '-t:- Loss Budget (dB)
k—..i - \\ 0.0000 Refresh
. ——
e - - Picked Data Point Information
= T — T | - Fi MHz) : 9500.000
i — —— Ebrmea bt
—
— — e Print B
Loss v frequency graph r—
with conductor and dielectric losses .
Interactive

graph settings

1000 2000 3000

4000 5000

Frequency - MHz

6000 7000 8000 9000 10000
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The Frequency Dependent Properties dialog includes:
the structure image of the selected structure

frequency dependent parameters for the user defined
frequency range and frequency of interest

a table of substrate causal extrapolation reference points
for each substrate dielectric/region

surface roughness compensation model selection
between Hammerstad, Groisse, Gradient, Huray and
Simonovich-Cannonball methods

the loss v frequency graph showing the data series for
conductor and dielectric losses and total attenuation

interactive graph setting with data point selection allowing
drilling down to the underlying loss data

data tables for the selected frequency range

Graph Odd Mode | Even Mode |
Frequency Enepjdance :mgz;inaar:e H:;:;j;: Inductance Resistance Capacﬂance Conductance ‘Bl;i;h E::Educlur Dizliectnc Attenuation E:::E;rli?'lr wnﬁhﬂualmﬂ
Hz Ohms Ohms Ohms HAine Ohms/line FAline SAine n dB/ine dB/ine dB/ine ‘?Bu;ir;ness ‘?Bu;llilness ]
b SONE  SOGEI DTG SOOEDI  LMER IS0 T20ETI  GIOEK  LIMEN GG LM G0 00k S0 |
1000E+09  5.048E:01 -2527E02 | 5.048E:01 3.060E-08 3547E+00 1.201E-11 1.316E-03 8.228E-05 -3.051E-01 -2 885E-01 -5 936E-01 -5.868E-01 -8753E-01 €
1.500E+09 5.051E+01 6.176E-02 5.051E+01 3.050E-08 4.334E+00 1.155E-11 1.574E-03 6. 718E-05 -3.726E-01 -4 33EN -8.057E-01 -7 261E-01 -1155E+00 €
2.000E+09 5.054E+01 1.140E-01 5.054E-01 3.044E-08 4.998E+00 1.152E-11 263303 5.818E-05 4285601 -5.778E-01 -1.007E+00 | -8.425E-01 -1420E+00 €
2500E+09 5.056E+01 1.455E01 5.056E-01 3.035E-08 5.583E-00 1.185E-11 3.291E-03 5.204E-05 -4.755E-01 =127 -1202E-00 | -9.443E-01 -1.667E+00  |€
3.000E+09 5.059E+01 1.765E-01 5.059E+01 3.036E-08 6.112E+00 1.186E-11 3.950E-03 4.750E-05 -5.247E-01 -8.677E01 -1.392E+00  |-1.036E+00  |-1.904E-00 €
3.500E+09 5.061E=01 157401 5.061E+01 3.034E-08 6.538E+00 1.184E-11 4.608E-03 4.398E-05 -5.662E-01 S1013E+00  |-1579E+00  |-1.120E+00  |-2133E=00 €
4.000E=09 5.063E+01 21430 5.063E+01 3.032E-08 7.051E+00 1.183E-11 5.267E-03 4114E05 -6.048E-01 -1.158E+00  |-1.763E+00 |-1.198E=00 |-2.356E+00 €
4 .500E+09 5.065E+01 2.255E01 5.065E+01 3031E-08 7.572E+00 1.181E-11 5.525E-03 3.879E-05 -5.492E-01 -1.303E+00 |-1953E+00 |-1287E+00 |-2591E+00 Ei
5.000E+09 5.067E+01 2374EM 5.067E+01 3025608 7.585E+00 1.180E-11 6.584E-03 3 679E-05 -5.843E-01 -1.445E+00 |-2133E+00 |-1358E+00 |-2807E+00 (€
5.500E+09 5.069E+01 2478E-M 5.065E+01 3.028E-08 8.378E+00 1.178E-11 7.242E-03 3 508E-05 EAR: =4 -1584E+00 |-2312E+00 |-1425E+00 |-3.020E+00 |€
6.000E+09 5.070E+01 2.568E-01 5.070E-01 3.027e-08 8.753E-00 1177E-11 7501E-03 3.359E-05 -7 457E-01 -1740E+00  |-2450E+00  |-1450E+00 |-3.230E+00 €
6.500E+09 5.072E+01 2648E-01 5.072E-01 3.026E-08 5.114E+00 1.176E-11 8.559E-03 3.227E05 -7.804E-00 -1.885E+00 |-2666E+00 |-1.551E+00 |-3437E=00 €

Frequency dependent parameters

Speedstack Si runs a detailed analysis of the transmission line
structure for controlled impedance and insertion loss. Each
structure in Speedstack can store a complete set of
frequency dependent parameters: Length of Lines,
Frequency Minimum, Frequency Maximum, Frequency
Steps, substrate data, surface roughness and loss budget.
Supply the values in the dialog below.

Freguency Maximum (GHz)
Freguency Steps
Freguency of Interest (MHz)

Length of Line [EIE 4000.0000
Trace Conductivity (S/m) TC 5.800E+07
Freguency Minimum (MHz)  FMin

500.0000

FMax  [10.0000

FStep (20

Freg

H000.0000
Calculate
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Specify the line length and trace conductivity along with the
frequency range and frequency of interest.

To specify the frequency range click the Set... button and
enter the minimum frequency (in MHz) and maximum
frequency (in GHz); specify the frequency increment (in MHz)
then click Apply.

Frequency Entry n
Frequency Minimum (MHz)  FMin IW Apply |
Freguency Maximum (GHz) FMax |1|}_[:-[;-[:-[:- Cancel
Frequency Increment (MHz)  Flnc IW

With all parameters entered, click Calculate. Results are
displayed in graphical and tabular form.

To provide for applications where the insertion loss
requirements or loss budget specifications are needed for a
given frequency the results for the specified frequency of
interest are highlighted in green in the table of data.

Presentation of results

Use the Result Presentation dialog to choose units in which
to present plots and tables of results.

Result Presentation

{* i ength of Line " Jin " I'm

The graphs are able to display results in dB/line length,
dB/inch or dB/metre.

Click the unit of choice and click Calculate to refresh the
graphical display of data.

Graph settings

Use the Graph Settings dialog to choose the display series.

Speedstack Si graphs All Losses — conductor loss, dielectric
loss and total attenuation.

Display Series

[l Losses B
Impedance Magnitude

Inductance

Resistance

Capacitance

Conductance

Skin Depth

Alpha b

If roughness compensation is applied the data series
conductor loss with roughness and attenuation with
roughness are added to the graph.
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Edge Coupled Coated Microstrip 1B
Odd Mode

N Conductor Loss BB Dielectric Loss MBS Attenuation [——3 Conductor Loss with Roughness

1 Attenuation with Roughness
@ 0
% L S k
oM * T .
t!1 . P

- - e

% B \ -i--.._._,_“-----....._._._h‘_._._.-.l -
=) ey
g M
5-3 - ----:""--..
= | . -\-..
w
e . H
w4
o
i
<
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1000 2000 3000 4000 5000 6000 7000 8000 9000 10000
Frequency - MHz

All losses with roughness

Speedstack charts are interactive. Click on a point on the
data series of interest to display the data point value in the
Picked Data Point Information text box

Edge Coupled Coated Microstrip 1B
Differential
055 BN Attenuation 2 Conductor Loss with Roughness
-__T—-l-—...‘____ .
T . . X Ficked Data Point Information
Hmﬂix : : Frequency (MHz) : 5500.000
i -....______-__ Dielectric Loss (dB) : -2.760
\
-‘_\
[N I [ A I Y S N S I A A [ N A A A S S A A A A A W |
4000 5000 6000 7000 8000 9000 10000
Frequency - MHz
The range of data series includes losses, impedance
magnitude, inductance, capacitance and skin depth: Choose
the data series from the Display Series drop down.
Edge Coupled Coated Microstrip 1B
Differential
61.8
61.6 \

™~

Inductance - nH/line
(=3}
(=}

60.8 M
~——]
60.6
60.4
| NS [N N A [ I[N S A (N O [ [ [N U [ S [ N [N U S O IS A O N A |
1000 2000 3000 4000 5000 6000 7000 8000 9000 10000

Frequency - MHz

Graph of inductance v frequency
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Displaying the loss budget

A value for loss budget can be added to a graph. A loss
budget line will allow losses that exceed the budget to be
easily identified.

All Losses with Roughness - dB/m

Graph Settings

Edge Coupled Coated Microstrip 1B Display Series

Differential |4l Losses |

s Conductor Loss DS Dielectric Loss BB Attenuation T——1 Conductor Loss with Roughness

== Attenuation with Roughness E==33 Loss Budget

Differential
|Diﬂerentia| j

Loss Budget (dB)

20,0000

.............. Picked Data Point Infermation

h--_‘__..--'

............... ‘ e ettt P . S Maximise| Print Export

o

2000 3000

4000 5000 6000 7000 8000 9000 10000
Frequency - MHz

The plot above indicates that the loss budget is exceeded by
the total attenuation (cyan) beyond 8000Mhz (8GHz.)

Setting the Loss Budget stores the value with the structure
for future use. This would prove useful if the stackups
changed and it is necessary to ensure that the structure still
meets the loss requirements after the changes.

Material and surface roughness properties

The Speedstack graph above charts all losses, the dielectric
loss and the significant increase in the overall loss due to
surface roughness, allowing the materials supplier to isolate
the contributions of the different loss mechanisms.

Dielectric loss

In order accurately to calculate dielectric loss it is necessary
to understand the material / substrate properties.

Speedstack Si allows substrate properties including dielectric
constant (Er) and loss tangent (TanD) to be specified for
each structure substrate region.

Substrate Causal Extrapolation Reference Points

[ Set Dielectric Constant (Er) from Stack Up materials
|+ Set Loss Tangent (TanD) from Stack Up materials

Freq (Hz) Ref Er Ref TanD
H1  [1.000Es09  |4.2000 0.0195
2 | |
B | |
i | |
| |

=]
=
(=]
£n

CEr  |1.000E+09
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Speedstack Si causally extrapolates Er and TanD over the
specified frequency range using a single value of Er and
TanD to enable Svensson-Djordjevic frequency dependent
permittivity modelling for each dielectric layer in the current
controlled impedance structure. The table above therefore
provides the ability to specify the extrapolation reference
points for each substrate region; the reference point data is
usually available from the material supplier data sheets. The
values of Er and TanD can, optionally, be derived from the
materials in the stack. (See the Polar Application Note
AP8184 or the Si9000e User Guide for a more detailed
discussion of causally extrapolating substrate data.)

The fields shown active in the table in the dialog reflect the
structure selected; inapplicable fields are shown greyed out.

The fields shown above allow values to be specified for the
frequency of interest, the dielectric constant, Er, and loss
tangent, TanD, for the prepreg dielectric and the coating.
Enter the parameters and click Calculate to refresh results.

Conductor losses — surface roughness compensation

In order to provide good adhesion between copper and
dielectric materials in core layers PCB materials vendors
control the roughness of the associated copper layers
(typically by chemical treatment). Speedstack Si provides
industry standard methods of compensation for surface
roughness in frequency dependent calculations; the
compensation methods include:

Smooth copper, (no compensation for Cu loss at all)
Hammerstad modelling

Groisse modelling

Gradient modelling

Huray modelling — with Simonovich-Cannonball Model

Speedstack charts dielectric losses along with conductor
losses and attenuation values that optionally include
compensation for surface roughness. Roughness is a
random quantity and is commonly specified in terms of the
rms (root mean square) height h of the surface unevenness
for the Hammerstad and Groisse compensation methods.
Huray modelling is based on a non-uniform distribution of
stacked copper nodules shapes resembling “snowballs”.

Surface roughness compensation methods
Accurate calculation of conductor loss requires the surface
roughness parameters for each method:

The Smooth copper option provides for no compensation for
copper loss.
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Hammerstad modelling is a proven technique that has stood
the test of time but has practical limitations when used over
4GHz as the model tends to saturate.

Groisse modelling can, with care, be used to extend the
modelling up to 7 to 10 GHz before saturation in the model
blunts its accuracy.

Hammerstad/Groisse/Gradient methods

To specify the roughness parameters for the Hammerstad,
Groisse methods, click the option button for the method:

—Surface Roughness Compensation
" Smooth
* Hammerstad
" Groisse 37 Edit.. |
" Gradient (Beta)
" Huray - Edit...

Click the Hammerstad/Groisse/Gradient Edit button.

Surface Roughness Compensation - Hammerstad / Groisse n

Surface 1 Roughness (RMS) R1  [(HI) feply |

Surface 2 Roughness (RMS)  R2 Iﬂ_zﬂ[ﬂ]
Cancel |

Surface Roughness Compensation

Enter the values for roughness in the R1 and R2 fields and
click Apply. Click Calculate to refresh results.

Huray method — with Simonovich-Cannonball Model

Huray modelling extends the roughness modelling validity up
to 40 to 50GHz (and possibly beyond).

Click the Huray option button:

Surface Roughness Compensation

" Smooth

" Hammerstad )
" Groisse ]7 Edit..
* Huray —_— Edit...

Click the Huray Edit button and specify the parameters for
the Huray spheres (snowballs.)
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Surface Roughn ompensation - Huray
Ratio of Areas 1.0000 Apply |
Effective Ball Radius (um) ||] 7500
| firea of Ball Count (sq pm) 90.0000
| Number of Balls in frea [:2

Enable Simonovich-Cannonball [

Rz Matte (pm) |4_443D 7

|’Maﬁe—5ide Roughness

Rz Drum (pm) |3_[‘.~43D -

|'Drum—5ide Roughness

Courtesy of Bert Simonovich, Lamsim Enterprises Inc Application Note

Supply the values in the associated fields and click Apply.

If the Huray values are not available, click Enable
Simonovich-Cannonball and supply the Rz values for matte
and drum side roughness and click Calculate to populate the
Huray fields, then click Apply.

Click the Application Note link to access the paper Practical
Modelling of High-speed Channels Based on Data Sheet
Input (Bert Simonovich, LamSim Enterprises Inc.) which
includes a description of roughness modelling using the
Simonovich-Cannonball Model.

Edge Coupled Coated Microstrip 1B
Differential

s Conductor Loss B Dielectric Loss EEEEEE Attenuation C—— Conductor Loss with Roughness
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g’ b
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@ r T MH""‘M
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2 5 ---_-__-“-'""‘-—_..____ x —
o -30 S e
= - ‘—.-""""—-..
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Speedstack charts a range of data series, including losses,
impedance magnitude, inductance, resistance, capacitance
and conductance; for differential structures select the
transmission line mode, differential, odd or even mode.

Dhfferential

<]

Differertial
Qdd Maode
Ewven Mode

Click on the Display Series drop down to select the data to
be charted.

Display Series

n Do =]

Impedance Magnitude ~
Inductance

Resistance

Capacitance

Conductance

Skin Depth

Alpha

Beta b

The chart below displays skin depth v frequency
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Printing the technical report

The Speedstack Si technical report includes the stackup with
its stack data, the controlled impedance structures and
structure data, the drill data and loss data for each structure
in the stack.

Displayed loss data for each structure reflects the structure
type, the frequency dependent parameters, the substrate
causal extrapolation reference points, the surface roughness
method and settings, frequency of interest and associated
loss values for dielectric and conductor losses and total
attenuation and losses with roughness.

Frequency dependent loss calculations (Speedstack Si only) ¢ 139




Speedstack User Guide

Edge Coupled Coated Microstip 1B

NI

Length of Line: 25 4

Frequency M
Frequency Steps: 20

Causal Points
Freq(Hz) | RefEr | RefTanD
Trace Conductivity: 5.8E+07 S/m H1 1.000E+09 | 4.2000 0.0195
Frequency Minimum: 500 MHz j
10GHz =
REr 1
CEr T.000E+08 | 4.2000 0,015

Surface Roughness Compensation: Huray
Ratio of Areas: 1

Effective Ball Radius: 0.75 um

Number of Balls in Area: 32sq um

Area of Ball Count: 80

Frequency of Interest: 1000 MHz
Canductor Loss: -3.003E+00 dB/m

Dielsctric Loss: -2.840E+00 dBfm

Attenuation: -5.843E+00 dBim

Conductor Loss with Roughness: -4.479E+00 dB/m
Attenuation with Roughness: -7 319E+00 dB/m

Click File|Print|Print Technical Report, Speedstack refreshes
the loss data results and displays them in high quality
graphical form.

Step through the pages to view the stack, impedance and
drill data and the frequency dependent loss graphs for each
structure in sequence in the stack.

CASpeedstack\Eval Imperial v13.stk Units: Microns

o Dl

Edge Coupled Coated Microstiip 15
AN AN

Length of Line: 101600

Frequency Minimum. 500 MHz
Frequency Maximum: 10 GHz
Frequency Steps: 20

Trace Conductivity: 5.8E+07 S/m

Substrate Causal Exirapolation Reference Points

Surface

Freq (Hz) Ref Er Ref TanD
H1 1.000E+05 |4 2000 0.0185
Az
H3
Ha
RET
CEr TO00E=08 [4.2000 00755

Roughness
Surface 1 Roughness (RMS) R1:5.08
Surface 2 Roughness [RMS) R2: 5.08

: Hammerstad

Atenuation: -5,843E+00 dB/m
=5 with Roughness: -5.776E+00 dB/m
ith Roughness: -8 615E+00 dE/m

Conductor
Anenuati

Frequency of Interest: 1000 MHz
Conduator Loss: -3.003E+00 dBim
Dielectric Loss: -2 B40E+00 dBim

s Conductor Loss =mmssm Dielectric Loss s Afienuation &==== Conductor Loss with Roughness === Aftenuation with Roughness

All Losses with Roughness - dB/line

5000

6000

Frequency - MHz

I T -

7000

ison.

Modificabon

Cate of Revision: Editor

To Field Solver

Speedstack Si to Si9000e data transfer

Speedstack and Si9000e incorporate the facility to realise
bidirectional transfer of all structure parameters (i.e. both
lossless and frequency dependent) for a single structure or
all structures via the clipboard.

Parameter transfer is accomplished via the data transfer

icons:

Single structures

Use Speedstack’s To Field Solver icon to transfer the
parameters of a single structure via the clipboard from
Speedstack to the Si9000e
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From Field Solver

IIT]

Paste Structure from
Speedstack

0

Copy Structure to
Speedstack

b

To Si Project

I

4 Paste from
Speedstack into Si Project

Use Speedstack’s From Field Solver icon to transfer the
parameters of a single structure via the clipboard from
Si9000e to Speedstack

Use the Si9000e’s Paste Structure from Speedstack to
paste the whole structure with all its parameters into the
Si9000e — the currently displayed structure will be replaced

With all calculations complete click the Copy Structure to
Speedstack to return the structure to the stackup in
Speedstack.

Multiple structures

Use Speedstack’s To Si Project icon to transfer all
structures as a project from Speedstack to the Si9000e

Use the Si9000e’s Paste from Speedstack into Si Project to
paste the set of structures into the Si9000e as a project.

Sharing structure properties

Each structure in Speedstack can store a complete set of
frequency dependent parameters, so each structure can
have its own Length of Line, range of frequencies (FMin,
FMax, FSteps and Frequency of interest) substrate data,
surface roughness compensation and loss budget.

Using the data transfer icons within Speedstack allows a
selected set of structure properties to be shared between
other structures on the same electrical layer on the stackup.

To share parameters between structures, select the source
structure (structure 1, Edge Coupled Coated Microstrip 1B.)

HE Polar Speedstack PCB Stack Up Builder:  Stack : Eval Imperial vi3.stk  Project : Eval Imperial v13.sci - O X

File Edit View Tools Units External Utility Help

EEATNESlXO==m=m =815 7777 2T e 201

1 Foil  CopperFail

- PP PrePreg 1080

2
- Core FR4Core
3

GHz

Frequency Dependent
Properties

Stack Up Edtor | DRC -0 Cortroled Impedance | CI Resuts |
XS EDL=w@ny
Al 12| < |1 of4 >|>I
Eage

aga

Substrate 1 Height H1|161.29

Select the Frequency Dependent Properties button to
display the frequency dependent properties.

Frequency dependent loss calculations (Speedstack Si only) ¢ 141




Speedstack User Guide

To Field Solver

From Field Solver

Frequency Dependent Properties - o X
. . ) Result
Edge Coupled Coated Microstrip 1B Length of Line: L 000000} IV(: Length of Lins @ i ® i | Close
Trace Conductivity (S/m] TC
. e thll 9 & 5800807 —Subsirate Causal Extrapolation Reference Points P
requency Minimum (MHz in 000 lear Resu
500 [# Set Ervalues from Stack Up materials

Frequency Maximum (GHz)  FMax [10.0000 Sat... Freq (Hz) Ref Er Ref TanD
Frequency Steps FStep [20 H1 1.000E+09 [4 2000 0.0195
Frequency of nterest (MHz)  Frea  [1000.0000 K2 [ |

Calculate B [ I
He

REr I | I

CEr [1.000E+03 [4.0000 0.0195

[~ Surface Roughi C

 Smooth

& Hammerstad 5

£ Croisee T e |
® ey - Et |

Print Settings
[¥ Include Loss Graph for this structure on the report |

All the structure’s properties, including all the frequency
dependent parameters, will be available for sharing with the
target structure.

Close the dialog and click the To Field Solver button to copy
the parameters to the clipboard.

Select the target structure (in this example, structure 2,
single ended Coated Microstrip 1B as shown below) and
click the From Field Solver button.

an | i<| <|20f4 >|:>||

Substrate 1 Height H1[i6129
Substrate 1 Dielectric E1[42000
Lower Trace Width W1 |114.30
Upper Trace Width w2 [s850
Trace Thickness T1 [17.78
Coating Above Substrate c1[zm4a0
Coating Above Trace c2 40
Coating Dielectric Cer[40000
Impedance Zo[7587
Target Impedance W
Target Tolerance % W

Speedstack displays the Paste Structure Properties dialog
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Paste Structure Properties n

Please select the Property Groups that you wish to paste to the selected structure:
| Impedance Parameters (H1, Er1, w1, W2, 51 etc) Cancel

[v Freguency Dependent Parameters (LL, TC, FMin, FMax etc)
[v Substrate Causal Extrapolations Reference Points (Ref Freq, Ref Er, Ref TanD)

[v Surface Roughness Compensation (Hammerstad, Groisse, Huray)

Select the properties to be pasted — in this case, the
impedance parameters are unchecked as the source
structure’s 100 ohm differential impedance does not apply.

The frequency dependent parameters, along with the causal
extrapolation reference points (frequency, Er and TanD) and
surface roughness compensation method are applied to the
target structure.

Transferring structures between Speedstack and Si9000e
Speedstack Si is fully integrated with the Si9000e
transmission line field solver.

Users can transfer structures to the field solver for
processing then transfer the solved properties back to
Speedstack Si.

Transferring a single structure

Ensure the field solver is running. Select the structure to be
copied to the Si9000e

Stack Up Edtor | DRC: 0 Controled Impedance | C1 Resus |

XS EOEL = wE e

Al [ I=] < |30f4 >|>I|
ige e

PrePreg 3080

PrePreg 1651

PrePreg 1651

FR4 Core

PrePreg 1651 152.400

PrePreg 1651 152 .40

PrePreg 3080

Click the To Field Solver button to transfer the structure
and all parameters to the Si9000e.

3 |1, Fild Solver

Switch to the Si9000e.

Click the Si9000e’s Paste Structure from Speedstack
ﬁé button to paste the structure complete with all impedance

Paste Structure from . .
Speedstack and frequency dependent parameters into the Si9000e.

The Si9000e displays the Paste Structure Properties dialog.
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[EE Paste Structure Properties >

Flease zelect the Property Groups that you wizh to paste to the selected stucture:

[v Impedance Parameters [H1, Er, w1, W2, 57 etc] Cancel

[v Freguency Dependent Parameters [LL, TC, FMin, Fiax etc)
[v Substrate Cauzal Estrapolations Reference Points [Ref Freq, Ref Er, Bef TanD)

[v Surface Roughness Compenzation [Hammerstad, Groizse, Huray]

Choose which groups of properties are to be pasted into the
field solver and click Apply. The impedance, lossless and
frequency dependent properties are pasted into the field
solver for processing. The units setting in Speedstack will
replace the setting in Si9000e.

Solving for impedance

With the structure loaded into the Si9000e switch to the
Lossless Calculation tab to display the structure graphic and
lossless parameters.

Tolerance  Minimum b aximum

.. Substrate 1 Height H1 [az300 -+ 00000 (632100 [6325100  Caleulate
Edge-Coupled Offset Stripline 1B1A Substrate 1 Dielectric Er [ 42000 j +[ 00000 [ 42000 [ 42000 Caleulate
Substrate 2 Height Hz | 3881100 j £ [.0000 | 3881100 3831100 Calculate
Substrate 2 Dielectnic Er2 | 4.2000 j + | 0,0000 | 4.2000 | 42000  Calculate
Lower Trace Width W1 [191.9893 =+ [ 0.0000 [191.9893 [191.9683
Upper Trace Width w2 [1gegesz =+ o000 [1665e53
Trace Separation 51 [2159000 = = [ 0.0000 [215.3000 [2155000 Caleulate
Trace Thickness T [ 355600 = *[ 0.0000 [ 355600 [ 355600 Caleulate

Differential Impedance  Zdiff 100.00

Specify the target impedance then click the Calculate button
for the parameter to be used in the goal seek (e.g. trace
width); with the target impedance reached switch to the
Frequency Dependent Calculation tab.

Running frequency dependent calculations

Enter the frequency dependent parameters, the extended
substrate data settings, the surface roughness compensation
method and values and click Calculate to refresh the results.
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Parameter Enty Urits

o ] § | == oo s e/ (] coseon e ] EIES) 45 G5\ IO A B o BN 0P B 2B G2,

Frequency Distribution Measurement Data

LA Length of Line LL 2540000  Logarthmic @ Linear NoData Inported Optians.
Edge-Coupled Offset Stripline 1B1A Trace Conductivity (5/m) TC 5E0E+07 —  Set Result Presentation
Loss Tangent Tal [ O01% — GoslSesk| | O Lenghoilie /i & /m

Rise Time [ps] Tt [ 10 Extended Substrate Data S-Parameter Configuration
Frequency Steps

i 00 - Ji
Frequency Maximum (GHz)  FMax 10,000 Set..  Muliple Er / TanD:
_set. | MBI EIEL ]| souce and Load Impedance (Ohms)

o
ey Sl (Rl 20 Surface Roughness Compensation Sowce  Load
[ Auto Cale Caloulats  Smooth Son] 5000
C Hammersiad Nurbering Mode
 Groisse T @ Modem O Classic
B e e | £ i

Graph | 0dd Mode | Evenbods | SPICE RLGC| 4 Pon §-Patameters - Graph | 4 PortS-Paramsters -Dsts | Mived Madls S-Parameters - Graph | Wit Mods S-Paramsters -Dsta | Crasstalk| Measursmert Dats |

~

i

Suiface Microstip [~ Include on All Losses plat
1B

Frequency Minimum MHz] - FMin [~ 500000 ? E::z::té“; l;”ai e [T

Il

Suiface Miciostip

Coated Microstip
1B

— Graph Settings
% Edge-Coupled Offset Stripline 1B1A Display Seres
Coated Micrastip Differential l Losses -
iz} mmmm Conductor Loss B Dielectric Loss —EEESSSE Attenuation C——— Conductor Loss with Roughness [E===5 Attenuation with Roughness Diff il
iferentia
E = [Differentisl =]
£ r — e — . Loss Budget (dB)
@ -1 S
Dual Coated S \\ . i [ o000 _Reshesh | |
Micrastip 16 o T - r—T A .
% I 20 - P —— g Picked Data Point Information
(=] [ \
2 I P
Dual Coated v T— ———
Micrastip 28 s T T — I
= 4 ...____\ Masimise Piint Export
&
S
Embedded ES S
Microstip 1614
| S [ | ] N | | | N T | ] N | ] T | N N | | -1 | N -
E 1000 2000 3000 4000 5000 6000 7000 8000 9000 10000
Frequency - MHz
Embedded

Mismastip 1624 Lossless Calculation J\ Frequency Dependent Calculation J\ Sensitivity Analysis l Via Checks
For detailed Si9000e operation see the Si9000e User Guide.
With all calculations complete click the Copy Structure to
= Conv Structure & Speedstack to return the structure to the stackup in
— opy Structure to
Speedstack Speedstack.

The Paste Structure Properties dialog is displayed.

Paste Structure Properties

[v |mpedance Parameters (H1, Erl, W1, W2, 51 etc) Cancel
v Freguency Dependent Parameters (LL, TC, FMin, FMax tc)
[ Substrate Causal Extrapolations Reference Points (Ref Freg, Ref Er, Ref TanD)

Please select the Property Groups that you wish to paste to the selected structure: Apply

[+ Surface Roughness Compensation (Hammerstad, Groisse, Huray)

Choose which properties are to be updated and click Apply.

Rebuild and calculate the structure in Speedstack. The
structure reflects the updated values.
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Ele Edit View Tools Units External Uility Help

Ex=d

w0

Sl XO===EZNE 777717

T =
BE 594
Stack Up Edior | DRC: 0 Centrolled Impedance | CI Resuts |
XS EOES =@
Al |I<|<I3of4 >3l

Substrate 1 Height H1 [692.9
Substrate 1 Dielectric Erl
Substrate 2 Height HZ
Substrate 2 Dielectric Er2|4.2000

[ R S Lower Trace Width i

VY & VI IPI Upper Trce Vit w2
Trace Separation 51

| Trace Thickness T1 [35.5
Differential Impedance Zd [100.00
Target Impedance 100.00
Target Tolerance % 10.00

[Master [Microns [Target Stack Up Thickness = 1524.00  [Stack Up Thickness = 1510.28 [Stack Up Thickness with Soldermask = 1561.08  [Beta V : 17.08.15343 y

Transferring multiple structures via Si Projects

To transfer all the structures in a stack use the Si Projects
transfer function incorporated in Speedstack Si and Si9000e.

Si Projects allows for transfer of all controlled impedance
structures along with all lossless and frequency dependent
parameters from Speedstack Si into the Si9000e field solver.

Si Projects allows groups of structures to be saved and
recalled in Si9000e and the updated structures pasted back
into Speedstack.

The stackup in the example below contains four structures.
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E Polar Speedstack PCE Stack Up Builder:  Stack : Eval Imperial v13.5tk  Project : Eval Imperial v13.sci - [m] x

File Edit View Tools Units Exernal Utility Help

EO =1

777

o

|7-q-

Stack Up Edllurl DRC:0 Cortroled Impedance |cw Resuts |
FX3XtS WDEHWEJHE%%LZ
L I |1 of 4

Liquid Photolmageable Mask

Substrate 1 Height H1 W
Substrate 1 Dielectric Er1|4.2000
Lower Trace Width Wil |215.90
Upper Trace \wiidth W2 |190.50
Trace Separation 51 |206.12
Trace Thickness T1|17.78
Coating Above Substrate C125.40

Liquid Photolmageable Mask Coating Above Trace c2 2540
Coating Between Traces C3 |25.40
Coating Dielectric CEr|4.0000
Differential Impedance zd[0035
Target Impedance 100.00
Target Tolerance % 10.00

[Microns [Target Stack Up Thickness = 1524.00  [Stack Up Thickness = 1510.28 |Stack Up Thickness with Soldemmask = 1561.08  |Beta V : 17.08.15943 /a

Use the To Si Project toolbar icon to copy the group of four
structures from Speedstack Si and place them onto the

To Si Project clipboard; these structures can then be pasted directly into
the Si9000e as a new project.

Switch to the Si9000e and use the Si9000e’s Paste from
Speedstack into Si Project to paste the set of four
structures into the Si9000e as a project.

b

B

4 Paste from
Speedstack into Si
Project

E Polar 513000 PCE Transmission Line Field Solver - [C:\Users\Ralph\Desktop)Si@000 v18.x Beta 170ct2017\Untitled.5i9] [C:\Users\Ralph\Desktop\Si9000 v18.x Beta 170ct2017\Untitled.5IP]
File Edit Configuration Help

8 |l s ) i 5 1 i B 3] o AP

E i Length of Line L ITU1 E00.00 ’V(‘ Lugarllhmlc  Linear |
L1100 ohms (1] L1 100 ohms I 1 ) Trace Conductivity (S /m) TC SBIE-07 —  Set.. I Result P "
ohms
1 Lass Tangent Tanl 0.0795 — GualSeekl ’7(:' Length of Line = tin = dm |
T l {, i !‘_-1 Rize Time [ps] Tr I 10  Extended Sub Data
i " Constant Er / TanD
Frequency Minirmum [MHz Fhdin
E T : : Y G EDD ouo i+ Causally Extrapolate Er / TanD Edit
1175 ohms [2) Frequency Maximum [GHz] Fhdax I 10,000 _I  Multiple Er / TanD Edit i |
Frequency Steps FSleDs “Surface R N T -
] I~ Auto Cale " Smooth
* Hammerstad .
E i Groisse }—IEdlt"'
L4100 ohms (3] i Huray Edi... i |

Graph | Odd Mode | EvenMods| SPICE RLGE | 4 Pont 5-Parameters - Graph | 4 Port S-Parameters - Data | Mised Mode 5-Parameters - Graph | Mived Mode §-Parameters - Data | Crosstalk | Messureme

E L1 100 ohms (1)

L& 75 ahms (4] Differential

The Si9000e and Speedstack should automatically switch to
the units that were in use when the structure was copied.
(For instance, if Speedstack is in Mils and Si9000e is in
Microns and a structure is copied from Speedstack to
Si9000e the Si9000e should automatically switch to Mils.)

The complete set of structures appears in the field solver’s
Project window in the same order as shown in Speedstack.
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The Si Project window lists the transferred structures in
Speedstack’s display order, showing the order number and
impedance value along with a thumb nail graphic indicating
the structure configuration.

Modifying structures

Selecting each structure displays its associated graphic in a
grey background.

With a structure selected the structure parameters can be
modified as required and all values recalculated. The
recalculated structures can be pasted back into Speedstack.

To paste a structure back into Speedstack select the target
structure in Speedstack, switch to the Si9000e, select the
structure for transfer and use the transfer icons to update the
selected structure in Speedstack.

Click the Rebuild and Recalculate Displayed Structure to

| Rebuild and Recalculate  refresh the displayed structure.
Displayed Structure

He
A

Click the Rebuild and Recalculate All Structures to update all

Rebuild and Recalculate  Structures in the stack
All Structures

e
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Creating CITS test files

& Set CITS Test

Speedstack can create CITS test file data for each controlled
impedance structure in the stack.

Select each structure and click Set CITS Test to display the
Edit Test data dialog; specify the CITS test parameters for
each structure to be tested and click OK.

Edit Test data
— Structure Details —Channel Select
Structure Description IOﬁset Coplanar Stips 1B1A
| {* Single Ended Probe 1D
Impedance 50.00 o -
— Chan 1
Signal Layer | 4
—Horizontal —Vertical
i Inches -
Units | =~ Ohms/Division 10 -
Test From |3
— Tolerance
Test To |?
¥ Locked
Test Method |Absolute |
y Plus IW %
p
i I‘l 0 %
& Default Minus -
" User

Exporting the CITS test file

With the test data specified for each structure, from the File
menu choose Export To|Export CITS File. Add descriptive
Board Details and notes as required.

Customer
Board Type
Part Mumber

Revision Mumber

IFuIar

| G308 back plane

[1234

|Rev 05

Click Make File and navigate to a suitable folder and save the

CITS (.cif) test file.
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Working with flex-rigid stackups

Speedstack Flex
Speedstack Flex allows PCB fabricators and OEM engineers
rapidly to create and document accurate and efficient flex-
rigid PCB layer stackups.

The graphical stackup display

The Speedstack Flex Navigator enables the board designer
to link and document as many cross sections as necessary
in order to fully document a flex-rigid build up.

Speedstack Flex supports documentation of common flex-
rigid constructions, including doublets where stacked pairs of
flex link two rigid sections of the flex-rigid construction
together (see graphic below.)

Flex-rigid stacks

Speedstack constructs a flex-rigid stack from an existing
stack to which will be added a series of sub-stacks. This
stack is referenced by Speedstack as the master stack. The
electrical layer numbers of sub-stacks are determined from
the master stack, so this stack should be created first.

The master stack is effectively a "bill of materials" stack and
contains all the materials used in all sub-stacks; i.e., the
master stack contains the full set of materials used in the
final stackup and documents each rigid and flex-rigid section
with as many "sub-stacks" as needed for the design. There
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are no limits to the number of sub-stacks or layer count of
the total build.

Creating sub-stacks
Sub-stacks may be created either by:
e duplicating the master stack and then

enabling/disabling materials in the resultant sub-stack
to achieve the desired stackup or

o defined by selecting a range of layers from the master
stack to form the new sub-stack.

Add Stack H] Duplicate Master

Defined by layers

A range of materials including flexible adhesives, bondply
and FlexiCore can be enabled or disabled for each layer, and
impedance structures can be added to each sub-stack.

Mesh / Crosshatch ground planes

When used with Polar's Si8000m and Si9000e field solvers,
Speedstack Flex permits modelling and documenting
mesh/crosshatch ground planes from within the Speedstack
Flex environment. Mesh geometry and structure data can be
easily shared between Si8000m and Si9000e.

Internal Coverlays

Advanced rules allow impedance structures to be added
when coverlays exist internally within a stack. When a
coverlay is beyond the outer copper it will behave like a
coating, when internal it will behave like a bondply or prepreg.

Definable colours per material

Speedstack Flex can set and store individual material
colours via the material Properties dialog. This will help
ensure that special build requirements are obvious during
fabrication. This will be found useful for documenting plated
layers or highlighting specific material usage such as no-flow
prepregs and flexible cores.

Enabling Speedstack Flex/HDI

To enable Speedstack Flex/HDI select Tools|Options and
ensure the Licensing pane purchasable option Speedstack
Flex/HDI License check box is ticked.

Adding a flexible core

Create and save a symmetrical 6-layer stackup as shown in
the sample stack below
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Core

PP

PP

Core

PP

PP

Core

PP

PP

Caore

PP

PP

Liguid Photolmageable Mask 1.000 1.000

[3|:||:| per Foil
PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg

FR4 Core

PrePreg 1080

PrePreg 1080

Copper Foil

0.700
3.000 3.000

3.000 3.000

0.700

8.000 2.000
0700
3.000 3.000
3.000
0700
8.000 3.000
0
3.000 3.000

3.000 3.000

0.700

Liquid Photolmageable Mask 1.000 1.000

FR4 Core

PrePreg 1080

PrePreg

FR4 Core

PrePreg 1080

PrePreg 1080

PrePreg 1020

Flex Core

PrePreg 1080

This stack is referenced by Speedstack as the master stack
discussed earlier; this section describes adding a series of
sub-stacks to create the complete flex-rigid stack.

Ensure Symmetrical mode is off, right click the prepreg
above Layer 4 copper and add a flexible core:

0.700
8.000
0.700

Add
Add C.I. Structure o
Full Stack Up Editor Mode RCC

3000 L Flexible Core
Set to Signal

= (0 Bondply

3.000

e Set to Plane -

The flexible core is added as the new layers 4 and 5.

3.000 43.000
0.700
3.000 3.000

0.700

3.000 EXVI
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Using the Navigator
Press F4 to display the Navigator

. Docking Lock

Colours | —

Free

Refresh

Right click the Navigator and choose Docking|Float to allow
the Navigator window to be resized. The Navigator will move
with Speedstack’s Stack Editor. Choose Free to allow the
Navigator to move independently of the Stack Editor.

Adding stacks
Adding stacks, for example, to form a flex-rigid structure or to
illustrate the press cycles of an HDI build, can be achieved by:

e duplicating the master stack and disabling materials
selectively

e defining the layers of the new stack

Defining new stacks defined by layers

New stacks may be added, defined by layers of the master
stack. Choose Add Stack|Defined by Layers:

Add Stack [ Duplicate Master

Remaowve Stack Defined by layers

It will be necessary to choose layers in the master stack to
be the top and bottom layers of the new sub-stack and to
position the new stack relative to the original stack.

Use the drop-down controls to select the top and bottom
layers and position the new stack.
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Top Layer |3 LI
Bottom Layer Select Laver -
4
Pasition Stack —|g
&
Far Left 7 Far Right
I
i 9 [
10
Substack Root Name |Master
feply | Cancel

The starting and finishing layers (derived from the master
stack) form the top and bottom layers of the sub-stack; the
new stack is positioned relative to the current stack, choose
a descriptive sub-stack root name and click Apply.

Adding a flex stack Defined by layers

Select the stack in the Navigator window and click Add Stack
and choose Defined by Layers

Select Stack |
| Add Stack ,

Duplicate Master
Defined by layers |

Remowve Stack |

From the drop-down list choose Layer 4 as the Top Layer
and Layer 5 as the Bottom Layer as shown below and enter
Flex as the Substack Root Name.

Top Layer |4 LI
Bottom Layer I 5 LI
Pos=ition Stack
Far Left Left Right Far Right
i i o i
Substack Root Name |Flex
Apply Cancel
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Flex Core

Coverlay

W
See 3D View

The new stack reflecting the top and bottom chosen layers is
added to the Navigator in the specified position (to the right
in the example below.)

Each sub-stack can be renamed individually as required.

Click the new stack — the selected stack is reflected in the
Stack Editor and listed in the status bar.

Adding materials to the sub-stack

Select Symmetrical mode, in the Stack Editor click the new
core and add a coverlay above.

0.700 -
3.000 3.000
0.700

The coverlays are added symmetrically about the core.
Changes made in the Stack Editor are reflected in the
Navigator. Click into the Navigator — use the mouse wheel to
resize.

The Navigator can display in 2D or 3D views. Click on the
See 3D View button to display a 3 dimensional view of the
stackup
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The new stack with its added materials appears in the
Navigator; clicking each stack in the Navigator displays it in
the Stack Editor and allows editing as described earlier to
add controlled impedance structures, change layer types,
add non-copper layers, etc.

Adding a new stack by duplicating the master stack

The master stack is effectively a "bill of materials" stack and
contains all the materials used in all sub-stacks.

Master stack

The master stack contains the full set of materials used in
the final stackup and documents each rigid and flex-rigid
section with as many "sub-stacks" as needed for the design.

There are no limits to the number of sub-stacks or layer
count of the total build.

To add a sub-stack:
Right click the Navigator
Choose Add Stack|Duplicate Master
Rename the new stack and click OK.

156 ¢ Speedstack PCB Stackup Design and Documentation



Speedstack User Guide

Symmetrical Mode

The new stack is added to the Navigator. Click on each stack
to display it in the Stack Editor and then edit as required.

Enabling/disabling materials in the sub-stack

Utilize the Stackup Editor to add drills and to selectively
enable or disable materials in sub-stacks. Note that materials
cannot be enabled or disabled in the master stack — the Flex-
Rigid command is greyed out if the master stack is selected

Symmetrical Mode: If Symmetrical Mode has been
selected, material will be disabled both at the top and
bottom of the sub-stack.

With the sub-stack selected in the Stackup Editor, right click
the sub-stack, select the materials to be disabled — choose
Flex-Rigid and then choose Disable Material.

Flexi-Rigid ¥ Enable Material
Disable Material

Toggle Material Selection

Disabled materials are shown in blue and will be removed
from the sub-stack display (for example to illustrate a press
cycle; the Navigator will display the press cycle with the
materials removed alongside the master stack.)

See also Working with HDI builds — Enabling/disabling
materials in the sub-stack

Copying and pasting stacks

To copy a stack in the Navigator select the stack, choose
Copy and Paste Stack, then from the dialog below choose
the position of the new stack

Working with flex-rigid stackups e 157



Speedstack User Guide

Position new stack...
Far Left Left Right Far Right
o i i i
fpply | Cancel

Removing stacks

To remove a stack right click the Navigator, choose Remove
Stack and select the stack to be removed.

= -
SubStackDl
SubStack(?

Using mini-stacks in rigid-flex constructions

The Speedstack Flex Navigator enables the board designer
to link and document as many cross sections as necessary
in order to fully document a flex-rigid build up. Speedstack
Flex supports documentation of common flex-rigid
constructions, including doublets where stacked pairs of flex
link two rigid sections of the flex-rigid construction together
(see the graphic below.)

The stack construction below is typical of a bookbinder flex,
in which a stacked pair of flex sections link the two rigid
sections of the flex-rigid construction.
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FRO110

AP8525

FRO110

FRO110

AP8525

FRO110

When adding the first impedance structure to the flex sub-
stack Speedstack allows the flex sub-stack to be specified
as:

e asingle stack construction with two flex cross-sections
separated by an air gap

e two mini-stacks
In many cases it would be appropriate to treat the individual
stacks as mini-stacks from an impedance viewpoint but
where the flex cross-sections would interact with each other
the sub-stack can be defined as a single stackup with air
between the flex sections as a dielectric.

Adding controlled impedance structures

When a controlled impedance structure is added to a signal
layer, Speedstack displays the Structure Control dialog to
allow the designer to choose a structure based on the
arrangement of signal layers and reference planes.

Click on the sub-stack to display it in Speedstack's Stackup
Editor.

2.0000

0.7000

2.0000
: 0.7000
3.500/0.0200 2 0000
3.800/0.0200

3.500/0.0200
2.0000
__0.7000
g 2.0000
3.500/0.0200 0.7000
3.500/0.021 2.0000

3.800/0.0200

3.500/0.0200

The flex sub-stack above can be regarded as a single stack
with an air gap between two flexible layers or as two
separate stacks (ministacks)

If a controlled impedance structure is added (in this case to
signal layer 6 in the sub-stack above) the flex sub-stack
above must be defined either as a single stack with an air
gap or two separate "ministacks".

When the first structure is added Speedstack displays the
Select Ministack Handling Method dialog

Select Ministack Handling Method

There are the following number of Ministacks, how
do you wish to handle them?

|2
Trezat as Individuzals ¥

Include Air Gaps "
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The mini-stack handling method chosen will determine the
structures available for the selected layer. The structure
options are shown in the dialogs below.

Structure Control

-Number Of Signal
Tracks

@+ Single Trace

" Differential

Structure Control
-Number Of Signal
p Tracks E 5
&
Apply Al + Single Trace Apply Al
(Cffzet Stripline " Differential Coated Microstrip
1B
Advanced E Advanced
Offget Coplanar Coated Coplanar
Strips 1B1A Strips With Low...

Defining the sub-stack as a single stack Defining the sub-stack as two ministacks

with air gap

Sub-stack impedance structure options

For the sub-stack above specified as a single stack with an
airgap, structures on layer 6 will effectively be offset
striplines or offset coplanar strips.

If the sub-stack is defined as two mini-stacks, impedance
structures will function as coated microstrips or coated
coplanar strips.

Resetting mini-stack settings

The current mini-stack settings for the flex sub-stack may be
reset from a single stack to two mini-stacks and vice versa.

Note: — resetting the stack handling method clears the
structures on the sub-stack.

Select the flex sub-stack in the Speedstack Navigator
(shown highlighted below.)

Copy valid drills from Master

Move Right
Mowe Left
Reset Position

HD! Build >
Rename Stack...
Reset Mini-5tack Settings

Docking >

Right click the sub-stack in the Speedstack Navigator and
choose Reset Mini-Stack Settings — the controlled
impedance structures added to the sub-stack will be cleared
from the sub-stack.

When a structure is next added to the sub-stack Speedstack
displays the Select Ministack Handling Method.

Right click the sub-stack in the Speedstack Navigator and
choose Reset Mini-Stack Settings — the controlled
impedance structures added to the sub-stack will be cleared
from the sub-stack.
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When a structure is next added to the sub-stack Speedstack
displays the Select Ministack Handling Method.

Select Ministack Handling Method

There are the following number of Ministacks, how
do you wish to handle them?

|2
Treat as Individuals O

Include &ir Gaps "

As described earlier, redefine the sub-stack as a single stack
with airgaps or two separate stacks. Any new structures
added to the sub-stack will reflect the chosen mini-stack
handling method.

Aligning materials in the Navigator

On occasions, adding a flexible stack results in misalignment
between layer materials displayed in the Navigator, for
example, between the bondply and coverlay layers and the
associated prepreg layers — see the graphic below.

To move the layers into alignment, select the stack in the
Stack Editor and use the FlexNav Move Up and FlexNav
Move Down commands from the Edit menu.

In the example above select the flexible stack in the Stack
Editor, select the upper Coverlay layer and shift the layer up
into alignment with the prepreg layer in the rigid stack (use
the Ctrl + Shift + Up arrow keys)

Repeat the alignment for the bondply and lower coverlay
materials (using the Ctrl + Shift + Down arrow keys.) The
materials are displayed aligned in the Navigator — below.
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To return the stack to its original alignments, from the Edit
menu Reset All NVDP (Navigator Visual Display Position)
Attributes.

The Navigator display is reproduced in the Technical Report

| - 00000000
-
. | Sttt —
I | | |
I

£ w
I —eed

(o] [4)]
e m——

Master flex Sub_stack 3

The technical report also supports different materials on the
same dielectric layer, improving the clarity of documentation
between the stackup designer and fabricator.

Displaying the stack in Proportional View

Speedstack can display the stackup so that the material
thicknesses are shown proportional to each other. Select the
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stack in the Stackup Editor and from the View menu choose
Proportional Stack Viewer.

4.000 1.000
2.800

4.260 20.000
1.400

3.940 5.000

3.940 5.000

1400
2.900 ,: 4.000

1.400

4.000
1.400

4.000
1.400

5.000
5.000
1.400
20.000
2.800
4.000 1.000

This visual aid will be found useful when considering the
dielectric thicknesses between electrical layers.

Using the Ruler within Proportional view
Select the stack in the Stackup Editor
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63.500

101.600

76.200

101.600

63.500

Switch to Proportional View and click the ruler on.

‘Distance: /6.20846 ym

Zoom in as required and use the ruler to measure material
dimensions, thicknesses, trace widths, etc.
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Working with HDI builds

Speedstack HDI

For HDI PCB fabricators, Speedstack HDI provides the
flexibility quickly to calculate the possible impact of
substituting alternative materials to improve manufacturability
and reduce cost while maintaining the specified parameters
and performance of the board.

Easy graphical stackup display

The HDI Navigator provides a rapid guide through the
sequential sub-stack lamination sequence and presents the
complete assembly in a parsed graphical display that shows
each phase of the multi-step lamination sequence of an HDI
PCB.

User-definable settings within the Navigator allow engineers
to display layers in transparent, invisible or 3D mode.

Sub-stack reordering

Speedstack Navigator makes re-ordering and renaming sub-
stacks quick and easy in HDI builds; sub-stacks can be
simply moved left or right within the Navigator window.

HDI builds

Use the Speedstack Navigator to document HDI press/drill
cycles. Speedstack can document press cycles based on foil
locations or drill start and end layers.

Sequential plan

The Sequential plan command creates sub-stacks that
represent each press cycle in a sequential lamination from
the Master stack based on foil locations.

Drill plan

Using Drill Plan, Speedstack determines the sub-stacks by
the start / end layers of the drills.

Creating the target stack with the Stack Editor

Consider the target stack below — it will require three press
cycles. Build and document the stack in the Stack Editor.

Switch to 2D View.
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Liquid Photolmageable Mask
Copper Foil

PrePreg 1080
Copper Foil
PreFreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080
PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil
PreFreg 1080

Copper Foil
Liquid Photolmageable Mask

With the target stack completed use the Navigator's Add
Stack to document each press cycle, building up the stack in

the Navigator. Press F4 to start the Navigator and display the
master stack.

Click Add Stack to copy the stack and name the new sub-
stack Press cycle 2.
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Stack Name IP'ress cycle 2

— Board Thickness
Target Stack Up Thickness  [628821
Positive Tolerance % o
Megative Tolerance % 10

—Copy into new stack. . . .

v Impedance Structures
[+ Motes

[T File Properies

Ok Cancel

The new sub-stack is copied into the Navigator window.

To edit the sub-stack to illustrate the press cycles, click the
sub-stack to display it in the Stack Editor.
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Enabling/disabling materials in the sub-stack

Utilize the Stackup Editor to add the drills and, optionally, to
disable the materials that are added in each press cycle.

e Note that if Symmetrical mode has been selected, material
. ’ - will be disabled both at the top and bottom of the stack.
i Symmetrical Mode

With the sub-stack selected in the Stackup Editor, right click
the sub-stack, select the materials to be disabled —i.e., in
this case the materials added in the final press cycle, see the
graphic below — and choose Flex-Rigid and then choose
Disable Material

Flexi-Rigid > Enable Material
Disable Material
Toggle Material Selection

FR4 Core

PrePreg 1080

Copper Foil

Disabled materials are shown in blue and will be removed
from the sub-stack display to illustrate the press cycle.

The Navigator now displays the press cycle alongside the
master stack.
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The sub-stack can be displayed either to the right or left of
the master stack. Right click the sub-stack and from the
context menu choose Move Left.

Sub-stack Press cycle 2 is now shown to the left of the
master stack.

Press cycle 2

To add the next press cycle, right click the sub-stack and
choose Copy and Paste Stack and position the new sub-
stack to the far left.
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Position new stack...
Far Left Left Right Far Right
o i i i
fpply | Cancel

Modify the new sub-stack, disabling materials added in the
first press cycle, in the Stack Editor as previously described
and display the completed stack in the Navigator.

Each press cycle appears as a separate stack, progressing
from left to right, in the Navigator.

Exposing the cores

In the fabrication process the manufacturer will process all
the core materials first, prior to bonding where each core is
interleaved with prepreg materials. It is sometimes useful,
therefore, to see all the core materials on a single sub-stack.

Right click the Navigator window and choose HDI
Build|Expose Cores to display the core layers.
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Using the Sequential Plan

Sequential Plan creates sub-stacks that represents each
press cycle in a sequential lamination from Master stack
based on foil locations. Consider the 14-layer stack below —
this stack will need several press cycles to manufacture.

Liguid Photolmageable I

Copper Foil
PrePreg 1080

Cop

Copper Foil
PrePreg 1080
Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080
Feil

PrePreg 1080

Copper Foil

PrePreg 1080

Copper Fail

Liguid Photolmageable Mask

Opening the Navigator will display the completed master
stack (shown below) in the Navigator window.
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Right click the Navigator window and choose HDI Build
|Sequential Plan and name the sub-stacks:

Substack Root Name |Press Cycle

Mo Blind Mechanical Vias v

Apply | Cancel |

Click Apply — the Navigator displays the 4 press cycles

Choose HDI Build|Expose Cores — the cores are displayed in
the Navigator window alongside the press cycles.
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Using the Drill Plan

The HDI Build|Drill Plan creates sub-stacks that represents
each press cycle from the Master stack based on drill start-
end layers. Consider the stackup below — a 10 layer
sequential lamination construction.

Liquid Photolmageable Mask
Copper Foil

PrePreg 3113

Copper Fail

PrePreg 1080
FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080

Copper Fo

PrePreg 3113

Copper Foil

Liquid Photolmageable Mask

Press the F4 key to open the Navigator
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Master

The completed Master stack is displayed. Right click the
Navigator and choose HDI Build|Drill Plan.

| HDI Build v Sequential Plan
. Drill Plan |

Expose Cores

Rename Stack...

Supply the Sub-stack root name — the name willl be used
when numbering the press-drill cycles.

Substack Root Name |Press-Drill Cycle |

Mo Blind Mechanical Vias v

fpply | Cancel |

Click Apply — Speedstack documents the build-up stages of
the sequential lamination.

Press-Drill Cycle 02
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Exposing cores

Right click the Navigator and choose HDI Build|Expose
Cores — the cores are shown alongside the press cycles.

There are no limits to the number of press cycles that may
be documented.

Working with multiple press cycles

The stack below is a 24 layer stack with multiple press-drill
cycles. Open the Navigator, choose HDI Build|Drill Plan.

The Navigator displays the drill plan and cores below:
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Printing the Navigator screen

From the File menu choose Print Technical Report —
Speedstack prints the Navigator screen with its press cycles
along with individual stack data, impedance data and drill
data tables.
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Using Speedstack materials libraries

The materials libraries are collections of the materials used
in the process of designing stackups. Users can create and
manage their own libraries of board materials or use
libraries pre-built and provided by material suppliers. Using
43 pre-built libraries can ensure accuracy and save
_@ﬂ considerable time during stackup design. Speedstack allows
Materials Library libraries to be created and materials added. Up to date
libraries of materials may be downloaded from the Polar
Online Material Library. Click the Materials Library button to
display the Materials Library window.

Working with the materials libraries
When Speedstack is started the materials library specified as
the default materials library file (selected via the
Tools|Options|File Locations dialog below) is opened.

File Locations |

Select default materials library file

C:\Program Files (x86)\Polar\Speedstack\Samples\Speedstack Imperial mlbx Browse. ..

The dialog includes the data grid displaying the contents of
the loaded library and the associated library filter.

Each library component type is accessible via its associated
tab. Click on each tab to view or edit the component type.

&= C:\Program Files (x86)\Polar\Speedstack\Samples\Speedstack Imperial.mibx

T TS N TS &

Filter
Field Operand Criteria Logic Row Filter

| = | |
| = | |
| = | |
| |
| |

= |
i | I |

Fols | Prepregs | RCCs  Corss | Solder Masks | dent Inks | Peeiable Masks | Covertays | Bond Ply | Adhesive | Fexible Cores | Shieids |

Type - | Suppier SuppierDesorption | Description_| Stock Number | Dielectrc Base Thickness | Diskectric Finished Thickness| Dielectrc Canstant | Loss Tangent | UpperCu Base Thickness | Lower Cu Base Thickness | ResinContert | Tg | =
» FR4 Polar Samples €001 400-001 508 508 42 0.0135 17.78 17.78 75 180 ml

FR¢  PolerSamples 400002 508 508 42 00135 35.55 35.55 75 180

FR¢  PolarSampie 400003 508 50.8 42 0.01%5 7112 7112 75 180

FRa Polsr Samples 400-004 762 762 42 0.0135 17.78 17.78 60 180

FR¢  PolerSsmples 400005 5.2 5.2 42 0.01%5 35.55 35.55 50 180

FRe  PolarSsmpie 400005 762 762 42 0.01% 7112 71.12 50 180

FR4 Polar Samples 400-007 1016 1016 42 0.0135 17.78 17.78 53 180

FR¢  PolerSsmples 400008 1015 1015 42 0.0135 35.55 35.56 53 180

FRe  PalsrSamples 400009 1018 1018 a2 001% .12 .12 53 180

FR¢  PolarSample 400010 127 127 42 0.01% 17.78 17.78 50 180

FR¢  PalerSsmples 400011 127 127 42 0.01%5 35.55 35.55 50 180

FR¢  PalsrSamples 100012 127 127 42 0013 71.12 71.12 50 180

FR¢  PolarSample 100013 152.4 152.4 42 0.01% 17.78 17.78 47 130

FR¢  PolerSampie 400014 152.4 152.4 42 0.01%5 35.55 35.56 47 180

FR4 Polar Samples 400-015 152.4 162.4 42 0.0135 7112 7112 47 180

FR¢  PolerSamples 400016 2032 2032 42 00135 17.78 17.78 45 180

FRe  PolarSampie 100017 2032 2032 42 0.01% 35.55 35.55 45 180 —

FRa Polar Sample: 400-018 2032 2032 42 0.0135 7112 7112 45 180

FR¢  PolarSample 40001 3043 3048 42 0.01%5 17.78 17.78 45 180

FRe  PolarSsmpie o 400020 3042 3048 42 0.01% 35.55 35.56 45 180

FR4 Polar Samples 4 ore 400-021 3048 3048 42 0.0135 7112 7112 46 180

FR¢  PolerSsmples i o 4004022 533.4 533.4 42 0.0195 17.78 17.78 a1 180 -
| 3

(Click on @ material row to edit it
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Materials library toolbar

Use the toolbar to load and save libraries, import or export
libraries, arrange data columns or access the online or on-
premise libraries. The Toolbar and button functions are
shown below.

m

BT e &

3
b
.

+ 4

Exit library

| Clear materials library

Open materials library

Open and Append

Save materials library

Clear current data table

Import CSV library

Export CSV library

Select & arrange column fields

Save column order

Load column order

Library lock

Online / on-premise library

Library filter toolbar
Use the library filter toolbar to filter materials by data field

Y
Y

Set filter

Clear filter
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® ¥

Open Materials

Library

Open and Append

Library

Opening a library
To open, or load, a library, click the Open Library icon and

browse to the library; click Open — the currently loaded
library will be replaced.

Opening and appending a library

To open a library and add the materials to an existing
library click the Open and Append Library icon, browse to
the library and click Open: the material will be added to the
existing library table.

Filtering Materials

When adding or swapping materials, available materials
(Foils, Prepregs, etc.) are listed in the associated material
library data grid. Lists can be filtered for materials matching
desired parameters (for example, dielectric thickness, Er,
loss tangent, etc.)

Filter
Field Operand Criteria Logic Row Filter
| =] | | = Y% Y
| =] | | =
| =] | | =
| =] | | =
| = | =1 | =
To list only materials matching required characteristics,
specify the criteria in the filter drop-downs and text boxes
and apply the filter.
Filtering for an exact match
For example, to select materials with a dielectric base
thickness of 3.937 mil select the field and operand and
specify the criteria, then click Apply.
Filter
Field Operand Criteria Logic Row Filter
|BaseThickness ﬂ |= ﬂ |3.53? | ﬂ BaseThickness = 3.937
| =l || | = V| %
| = =] | =
| =l =l | =
| =l =l | =
Foils ] Prepregs | RCCs  Cores l Solder Masks ] Ident Inks ] Peelable Masks ] Coverays ] Band Ply ] Adhesive ] Flexible Cores ] Shields ]
Type Supplier Supplier Descripti Description Stock Mumber Dielectric Base Thickness Dielectric Finished Thickness| Dielectric Constant Loss Tangent
» FR4  PolarSamples CO/DO0T FR4 Com 400-007 3.937 3.937 4.2 0.0155
FR4  PolarSamples CO/D0S FR4 Core 400-008 3.937 3.937 4.3 0.0195
FR4  PolarSamples CO/008 FR4 Core 400-009 3.337 3.937 42 0.0155

The matching materials are displayed, along with the row
filter criteria.
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Filtering with multiple criteria
Multiple conditions may be specified with AND/OR logic.

Filter
Field Operand Criteria Logic Row Filter
|BaseThickness j |= j |3.53? |AND % W BaseThickness = 3.937 AND UpperCuThickness = 1.378
|UpperCuThickness j |= j |1.3?E |

| =l =l |
| =l =l |
| =l =l |

Fails ] Prepregs | RCCs  Cores ]Solder Masks ] Ident Inks ] Peelable Masks ] Coverays ] Bond Ply } Adhesive ] Flexible Cores ] Shiglds ]

Ll Ll Led L Led

Type Supplier Supplier Descripti Description Stock Number Dielectnc Base Thickness Dielectnc Finished Thickness| Dielectric Constant Loss Tangent | UpperCu Base Thickness
» FR4 PolarSamples  CO0J008 FR4 Core 400-008 3837 3837 432 0.0185 1378

Use the AND/OR logic field to add each new condition:

Example: BaseThickness = 3.937 AND UpperCuThickness =
‘ﬁ- 1.378 AND DielectricConstant = 4.2 AND LossTangent < 0.02

Apply Filter . - . .
i The conditions are shown specified in the graphic below.

Filter

Field Dperand Criteria Logic Row Filter

[BaseThickness ~|[- ~|[r937 [anD ~| BaseThickness = 3.937 AND UpperCuThickness = 1.378 AND DielectricConstant = 4.2 AND LossTangent <

|UpperCuTh\cKness j |= j ‘T 378 |AND j % ‘* 02

| DietectricConstart ~|[- ~|[e2 [anD ~|

|LcssTangen1 j |< j ‘I} 02 | j

[ = | [ =

Fails ] Prepregs | RCCs  Corss ISu\der Masks] Ident \nks] Peelable Masks I Cuvedays} Bond P?yl Adheswe} Flexible Cores I Shlelds]

. :;:E ::::J\Sles(mpms s;:DD;:rDesnnml ::;c;:::n q5::;::1IJI<:’I:|.|mbe( ::;mnch;eTmckness ::;mncﬁmshed'rhmkne; ::Iemncc:nsmm ;:;s;‘s(angem :F:::ICU Base Thickness :.:;‘.;‘:rCuBsseTmckness ::sm
Filtering for an inexact match with Like
Use the Like operand to to search for a specified pattern in a
column. Use wildcard characters * or % to represent zero or
more characters.
For example,
Like *1080 returns all lines ending in “1080”
Like *1080* — below — returns all lines containing “1080”

Filter

Field Operand Criteria Legic Row Filter
|Descri|:dion j |Ijke j |'1DED Description Like 1080

|
| =l || |
| ]| || |
| =l =i | =l
| =l = | =

Foils ] Prepregs | RCCs  Cores lSoIder Mashs ] Ident Inks ] Peelable Masks ] Coverlays ] Bond Ply ] Adhesive ] Flexible Cores ] Shields ]

1% %

Desecription Dielectric Base Thickness Dielectric Finished Thickness| Diekectric Constant | Loss Tangent | UpperCu Base Thickness | Lower Cu Base Thickness | Resin Content
r 11080 G4 G4 362 0.0088 18 18 57
1x1080 64 64 3.62 0.0083 35 35 57
121080 G4 G4 362 0.0083 0 70 57
121080 76 76 3.5 0.0082 18 18 63
11080 76 76 358 0.0082 35 35 63
1x1080 78 78 3.5 0.0082 70 70 (]
1x106/1x1080 102 102 358 0.008 18 18 53
1x106/11080 102 102 3.58 0.009 35 35 53
1x106/11080 102 102 .58 0.008 0 70 58
1x106/121080 1089 108 3.54 0.0082 18 18 61
1x106/11080 108 109 3.54 0.0082 35 35 61

‘& Click Clear Filter to return to displaying all materials.

Clear Filter

On exiting the library window, Speedstack prompts to save
the library.
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Creating a new library

To create a new library, click Clear Library to clear the
currently loaded materials; the library is removed from the
library manager.

2 Clear Library

ﬁ*‘ Import materials (usually supplied in comma separated
A Import CSV Library Values format) as described below and save the library.

Loading the new library at start up
Click Save Materials Library and supply a name and

jﬁﬂ destination folder to create the new library.

ElL

5 | Save Materials To have the library load as Speedstack starts, specify it as
Library the default materials library file via Tools|Configuration

Options|File Locations as described earlier.

Importing material to the Speedstack materials library

Speedstack allows users to add existing material lists
(usually supplied from the material manufacturer’'s data
sheets) to its library; material data must be arranged in the
format and order used by the Speedstack library.

Library materials can be imported from the Polar Online / On-
Premise Library or from local library files.

Importing from local material files

Prior to importing the material data file ensure the file is not
open in another process (for example, in Microsoft® Excel®.)

ﬁ‘_ Click the Speedstack Materials Library button to open the

Library, and then click Import CSV Library to open the
Import Library dialog.

Import CSV Library

AME P E[EE TTE %% &

Filter
Field Operand Criteria Logic Row Filter
| =] = ]| | = Y% | Y%
| =l =l | =
| =] = | | =
| =l =l | =
| =] = | | =
Fails ] Prepregs ] RCCs Cores ] Solder Masks ] Ident Inks ] Peelable Masks ] Coverlays ] Bond Ply ] Adhesive ] Flexible Cores ] Shields ]
Type Supplier Supplier Description | Description | Stock Mumber | Dielectric Base Thickness Dielectric Finished Thickness| Dielectric Constant | Loss Tangent
b FR& PolarSamples  CO/001 FR4 Cora 400-001 50 50 42 0.0185
FR4 PolarSamples  COv002 FR4 Core 400002 50 50 4.2 0.0185

When importing materials set the Import options in the Import
Library dialog: specify the units, delimiter and material type
and specify whether the material will be used to clear the
current data table or append to the existing library.
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Import Library
|nits for Import Delimiter File Type Exasting Data Table
|mipaort

* Microns * Comma Fails * Clear

RCC —
' Mils/Thous " Tab PrePrei ' Append 43"*

" Millimetres " (Other SolderMasks
|dents

" Inches Peelables
Coverdays
BondPly
Adhesive
FlexCores
Shields

Replacing existing material tables

Choose the Clear Existing Data Table option and choose the
field delimiter type. The library import function can accept
files in a variety of formats: tab delimited, comma separated
and Excel worksheet and template formats but must match
the arrangement of the supplied sample files with columns in
the correct order. Specify the units for import, file delimiter
and choose the file type (Foil, RCC, Prepreg, etc.) and click
Import. Navigate to the file via the Open dialog and click
Open. Repeat the procedure for every file type to be
imported. Save the resulting files as .mlbx library files.

Adding material data to an existing library

To add material data to an existing library table, open the
library, click Import CSV Library, click the Append to Existing
Data Table and click Import.

Navigate to the .csv or .txt file and click Open. Save the
modified library file as a .mlbx file.

Exit the library when all file types have been imported.

Adding new material to the data tables
Caution: ensure consistency of units

When defining dimensions, e.g., layer thicknesses, for a
stackup ensure that all measurements are defined using the
same units (mils, mm, etc.) throughout the structure and its
associated libraries.

Open the library to be modified. To add individual materials
to a library, click the associated component type tab; click
onto a material, or empty line. An editing box will open which
will contain the material clicked on, or the last material in that
type library.
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Review/Edit Cores

Supplier Size
Supplier Description |COID22 Note 1
Description |FFM Core
Stock Number |400-022
Type |FR4
Mote 2

Base Thickness |540.00
Finished Thickness |5-4D.I}D
Dielectric Constant |4.2 Note 2
Loss Tangent |D.E'1 55
Resin Content |4'|
Tg 180
T4 |D Mote 4
CAF Resistance i
£ Bwis Expansion |D
Tolerance +-% |1 0 Note &
Upper Cu Thickness [18.00
Lower Cu Thickness [18.00
Cost |22
Lead Time i

i
Flanes Both Sides I
Laser Drillable I

Add Delete ‘ <L < 22of 29 > = oK

The material can be edited or deleted, or a new material can
be added. To speed up the process of adding families of
materials, when a material is added the properties of the last
material are copied to the new material. The details can then
be edited. Clicking OK will add any new materials to the end
of the list.

Importing material to the data tables

Speedstack allows users to add existing material lists to its
library; material data must be arranged in the format and
order used by the Speedstack library.

Contact Polarcare@polarinstruments.com

Library sample files

Sample files for all material types in comma separated value
format and Microsoft Excel spreadsheet and template
formats suitable for importing to Speedstack are available on
request from Polar Instruments.

Click the Materials Library button to open the Library, and

s
Eqm Import CSV Library then click Import CSV Library to open the Import dialog.
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Import Library
|Inits for Import Delimiter File Type Exaisting Data Table
: |mipaort
* Microns * Comma E‘f':"é * Clear
C |
" Mils/Thous C Tab PrePre " Append $
" Millimetres " (Other SolderMasks
|dents
" Inches Peelables
Coverdays
BondPly
Adhesive
FlexCaores

Choose Clear or Append to Existing Data Table as
appropriate.

Creating a new materials library table

Choose Clear Existing Data Table, click Export Library as
CSV and choose microns as units and the field delimiter type
and click Export. The data table is exported as a “template”.

Open the file in a suitable text file editor — the file below is
opened in Microsoft Excel and shows the file header rows
with the column headers in the order and format expected by
the Speedstack library manager. Add the material data to the
associated columns and save in text format. As noted above,
templates for all materials are available on request from
Polar Instruments. Contact polarcare@polarinstruments.com

H ©- - Foil.csv - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Muance PDF

A3 v I
A B i D E F G H J K L [ M
1 |*Foil
2 |*Type Supplier Supplier Description Description Stock Number Cu Thickness Cost Lead Time Notes1 Notes2 MNotes3 Notes4 Notes5 Size
3 | |
4
3
6

Empty Foils library table

The library import function can accept files in a variety of
formats, tab delimited, comma separated and Excel
worksheet and template formats.

Sections of the sample files suitable for Speedstack are
shown below.
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A B
1 [*coresl
2 |* 1
3 *Type Supplier
4 FR4 Polar Samples
5 |FR4 Paolar Samples
6 |FR4 Paolar Samples
7 |FR4 Polar Samples
8 |FR4 Paolar Samples
9 |FR4 Paolar Samples
10 |FR4 Paolar Samples
11 |FR4 Paolar Samples

co/foo1
cofoo2
co/o03
coj/o04
CO/o05
Co/o06
co/foo7
co/foos

D E F G H I
Dielectric Dielectric
Supplier Description Description Stock Number Upper Cu Thickness Lower Cu Thickness Base Thickness Finished Thickness

FR4 Core 400-001 0.018 0.018 0.05 0.05
FR4 Core 400-002 0.035 0.035 0.05 0.05
FR4 Core 400-003 0.07 0.07 0.05 0.05
FR4 Core  400-004 0.018 0.018 0.075 0.075
FR4 Core 400-005 0.035 0.035 0.075 0.075
FR4 Core 400-006 0.07 0.07 0.075 0.075
FR4 Core 400-007 0.018 0.018 0.1 0.1
FR4 Core 400-008 0.035 0.035 0.1 0.1

Sample Cores library file in Microsoft Excel format

* COres, u553333030303333333333

*, 1332, ,0ielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,,,,,,,,
*Type,Supplier,Supplier Description,Description,Stock Number,Upper Cu Thickness,lower Cu Thickness,Base Thickness,Finished Thickness,
Content,Tg,Td,CAF Resistance,ZAxisExpansion,ExcessResin,Tolerance,Cost,Lead Time,Notes 1,Notes 2,HNotes 3,Notes 4,Notes 5,5ize
Samples,C0/801,FR4 Core,400-001,0.018,0.018,0.05,0.05,4.2,75,180,0,0,0,0,10,0,0,,,,,,*

Samples,C0/882,FR4 Core,400-002,0.035,0.035,0.05,0.05,4.2,75,180,0,0,0,0,10,08,0,,,,,,*

Samples,C0/8@3,FR4 Core,400-003,0.07,0.07,0.05,0.05,4.2,75,180,0,0,0,08,10,0,8,,,,,,*

Samples,C0/004,FR4 Core,400-004,0.018,0.018,0.075,0.0875,4.2,60,180,0,0,0,0,18,0,8,,,,,,*

FR4,Polar
FR4,Polar
FR4,Polar
FR4,Polar

g
[T Arrange Columns

Sampile library file in comma separated format

Files for importing into the library must be in the above
format, with columns in the correct order.

Specify the delimiter if necessary and choose the file type
(Foil, RCC, Prepreg, etc.) and units for import and click
Import and Clear or Append as required.

Choose the file from the list displayed in the Open dialog and
click Open. Repeat the procedure for every file type. Save
the file as a .mlbx library file.

Exit the library manager when all file types have been
imported.

Adding material data to an existing library

To add material data to an existing library, open the library
click Import CSV Library, click the Append to Existing Data
Table and click Import.

Choose the .csv or .txt file and click Open. Save the modified
Library file as a .mlbx file.

Selecting Materials from the Library

Arranging Columns in Library Forms

The Library windows can be customised in respect of which
columns to display and in which order.

The default setting displays all columns. The columns
displayed and the order they are displayed can be set in the
materials Library form.

Click the Go to Materials Library button and Select and
Arrange Columns; the dialog associated with the selected
material tab (Foils, Prepregs, etc.) is opened.
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Save Column Order

Load Column Order

Library Lock

Select Prepreg Fields

Selected Columns Awsailable Columns

Supplier ~
SupplierDescription

Description

Stock Mumber

Base Thickness

Finished Thickness

DielectricConstant

LossTangent

ResinContent

Ta

Down

Td Delete
CAFResistance

ZhxisExpansion .
ExcessResin v Clear All

(et

oK | Cancel ‘

The Left box of the dialog shows the columns that will be
displayed and the order top to bottom is the order they will be
displayed left to right in the library window.

Click OK to return to the Materials Library, which will show
the columns as set.

Until the column order is saved the column order is only
available during the current session. Click Save Column
Order to define the selected column order as the default
order whenever the program is run.

Click Load column Order to apply a saved column
arrangement.

Locking the library

The materials library can be locked and password
protected to prevent unauthorised or accidental editing. If
no password has been set the Material Library remains
open for any changes and modifications.

To lock the library, click the Library Lock button and supply
a password; the library is then locked and any editing
requires the password to be entered (via clicking on the
padlock). Once unlocked it will remain unlocked until
Speedstack is closed or the padlock is clicked again.

Using the Online Library

The Online Library comprises the most up to date copies of
the material files supplied from materials manufacturers who
are members of the Polar Speedstack Supplier Partner
program.

Each new version of Speedstack adds new and updated
materials to the Polar online library; utilisation of the online
library requires access to the internet.
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Importing from the Polar Online Library

To add materials (Foils, Prepregs, etc.) from the online (or
on-premise) library, choose the Open Materials Library icon
and click the Online Library icon highlighted below.

HE C:\Program Files (x86)\Polar\Speedstack!\Samples\Speedstack Imperial.mlbx O X
ENIT: e - = = . & By o
| kT % % (@
Online Library
| Prepregs | RCCs | Cores | Solder Masks | Ident inks | Peslable Masks | Coverlays | Bond Ply | Adhesive | Rexble Cores |
Supplier Supplier Description Description Stock Mumber Cu Base Thickness Type Cost
» PolsrSamples FOI001 Copper Fail 100-001 0.7 Copper 1
Polar Samples FOI002 Copper Foil 100-002 1.4 Copper 2
Polar Samples FO/003 Copper Foil 100-003 2.8 Copper 3
*

Speedstack connects to the Polar Online Library and
displays the materials available for each file type from all the
suppliers in the Speedstack Supplier Partner program; click
on a material supplier's name in the Filter by Supplier pane
to view just the materials available from that supplier.

Cdinie Libsiany
Faltr ey ‘Toppplier File Type Liteary Frles foadable - Al = i
~ Foia [TIE_TU_B72_SLK_10GHz_f0g) mim | e ]
| RCy {TUC_TU_B72_SLK_Sp_100k:_2007 mim 1
..E. Al SUPPhEl’S LEH_ TUC_TLI_BE3_W0GHE_ 2001 sk o
Coven |TUC_TU_BEY_Sp_10GHz_2001 miba
SolderMasin I TUC_TU_933_H0oHz 2001 mia ™ Cleas
et | Vertos_toe_soped_1_0_WT _4B40M)_1GHz 1901 miba:
Pesiabecy Werter_beo_speed_ 2 0_WT_&54_iGHz_ 1900 miba Lhee thes spiecn b9
:M Cavedim Wertes e 2 1 NT 481 1GH: 1900 s chaar dats from
BandFly d X3 O T 370 S 130 B B4
e Werdec_bac_speed 3 0_VT &840 ¥Ekr_ 1901 mbe by data iable
P o Verte_bec_soeed_4_0_VT_4620L) 1GHz 1300 mite
i | iertioe_por et &0 WT 454G 10GH: 30 mts
Werte_beo_spsed 5 0_WT_45dG_WEkr_ 33 mibs

Wertes: tec_moed 5 0 VT 4640 TMiHz 2801 min
| Werte:_por_spsed_5_0_WT_454G_H0GHz 301 mibe st

Filter by Froguend, Libw By Files Selected Sonied el 284800
& AR
JIRLON ~1GH: T 20GH
U e P ™ SaMz ™ S0GH:

© 10GHz © T5GHs

Fals Accdis Mode
% Deliea Polar Libeary [ Rpclpolannynumant com |
™ De-Premise Mode  Sgpdcpbon Noie

}: U Faiph ' Spp Dlata ' Poasreng " Paler Spesdarsch  Maresal Ly Browss J Downlcad

Flease Mote  Ths Sata o sccuraie o the bestof our knowhedge. howeser i1 pronaced, B o leom ow Matenal supplier pariners. Plaase feschack sy entors of
inaccuracies o Folarcene and we will contact the matenall pariner for clarfication o recbfication

Filtering libraries by frequency

Material libraries contain values for dielectric constant (Dk)
and loss tangent (Df) measured at frequencies specified by
the supplier. The measurement frequency is indicated in the
library file name. Use the Filter by Frequency function to list
all files or just the files with Dk and Df specified at the chosen
frequency. Speedstack provides frequency filtering at 1GHz,
5GHz, 10GHz, 20GHz, 50GHz and 75GHz.
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On-Premise libraries

To download a copy of the online library to a local folder,
click the Download... button. The library will be downloaded
and saved by default to the following local folder:
C:\Users\username\AppData\Roaming\Polar\Speedstack\Ma
terialLibrary

Where access to the online library is unavailable or a local
copy is required, a complete set of the online libraries is
available on request to Polarcare subscribers; contact
polarcare@polarinstruments.com with your Polarcare
contract number and Speedstack version. The supplied
libraries should be copied to a suitable local folder with the
file/folder structure preserved. To use the on-premise library,
choose On-Premise Mode and browse to the local copy: the
library files should appear as a local online library; import
materials as described above.

Downloadable mibx files

Note that the Online Library only lists files with .mlbx
extensions and that follow the file naming conversion:

<Supplier>_<MaterialFamily>_<frequency>_<release>. mlbx
(No spaces are permitted in downloadable library file names.)

All .mlbx file names reflect the frequency at which dielectric
constant and loss tangent is specified and the Speedstack
release version.

Although the .mlbx file format will support multiple material
types (Foils, Prepregs, Cores, etc.) in the same file the
downloadable .mlbx file only contains a single material type.

Choosing material files

Browse through the list of available materials or scroll
through the list of suppliers and choose a supplier to filter the
materials by that supplier.

Choose the File Type and material. From the Existing Data
Table dialog select Append to add the new materials to the
table. Click the Clear checkbox to replace the contents of the
selected table type. Repeat for each material to be added to
the library then click Close.

Using proxy servers

Note: Many organisations connect to the Internet via proxy
servers to provide caching and controlled access. In some
cases, a proxy server may return library content in a format
that prevents successful download into Speedstack. If your
organisation connects to the internet via a proxy server, you
may need to request the MIS department to grant address
ftp.//polarinstruments.com permission to bypass the proxy
server — if this is not possible the libraries can be supplied for
local (on-premise) access (see above.)

188 ¢ Speedstack PCB Stackup Design and Documentation


mailto:Polarcare@polarinstruments.com

Speedstack User Guide

Printing stackup information

To print the stackup information, from the File menu choose
the Print Technical Report command to open the Speedstack
Report Printer.

Print Technical Report includes:
e Stack data columns
e Controlled impedance structure data columns
e Drill data columns
¢ Bill of Material data columns
e Frequency dependent loss graphs for each structure

along with frequency dependent properties and information
entered into the Stack File Properties.

. Speedstack Report Printer

File Options

v e L (L] I

-y BaA [ |
\ﬂ\ Sy ew oo ([} Display Page -

BB HERESE
CONFIDENTIAL
- -

CA\Program Files (x86)\PolantSpeedsiack\Samples\Eval Impesial sci

|
L]
Copperlayer| Base | Processed
Type Thickness | Thickness | Resin Content | _er

‘lam| Stack up | Description

M-5683 L1
A I -3uid Photolmageable Mask 1000 4000
1 4 Op A A A A A A A B A Copufd Signal 0700 1400
A L ] FPrePreg 1080 3.000 1950 B0.000 4200
H i A /A & S S S S S S Signal 1400 1400
| FR4 Core 1000 3000 60000 4200
3 1 Plane 1400 1.400
= ] PraPrag 3080 2000 2776 60000 4200
C ] PrePreg 1631 8.000 3352 47.000 4200
C | PreProg 1851 8000 sas2 47000 4200
4 g =8 = ) N N N N N N N N ) Signal 1400 1.400
: g - ﬁ | FR4 Core 12.000 12.000 48000 4200
H 8| 8| B § Y U W ¥ U ¥V ¥V ¥V ¥ v signal 1400 1400
[ ] FrePreg 1651 £.000 5352 47.000 4200
C | PrePreg 1651 6000 5582 47000 4200
= ] PrePreg 3080 3.000 2778 60,000 4200
8 ] Plane 1400 1400
| FR4 Core 3000 3000 60000 4200
7 Y A A e v S Signal 1400 1400
A\ I ] PrePreg 1080 3,000 1850 80.000 4200
] Y LI W W W W W W W W W Comsfol Signal 0700 1400
Y N, -4 Photolmageable Mask 1000 4000
414818
‘Copper Thickness = 11.200 | Dietectric Thickness = 49.660 | Solder Mask Thickness = 2.000 |
Stack Up Thickness = 60.860 | Stack Up Thickness with Soldemmask = 62.860
Siack Up Cost = 54.00
Lower | Upper Coating
Trace | Trace | Trace | Subswate| Subswate| Rel | Ref. | Abave
Structure Target | Calculated | Width | Width | Thickness | 1Height | 2 Height | Plane 1 [ Plane 2 | Substrate
Image Stucture Hame Impedance | Impedance | (W1) | (W2) Ty (H1) (H2) | inLayer| inlayer| (C1)
I;| Coated Microstrip 16 75,000 75.740 4000 3000 1400 6350 0.000 3 ] 1.000
Q Edge Coupled Coated Microstnp 18 100.000 108.250 7850 B850 1400 8350 0.000 3 [] 1.000

Stackiame: 10 Contral

Drawing No: v1.03 Associated Documents: Revision: | Modification: Date of Revision: | Editor

Date: 0108 2022 101 & NIM

Designer. RAB 02 I CEm Fage %-
Eng Model 1.03 1/8/2022 RRE . .

Office: Garenne Park CONFIDENTIAL

[— e —

Speedstack Technical Report
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Speedstack Report Printer toolbar

The Speedstack Report Printer toolbar provides shortcut
access to the most commonly used printing commands.

e G AT EE- w2 M E RSP HQQEOD0E  awwr =

Use these commands to set up the printer, page orientation
and margins, font size and printing order, select data columns
for display, display or suppress data tables and choose the
on-screen zoom levels. Button functions are described below.

Send report to printer

Print set up — choose printer, print range, copies

Page set up — orientation and margins

Print all pages

H B IE| B

Print range of pages (display Page Range dialog)

From To

ERNU

Okay

Select page range

"_'|.

Select stack data columns

Select impedance data columns

Select drill data columns

Select BOM data columns

Change font size

Select stack/drills/impedance/notes print order

Set note field aliases
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][+][ ][ Show expanded drills — toggle wide stack
and narrow stack image

.‘_l
' ? Toggle suppress stack data table
=

H? Toggle suppress controlled impedance data table

Toggle suppress frequency dependent loss graphs

I
? Toggle suppress drill data table

Toggle suppress BOM data table

'{'l'%' &’1&

Zoom in / Zoom out

Fit page to viewer

0D
(|08 |o5

Preview one / two / four pages

Display Page |1 -

Select page for display

Speedstack Report Printer menu system

File menu

Use the File menu under the Printing window to save and
load print settings.

Save Print Settings
Load Print Settings

Exit Ctrl+ 0

Saving print settings

Click Save Print Settings and specify the Print Settings file
name and location.

Loading saved print settings

Click Load Print Settings to load a saved Print Settings file.
Whichever settings were last used in a session will become
the default when the Printing window is next loaded.
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Options menu

The Speedstack Report Printer Options menu contains all
the settings for printing.

Print Setup

Page Setup

Stack Data Table »
Controlled Impedance Data Table ¥
Frequency Dependent Loss Graphs »
Drrill Data Table »
B.O.M. Data Table »
Footer »

Mote Field Aliases

Print Order

General >
Confidential...

Restore Default Settings
Restore Default Table Fields
Restore Default Table Fields (Legacy)

Print Setup

Use the Print Setup command to choose the target printer,
along with its properties, the range of pages to print and
number of copies. Optionally, click the Print to file check box
to save the output to a file (for example, to save the file as a
document in PDF format) when printed.

Page Setup

Page Setup displays the Page Setup dialog to change the
paper size and source and page orientation and margins.

Stack Data Table

The Stack Data Table commands allow for optional display
of stack parameters, drills, thickness totals and tolerances.

Choose Stack Data Table, Suppress to hide the stack data
table and the associated columns selected for display via the
Stack Data Columns... command.
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L8 L4

%

Suppress

Stack Data Columns...
Show Drills (Stack Table)
Show Thickness Totals
Show Stackup Cost

Show Hatch Profile Data
Show Finishing Class Data

Show Expanded Drills (will widen materials celumn)

Show Stackup Thickness...

Show Stackup Thickness Tolerance Value As...

Show Stackup Thickness (Solder mask-5older mask)
Show Stackup Thickness (Laminate-Laminate)

Stackup Thickness Decimal Accuracy

Stack Data Columns...

Choose Stack Data Columns... to select and order the data

columns available for the stack as required.

Select a column from the Available Columns list, move it to
the Selected Columns list and use the Up and Down buttons
to order the displayed columns.

g= Select Stack Table Columns — O pod
Selected Columns Lorzilable Columns
Description < | Supplier A
Copper Layer Type Supplier Description
Baze Thickness » Stock Mumber
Processed Thickness - Type
Resin Content Min Trace Width
er Up Telerance
Loss Tangent Tg
Impedance [D 0 Td
Finish Thickness own Ink Thickness
Copper Coverage Colar
Izolation Distance Delete Mask Thickness
|zolation Distance (Summed) Data Filenames
o Cost
Clear All Lead Time o
QK Cancel

The stack data table is displayed in selected column order:
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Layer| Base | Processed Finish | Copper | Isolation | Distance
Layer Stack up Description ype Thickness | Thickness | ResinContent| e | Loss Tangent ID | Thickness | Coverage | Distance | (Summed)
I . iquid Fhatolmageable Mask 25400 4000 00188
1 il A A M M Copperfol Signal I 17780 1.2 17780 0.000
PrePrag 1080 7200 49530 60.000 4200 00195 76.200 49530 43530
2 Signal 35.560 35560 35.560 0.000
) Fra Core 3200 76200 60,000 4200 00198 76.200 76200 76.200
E | Plane 35560 35560 33560 0.000
] PrePreg 3030 7200 0510 60,000 4200 00195 76,200 70510 352552
| PrePreg 1651 152 400 141.021 47.000 4200 00195 152,400 141020 .
| PrePreg 1631 152400 141.021 47.000 4200 00135 152400 1410 .
4 = Signal 35560 35560 3 33560 0.000
= ) FR4 Core 04E00 304800 45000 4200 00195 304.300 304800 304.800
5 & Signal 35.560 35.560 35560 0.000
| Prefreg 1631 152 400 141.021 47.000 4200 00195 152,400 141020 3s52.552
| Prefreg 1651 152400 141011 47000 4200 00133 132400 H“iem o -
] PreFreg 3080 76.200 70510 60.000 4.200 00193 76.200 70.510
5 ] Plana 35560 35,560 35560 0000
| FR4 Core 7200 76200 60.000 4200 00195 76.200 76200 76.200
7 Signal 35560 35560 33560 0.000
PreFreg 1080 76.200 49.530 60.000 4.200 00193 76.200 49.530 43330
B ~0 i W W W W CopperFoll Signal 17.780 17.780 4 17.780 0.000
I Liquid Phowimagezble Mask 25400 4000 00135
Copper Thickness = 248.920 | Diclectiic Thickness = 1261.364 | Solder Mask Thickness = 50.800 | Stack Up Thickness = 1510.284 | Stack Up Thickness with Sokdermask = 1561.084
Stack Up Cost = 54.00

Use the Show Drills (Stack Table) command to show or hide
the drills in the stackup graphic in the Stack Table.

The Thickness Totals provides optional display of the sum of
materials thicknesses, copper, dielectric, solder mask and
the stackup — with and without the solder mask thickness.

Copper Thickness = 284480 | Dielectric Thickness = 1261.364 | Solder Mask Thickness = 50800
Stack Up Thickness = 1343.844 | Stack Up Thickness with Soldermask = 1596.644

Use the Show Stackup Cost option to display the cost in the
stack summary.

Select Show Hatch Profile Data to include the hatch pitch and
width and copper area percentage in the stack summary.

The Show Finishing Class Data displays the copper finishing
class specified from the list of Copper Finishing classes —
either a Copper Coverage Fishing Class or a Simple
Percentage Finishing Class — depending on which finishing
method was chosen via the Tools|Set Finishing Method.

Show Expanded Drills

By default, the Stack Data Table shows just the first six drill
slots in the stack (Stackup Columns in the Add Drill dialog),
although up to eleven drill slots may have been defined. Use
Show Expended Drills to view all defined drill slots.

h
1 1 A [ | A AR ] 1 t A 0N 00 ER RQ L
s A0 = ] s A0 i — [ |
3 E :‘_I 3 E I - EI
C ] o — s I 0 |
C o C - V4 @
0 [r— B N N ! == @
e i , 5| 5 § o eSSl == b
C [ = [ Ay i
(= i C /0 @
C B C == 0
5 B o
7 E\ | Y/ q 7 E 1 — 3
YO % L YO =V 3
g A [ & | Y Ly 8 v La 1F
L 4 A 4
Standard Drill display Expanded Drill display

Use the Show Stackup Thickness commands to display or
hide the target or calculated values of total stack thickness.
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Values can optionally include solder mask and laminate
thicknesses.

a3

1561018

1510.28

Liguid Fhatalmageable Mask
s GO @ M M A M Cowerfol
&) | | FreFreg 1080
E # 1 A & & N
|
[ | FreFreg 3080
1 | PrePreg 1651
[ | PrePreg 1631
= t A & & & &
= | FRd4 Core
= w W W W W
O | PrePreg 1851
[ | PrePreg 1651
[ | PrePreg 3080
E v v W ul e
v [ '|IJ | FrePreg 1080
r LOE S W W W W Coppefol
Liquid Photolmageable Mask

Foce

More Calculations

When the target value of the Stackup thickness is chosen the
Stackup Thickness Tolerance values can be displayed as
percentages of the target stack thickness or as actual values.

Choose Stackup Thickness Accuracy to display accuracy by
number of decimal places.

Controlled Impedance Data Table

Use the Controlled Impedance Data Table options to show or
hide the controlled impedance structures and parameters.

Suppress

Impedance Data Columns...
Show Structures-by-Layer Separator
Sort Structures in SE/Diff Order Per Layer

Impedance Data columns can be selected for display and
ordered as required.

Controlled Impedance data columns

Choose the parameters for display from the Available
Columns pane and change the order of display using the Up
and Down buttons.

Note that the available data columns include the results
shown in the Controlled Impedance Toolbar | More
Calculations dialogs. The More Calculations results are
highlighted in red in the graphic below
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wz= Select Controlled Impedance Table Columns

Selected Columns

Ref. Plane 1in Layer

Ref. Plane 2in Layer

Coating Above Substrate (C1)
Capacitance (C) (pFsin)
Inductance (L) inHn)

Delay (Odd Mode) (D) (ps/in)
Common Mode Impedance (Zcomm
Differential Impedance (Zdiff)
Efective Dielectric Constant (EEr)
Even Mode Impedance (Zeven)
Cdd Mode Impedance (fodd)
Velocity of Propogation (CITS) (Vp)
Mear-End Crosstalk (MEXT) (Kb)

Coupling Percertage (CF)

Up
Down

Delete

|

Clear All

HAorailable Columns

MNetClass3

MetClass4

MetClassh

Structure Mame

Substrate 1 Dielectric (Erl)
Substrate 2 Dielectric (Er?)
Substrate 3 Dielectric (Erd)
Substrate 3 Height (H3)
Substrate 4 Dielectric (Erd)
Substrate 4 Height (H4)
Tol (+/-%)

Trace Offset (01)

Trace Pitch (51+ W1)
Upper Ground Strip Width (G2)

OK

W

Cancel

The selected columns are added to the Impedance Table.
Note that adding or removing columns for display will initiate
a full on-demand recalculation of results.

Lower | Upper Coating m Common Effective Even w:fw Near-End
Trace | Trace Traoo Tmo swsguu Slbem Ref. Ref. Above Mode) Mode Differential | Dielectiic Mode Odd Mode | Propogation |  Crosstalk Coupling
S:::! h;:'dmww Impedance m;‘ “(\,'::‘lh “?T’ [E1)] "[:3“ 2::2?' rl-:; :':ev: €1 (oceuf:!l (Zcommon) | (zdiff) m(:;m (Zeven) Zadd) %ﬁ) m[:agn {CP)
Grouping structures by layer
Within the Impedance Data Table structures can be grouped
by layer; choose Show Structures-By-Layer Separator. The
Separator will add a black structure separator bar on the
print out between structure groups, allowing the structures to
be sorted by layer number rather than the order that the
structures are added to the stack.
Lower | Upper Coating
Trace | Trace Trace Substrate | Substrate Ref. Ref. Above
Structure Target Caleulated | Width | Width | Thickmness | 1 Height | 2 Height | Plane 1 | Plane 2 | Substrate
Image Structure Name Impedance | Impedance | (W1) | (W2) ) (H1) (HZ) | inlLayer | inLayer <)
Coated Microstrip 12 T75.000 75,870 114.300 BE. 900 17.780 161.250 0.000 3 il 23400
sdge Coupled Coated Migrasing 1B 100,000 100,350 213,800 120,000 17,780 161.250 D000 d o 3400
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Sorting impedance structures by type

The technical report, by default, prints the structures within a
layer in the order in which they were added to the stack.

In the example stack below the structures were added to the
stack in the order shown.

Lower Upper
Impedance Ref. Ref. Trace Trace Trace

Impadance | Structure Signal Plane 1 | Flane 2 | Width Width | Separation Target Tol {(+/-| Calculated
[ Image Struclure Name Layar in Layer | in Layer | (W1} {W2) (51) Impedance %) Impedance

1 E Edge Coupled Coated Microstrip 1B 1 3 0 2.500 7.500 815 100,000 10,000 100,350

E Coated Microstrip 1B 1 3 ] 4.500 3.500 0.000 75.000 10,000 75870

E Coated Microstrip 1B 1 3 0 11,476 10476 0000 50.000 10,000 48.520

E Edge Coupled Coated Microstrip 1B 1 3 ] 12.542 11.542 10.000 85.000 10,000 BG.220

Structures within each layer can be grouped by type, single
ended and differential.
To sort the structures by type choose the Sort Structures by

SE/Diff Order per Layer; the structures within each layer will
be ordered in single ended then differential order as shown

in the graphic below.

Lower Upper
Impedance Ref. Ref. Trace Trace Trace

Impedance | Structure Signal Plane 1 | Plane 2 | Width Width | Separation Target Tol {+/-| Calculated
[ Image Struclure Name Layar in Layer | in Layer | (W1} {W2) (51) Impadancea ) Impadance

2 E Ceated Microstrip 1B 1 3 i} 4.500 3.500 0.000 75.000 10,000 75.870

E Coated Microstrip 18 1 3 a 11.476 10476 0.oon 50.000 10,000  49.520

E Edge Coupled Coated Microstip 18 1 3 i} 8.500 7.500 8115 100.000 10,000 100.350

E Edge Coupled Coated Microstrip 18 1 3 i} 12.542 11.542 10.000 a85.000 10,000 B5.220
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Frequency dependent loss graphs

Speedstack Si provides graphing and tabular display of the
frequency dependent properties of each controlled
impedance structure in the stackup. The technical report
includes the option of displaying the loss v frequency graph
of every structure in the stackup — see below.

CAProgram Files (xBE)\PolarSpeedstack\Samples\APS 17 sci Units: Mils I M-

Offset Sipline 1B1A

Substrate Causal Exirapolation Reference Paints Surface Roughness Compensation: Hammerstad

Length of Line: 1000 Freq (Hz) Ref Er Ref TanD Surface 1 Roughness (RMS) R1:0.2 Frequency of Interest: 1000 MHz.
Trace Conductivity: 5.8E+07 Sim H T.000E+0S_[4.2000 0.0195 Surface 2 Roughness (RMS) R2: 0.2 Condustor Loss: -74855-02 dBlline
Fragqueney Minimurn: 500 MHz HZ 1.000E+08 [4.2000 00755 Sutface 3 Roughness (RMS) R3: 0.2 Dielectric Less: -9 312E-02 dBfline
Frequency Maximu m: 10 GHz
Frequency Steps: 20 RET Conduct ith Ro - -1.097E-01 dB/lne
CEr Anenuation with Roughness: -2 022E-01 dB/line

Surface 4 Roughness (RMS) R4: 0.2

e Conducior | 055 s Dielectric Loss mmmmmm Aflenuation === Conduclor Loss with Roughness === Atenuation with Roughness
%____-——______
02 \\ T

g 04

o 08

All Losses with Roughness - dB/line

10

—r—r— — S S A —————
1000 2000 3000 4000 5000 6000 T000 8000 9000 10000
Frequency - MHz

When the technical report is selected for print Speedstack
recalculates and displays the loss v frequency for the
frequency dependent properties of each structure in the
stackup.

The display for each structure includes the structure graphic
and the associated frequency dependent parameters, the
substrate causal extrapolation reference points, the surface
roughness method and settings and the losses and
attenuation at the user defined frequency of interest.

From the Options menu, choose Frequency Dependent Loss
Graphs|Suppress to toggle display of frequency dependent
loss graphs and tables.
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Drill DataTable
The drill information is reflected in the Technical Report.
From the File menu choose Print Technical Report.

The Technical Report opens with the Stack Data Table which
includes the drill and back drill information

Showing expanded drills

Speedstack can display up to eleven drill columns in a stack
though six columns are often sufficient. Use Show

Show Expanded Drills £y handed Drills to toggle between wide stack and narrow
stack image mode. Selecting the narrow stackup image
][ frees up the horizontal space for more data columns.
Speedstack displays a warning if drills exist beyond column
six and narrow stack mode is selected,
A A
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Example 1
The example below contains a single drill and associated
back drill.
Layer Stack up Description Type Thickness | Thickness | Resin Content | &r
e Lia:id Photolmageable Mask 25400 4.000
i f A A [] A A A & & A & A cowperol signal 17780 35560
e | PrePreg3113 101.800 100711 53.000 4.200
[ | PrePreg3113 101.800 10071 53.000 4.200
2 A A jL & & A/ A& signal 35560 35560
[ | FR4 Core 203.200 203.z200 45.000 4.200
3 | | Plane 35.560 35.560
[ | PrePreg3113 101.800 B7.376 53.000 4.200
[ | PrePreg3i13 101.600 87378 53.000 4.200
1 g2 =5 L P N N o N N N 0 N S N N Signal 35.580 35.560
~| = wl | | FR4 Cere 203.200 203.200 45.000 4.200
s 8 2 B W 1T W v o v v v v signal 3560 35560
[ | PrePreg 3113 101.600 B7.378 53.000 4.200
[ | PrePreg3113 101.800 B7.376 53.000 4.200
[ [ | Flane 35.560 35.560
| | FR4 Core 203.200 203.200 45.000 4.200
7 W v O o v v v v Signal 35,560 35,560
[ | PrePreg3113 101800 10071 53.000 4.200
¥ | PrePreg 3113 101.600 100.711 53.000 4.200
] \ 4 v v W W W W W W W W Copperfoi Signal 17.780 35.560
L Liguid Photolmageable Mask 25400 4,000
Copper Thick = 284.480 | Dielectric Thick = 1361948 | Solder Mask Thickness = 50,800 |
Stack Up Thickness = 1646.428 | Stack Up Thickness with Soldermask = 1697 228

Stack Up Cost = 77.00
‘Simple Percentage Finishing Class: ‘Class 1'= 17.780

Select page 2 to display the Drill Data Table.
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Use the Drill Data Table command to show or hide the table
of drill parameters and to select and order parameter values
for display.

Selected Columns

#= Select Drill Table Columns — O >

Hforailable Columns

Drill Image: < | Fill Type A
1st Layer Hole Count
Znd Layer » Different Hole Sizes
Column Position - Minimum Size
Drill Type Data Filenames
Back Drill Must Cut Layer Mo Up Minimum Pad Size
Back Drill Must Mot Cut Layer Mo Minimum Drill Size
Down Minimum Drill Size Tolerance
Minimum Bamel Wall Thickness
Back Drill Maximum Distance From (
Delete Back Drill Minimum Distance From C
Back Drill Primary Drill Size
o Drill Mates-1
DEERL Dril Notes-2 v

QK Cancel

Dirill Data Table

Click items in the Available Columns list and add to the
Selected Columns list for display. Use the Up and Down
arrows to order/reorder the selected columns.

Use the Sort Dirills... command to order the drill table — drills
can be sorted by start-end layer order or creation order.

» Suppress

Drill Data Columns...
Sort Drills... r Creation Order

Start - End Layer Order

Displaying the Drill Data Table
Page 2 of the Technical Report displays the Drill Data Table

Corill 1st 2nd | Column Muast-Cut | Must-Hot-Cut
Image | Layer | Layer | Position Dirill Type Layer No Layer Ho
| E 1 5 3 Mechanical PTH
L
Back Cril B 3

G

The Dirill Data Table displays the chosen Drill Data Table
columns in the sorted order
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Example 2

The example stackup below contains a selection of drill and
back drill types.

Liquid Photolmageable Mask
Copper Foil

PrePreg 1080
FR4 Core

PrePreg 3080

PrePreg 1651

PrePreg 1651

FR4 Core

PrePreg 1651

PrePreg 1651

Liquid Photolmageable Mask

These are reflected in the Technical Report
(File | Print Technical Report)

1561.08

Liquid Photolmageable Mask

A ERERER A A 0§ EF ER ER EF 4] CopperFoi
AT 1 [ { | ] PrePreg 1080
E ! — ¢ ¢ 4 4 i s H FR4 Core
C — w Z_ | PrePreg 3080
C ] %_ 7] PrePreg 1651
C %_ 7] PrePreg 1651
a8 = AN AN | N g . N h | %
1% % [é \Wj v/ 5| |7 [I] s % ? FR4 Core
C B | | %_ ] PrePreg 1651
C ] | | ] PrePreg 1651
= || é: ] PrePreg 3080
1 — B .
& JAL ] / a FR4 Core
A—li—~7 Zm
Y & L,fl "IJ il | | % | PrePreg 1080
v jieghEl W w Z4/ VA J  copperFoi

Liquid Photolmageable Mask
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Displaying the Drill Data Table
Page down through the Technical Report to display the Drill

Data Table
Calcutated | Calcukated
Diilll Dyill
Dexpith - Depihy -
Bk First Hack Hark
Drill fei | Znd | Colsne Musi-Curk | Musit-Hot-Cut | Drill Lapesr il Dl
Wmage | Layer | Layer | Position Dvill Type Layer Mo [ Layer No Type | Capped | MustC | Must-Rioi-Cut
'i 7 5 3 Laser FTH - - - False 00400 0.06H
m ] . 10 Bk Crill 3 2 POINTED  False 1331214 1442974
m ] - 4 Back Drill 4 3 FOANTED  False 943102 1331214
E 8 . i Back Drill 5 4 ROUTER  True G02742 945102
QI b - 7 gak Dril 6 5 FLAT Trug 2630 G022
Q ] . & Bk Dl 7 E POINTED  True 102870 214630
q ¥ 2 Laser FTH - - - False {L.0H) .01
ﬁ ] 7 3 Laser FTH - - - False  0.000 0,000
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Bill of Materials Table

Speedstack’s Technical Report incorporates the Bill of
Material (BOM) table with the stock-number displayed
optionally as a barcode. The table contains fields for Total
Quantity (No. Panels * Stack Quantity) and Total Cost (Unit
Cost * Total Quantity.)

Supplier Stack Total
Suppl Deseripli Description Type Stock Humber | Quantity | Unit Cost| Stack Cost| Quantity | Total Cost
Folar Samples SM007  Liguid Phoimageable Mask  Solderbask || || || ||| |||| z 0,00 0.00 z 0.00
Polar Samples FO/M01 Copper Fail Copper | | " " I || ||| | 2 +i] 2.00 2 2.00
Folar Samples PPI0O1 PrePreg 1080 Dislectric | || || | || ||| | 2 oo 2.00 2 2.00
Folar Samples Coioas FR4 Core FR4 || || || ||| |||| 2 5.00 10.00 z 10.00
Folar Samples FPIDOZ FrePreg 3080 Dielectric I " " I || |||| 2 2,00 4.00 2 4.00
Folar Samples PPID04 FreFreg 1651 Dislectric | || || | || || || 4 4.00 16.00 4 15.00
Polar Samples comzo FR4 Core FR4 || || || |||||| 1 20,00 20.00 1 20.00
54,00 =400
Ha, of Panels = 1 | Cwcuits Per Panel =1 | Prce Per Ciwcuit = 54 .00 |

The table includes totals for the Stack Cost and the Total
Cost columns.

A summary section presents 3 values: No. of Panels, Circuits
Per Panel and Price Per Circuit. The No. of Panels and
Circuits Per Panel can be entered by the user at any time or
optionally at the start of each print session.

Bill of Materials Table columns can be selected for display
and ordered as required. Choose the parameters for display
from the Available Columns pane and change the order of
display using the Up and Down buttons.

o= Select Bill of Materials Table Celumns — | it

Selected Columns HAwailable Columns

Supplier

Supplier Description
Description

Type

Stock Number
Stack Quantity 1
Unit Cost
Stack Cost
Total Quartity
Total Cost

-
s

Down

Delete

ddudas

Clear All

oK | Cancel |

From the Options menu choose B.O.M. Data Table to display
or suppress the table. The Suppress command toggles the
B.O.M. table on and off in the report.
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Stock numbers
Stock numbers can be displayed in alpha-numeric form or as

barcodes.
B.O.M. Data Table » Suppress
Footer » Stock Number ¥ Show as Barcode
Panels / Circuits per Panel... Barcode Font and Start/Stop Character...

Mote Field Aliases

Print Order ~  Show Mumber of Panels

~  Show Circuits Per Panel

3
General +  Show Price Per Circuit

Choose Stock Number|Show as Barcode to toggle the Stock
Number display between barcodes or alpha-numeric text.

Stack

Description Type | Stock Number | Quantity | Unit Cost

Liquid Photolmageable Mask  solderMask [N 2 0.00
Copper Foil - Copper [ [N 2 1.00

PrePreg 1080 Dielectric [ [F NI 2 1.00

FR4 Core FR& I 2 5.00

Prefreg 3080 - Dietectric [ III 2 200

PrePreg 1651 Dielectric [ [} I 4 400

FR4 Core FRe W 1 2000

Choosing the bar code font

From the Stock Number command choose Barcode Font and
Start/Stop Character. The Select Barcode font and Start/Stop
Marker Characters dialog is displayed.

8 -
9
10
11
Angsana New r—
AngsanallPC 13
Aparajta 14
Arabic Typesetting 15
Arial 16
Arial Black iy 17 %
3 of 9 Barcode 12
Include Stop / Start Character
" None
(* Asterisk -~
(" Exclamation - |
(" Other
Reset Close

Choose the font and font size and the start / stop character
as appropriate. (The barcode font must already installed on
the host computer.)

204 « Speedstack PCB Stackup Design and Documentation



Speedstack User Guide

Choosing the start/stop character

The Start/Stop character is a requirement for certain barcode
types such as Code 39 (also referred to as Code 3 of 9,
Code 3/9, Type 39, etc.) The Code 39 asterisk character is
normally reserved as a start/stop character rendering the
data a valid barcode.

As an example, if the Stock-Number is 123-456, selecting
the Asterisk option will add enclosing asterisks to the Stock-
Number so that the barcode is valid.

(In some instances, asterisks may already be included in the
Stock-Number in which case choose the None option.)

There are other situations where another character may be
used. Exercise caution when determining the appropriate
font choice and start/stop character to use. In the event that
an inappropriate font is chosen, the results may be
unpredictable.

Panels / Circuits per Panel...

To specify the number of panels and circuits per panel, from
the Options menu choose

B.O.M. Data Table | Panels / Circuits per Panel...

B.C.M. Data Table > Suppress

Stock Number ¥

Panels / Circuits per Panel...

Enter the number of panels and the number of circuits per
panel.

— O >
Enter the following data required for the Bill of Materials
[BOM) table.
Mumber of Panels |i]
Circuits per Panel |'I

[ Always show this at the start of a print session
Okay

The summary Price Per Circuit is then a calculated value
(Total Stack Cost / Circuits Per Panel).

| No_ of Panels =1 | Circuits Per Panel =1 | Price Per Circuit = 54.00 |

Use the Show Number of Panels, Show Circuits per Panel
and Show Price per Circuit commands to toggle the display
of the associated summary components.
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Footer

The report footer section is an optional item and may be
displayed or suppressed (hidden).

Footer > Suppress

Enable Expanded Footer

Owerride Footer Label...

Suppressing the footer

When the Footer section is suppressed the space is used for
other data, often reducing the number of pages required for

the technical report.
- Polar

StackName: W-Goard Version. V13.05 Revision. Wodiicaton Date of Revision. | Editor
Date: 12 June 2019 Associzied Documents: Rev #1 Coll 1 Dec 2018 J _
Author: B Johnson Rev#l | Daia Net T fpr 2018 FE} o

o|

Cepartment: Eng
Site: North Side

Using the expanded footer

Use the Expanded Footer option to allow longer and more
descriptive stack names to be displayed.

StackMame: Contraller M-Board MWFD1E3E
Version: V15,05 Associated Dosuments: Revision: | Madificabon Date of Revision:

Cate: 12 June 2015 Rev#l Cell 1Dec 2018
Rev#2 Data Met 1 Apr 2013

Author: B Johnson

Department Eng
Sita: North Side

Overriding the footer labels

The labels in the footer may be changed to reflect the
stackup design workflow and organisational structure.

Choose Footer | Override Footer Label...
The Override Footer Labels dialog is displayed:

[N

E Override Footer Labels — O b4

Owverride the labels shown in the footer of the printout

“ersion

Author

|Designer

Department

Site
|Oﬁice

Clear | Ckay

The new labels will be reflected in the footer:
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Drrawing Mo:| 15.03
DCate: 12 June 2018
Cesigner| B Johnson

Cepartment Eng
Dffice:] Morh Side

Note Field Aliases

Note Field Aliases allows for the free-text note fields (for the
Stack and Controlled impedance tables) to be given
descriptive names.

Print Order

Use the Print Order dialog to move the Controlled
Impedance Table, Drill Tables and Notes sections up or
down within the report.

Print Crder -

Stackup Table P
Controlled Impedance Table
Crills Table Down
Bill of Materials (B.0.M.) Table
Motes
Motes

Restare

Close

A

Note: the Stack/Materials data Table cannot be reordered
and must remain the first item in the print order.

General Options

Polar Lego 2
User Logo 3
Copyright 3
Data Mumber Format k
Data Alignment 2
Stack Alignment (Flex-Rigid only] k
Font Size k
Colours

File Path 3
Margin Guides 3

The General Options are described below

Polar Logo
Polar Logo: toggles the Polar Instruments logo on and off.
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User Logo: toggles the user-defined logo on and off (as set
in the application configuration).

Copyright
Copyright: toggles the copyright information on and off and
allows copyright test to be edited.

Data Number Format

Data Number Format: sets the precision of numeric data in
the printout.

Data Alignment

Data Alignment: specifies alignment (left, centre, etc.) for
stack, impedance and drill data.

Stack Alignment

Stack Alignment (Flex-Rigid only): — Align to Master Stack
allows the vertical position of sub-stacks (printed on
separate pages within the report) to be preserved with
respect to the master stack; Align to Page Top presents
each sub-stack at the top of each page.

Colours

Colours: allows for the colours of items within the report to
be customised. Click Override Default Colours and Change
to specify the new colour. Click Reset All to return to the
default colours.

File Path
File Path: toggles on and off the file path/file name

Margin Guides: toggles on and off boundary markings (in
the user selected units.) These match the Speedstack units
selected within the Stackup Editor | Units menu.

Margin Guides

The margin guides allow for display of the printable area of
the page — which can vary depending upon the device —
even though the page size remains the same. (With some
devices the report cannot use the full extents of the page.)
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Confidential... notice

The Technical Report includes an optional Confidential
notice to be added to the report.

Click Confidential... the Confidential Stamp Options dialog is
displayed.

Confidential Stamp Options

Select which location where you wish Confidential’ to appear.

Mote that some locations may interfere with existing text or loges. Itis your
responsibility to resolve this by editing the existing text or logos.

If you reguire, you can substitute Confidential with 3 word of your choosing.
Otherwise leave the field blank.

Alternative word

|Confidential
[+ Location 1 [ Location 3
[ Location 2 I+ Location 4

Close

The notice wording may be changed from Confidential to
other text as appropriate.

The specified text may be displayed in up to four predefined
locations as shown in the dialog.

Click the check box for each required location.
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Speedstack Stackup XML Information (.STKX) v25.00

General Notes
The Speedstack XML format is divided into a number of sections, and each section is described below. It

is necessary to provide the Header section and the Stack Collection section within the file, but the Drill
Collection and Impedance Structure Collection are optional.

Unused String fields should be set to a null string. Unused Numeric fields should be set to 0.

Header Section

<Version> This field defines the actual version of the
Speedstack Stack Up XML file. The Stack
Up XML file format may change in the future
as we introduce new features, so this field
can be used to verify whether an import /
export processors will support a particular
XML format.

Numeric. 25.00
<Units> Units used throughout the XML file.

Numeric field.

The mapping is as follows:

3=microns
4=mils
5=mm
6=inch
<StackDescription> Within Speedstack these fields are set using
<DateCreated> the File — Properties option
<Author> String fields. Optional
<Company>
<Department>
<Site>

<FileVersion>
<Revision1Number>
<Revision1Modification>
<Revision1Date>
<Revision1Editor>
<Revision2Number>
<Revision2Modification>
<Revision2Date>
<Revision2Editor>

<Revision3Number>
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<Revision3Modification>
<Revision3Date>
<Revision3Editor>
<Revision4Number>
<Revision4Modification>
<Revision4Date>

<Revision4Editor>

<AssociatedDocuments>

<TopSideLabel>

<BottomSideLabel>

<Notes> Stack up notes that are set using the Stack
Up Editor tab
String field.

<BoardThickness> Target board thickness (stack up thickness

from the first to the last electrical layer) and
tolerance that are set using the Tools — Set
Board Dimensions dialog

Numeric. In specified Units

<BoardThickPosTol> Numeric. Positive tolerance percentage
<BoardThickNegTol> Numeric. Negative tolerance percentage
<HatchProfile> Hatched Plane profile section. A single set of

hatch properties can be set for a stack up; all
hatched planes within the stack have the
same set of hatch properties. See Hatch
Configuration dialog within Speedstack for
more information

<HatchPitch> Numeric. Hatch pitch

<HatchWidth> Numeric: Hatch width

<HatchSet> Boolean: True if hatch planes are used in
stack up

Stack Collection Section <StackCollection>

This section defines each material object included within the stack up, starting from the top of the stack.
The following material objects are supported: <Foil>, <Prepreg>, <Core>, <RCC>, <SolderMask>,
<ldent>, <Peelable>, <FlexCore>, <Adhesive>, <Bondply>, <Coverlay>, <Shield>

<Foil>

<FoilMaterial> Each foil will have a FoilMaterial section.
Within Speedstack these fields are set using
the material library and / or stack up material
properties option

String. Type
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<Type>

<Supplier>

<SupplierDescription>

<Description>

String. Supplier

String. Supplier Description

String. Description

<TrackMirrored>

<StockNumber> String. Stock Number

<Cost> Numeric. Cost

<LeadTime> Numeric. Lead

<Notes1> String. Single element materials

<Notes2>

<Notes3>

<Notes4>

<Notes5>

<Attributes> Used to store material attributes.
Speedstack will assign attributes in the
following format. The | (pipe) delimiter allows
for multiple attributes to be assigned to a
single material
<FieldID>=<Value> eg. INVDP=-1
String

<Copper> Each foil will have a Copper section. Within

Speedstack these fields are set using the
material library and / or stack up material
properties option. The values of these fields
will have a direct impact on the overall stack
up thickness and impedance structure
parameters.

Boolean. Used to determine whether the
trapezoidal shape of the trace is mirrored.

False: Not mirrored, trapezoidal shape
pointing towards the top of stack up

True: Mirrored, trapezoidal shape pointing
towards the bottom of stack up
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<CuRMS> Numeric. Copper Surface Roughness value.
Optional
<CuBaseThickness> Numeric. Copper Base Thickness
<CuFinishedThickness> Numeric. Copper Finished Thickness (after
plating)
<CopperCoverage> Numeric. Percentage of copper coverage
<LayerType> Numeric. Layer Type
Layer type mapping is as follows:
0=Plane
1=Signal
2=Mixed

3=No Copper — used with <Core> or
<FlexCore>for single-sided copper cores and
non-copper cores. See <Core>
<CopperPresent> section for more info

5=Hatched

<ElectricalLayer> Numeric. Incrementing number representing
the electrical layer number. Electrical layers
start from 1 at the top of the stack. Duplicate
electrical layer numbers are not supported.

<LayerName> String. Speedstack will use the automatic
layer numbers <ElectricalLayer> but this field
allows companies to also specify their own
descriptions to match existing layer naming
conventions

String. Data filename for layer. This field is

<DataFile> most commonly used to identify the CAM
data file name (gerber file name) that
contains the X Y data for the electrical layer
<Colour> RGB colour
<Prepreg>
<PrepregMaterial> Each prepreg will have a PrepregMaterial

section. Within Speedstack these fields are
set using the material library and / or stack
up material properties option

See <Foil> - <FoilMaterial> for a description
of the fields.
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<Dielectric>

<DielectricBaseThickness>

<DielectricFinishedThickness>

<DielectricConstant>

<LossTangent>

<ResinContent>

<IsolationDistance>

<Tg>

<Td>

<CAFResistance>

<ZAxisExpansion>

<ExcessResin>

<Hvalue>

<Colour>

Each prepreg will have a Dielectric section.
Within Speedstack these fields are set using
the material library and / or stack up material
properties option. The values of these fields
will have a direct impact on the overall stack
up thickness and impedance structure
parameters.

For a description of Base, Finished and
Isolation thickness please see application
note AP507.

Numeric. Base Thickness of dielectric
material

Numeric. Finished Thickness of dielectric
material

Numeric. Dielectric constant of material

Numeric. Loss tangent of material

Numeric. Optional

Numeric. Isolation Distance of dielectric
material

Numeric. Optional

Numeric. Optional

Numeric. Optional

Numeric. Optional

Numeric. Optional. This field is only required
if the Speedstack Resin Starvation DRC
check is to be used

Numeric. Internal Speedstack field, set to 0.

RGB colour
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<Core>

<CoreMaterial> Each core will have a CoreMaterial section.
Within Speedstack these fields are set using
the material library and / or stack up material
properties option

<UpperCopperNotes1> See <Foil> - <FoilMaterial> for a description

<UpperCopperNotes2> of the fields.

<UpperCopperNotes3>

<UpperCopperNotesd> String. Three element materials

<UpperCopperNotes5>

<DielectricNotes1>
<DielectricNotes2>
<DielectricNotes3>
<DielectricNotes4>

<DielectricNotes5>

<LowerCopperNotes1>

<LowerCopperNotes2>

<LowerCopperNotes3>

<LowerCopperNotes4>

<LowerCopperNotes5>

<CopperPresent> The CopperPresent section is used to
determine whether the core material being
used has copper on both, one or no sides.
These options are commonly used for single
sided copper cores and non-copper cores.

<TopCopperPresent> Boolean. True if copper on the top of the

core is present.

Boolean. True if copper on the bottom of the

<BottomCopperPresent> core is present.

<UpperCopper> The UpperCopper section describes the
copper on the upper side of the Core.

See <Foil> - <Copper> for a description of
the fields.
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<CoreDielectric>

The CoreDielectric section describes the
dielectric region of the Core.

See <Prepreg> - <Dielectric> for a
description of the fields.

<LowerCopper> The LowerCopper section describes the
copper on the lower side of the Core.
See <Foil> - <Copper> for a description of
the fields.

<RCC>

<RCCMaterial> Each Resin Coated Copper (RCC) will have
a RCCMaterial section. Within Speedstack
these fields are set using the material library

<CopperNotes1> and / or stack up material properties option

<CopperNotes2>

<CopperNotes3> See <Foil> - <FoilMaterial> for a description

<CopperNotes4> of the fields.

<CopperNotes5>

<DielectricNotes1>
<DielectricNotes2>
<DielectricNotes3>
<DielectricNotes4>

<DielectricNotes5>

String. Two element materials

<RCCCopper> The RCCCopper section describes the
copper on the RCC material
See <Foil> - <Copper> for a description of
the fields.

<RCCDielectric> The RCCDielectric section describes the

dielectric region of the RCC material

See <Prepreg> - <Dielectric> for a
description of the fields.

<SolderMask>

<SolderMaskMaterial>

Each SolderMask will have a SolderMask
Material section. Within Speedstack these
fields are set using the material library and /
or stack up material properties option

See <Foil> - <FoilMaterial> for a description
of the fields.
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<SolderMaskMask> Each SolderMask will have a
SolderMaskMask section. Within
Speedstack these fields are set using the
material library and / or stack up material
properties option. The values of these fields
will have direct impact on the impedance
structure parameters.

<MaskThickness> Numeric. Thickness of mask material
<DielectricConstant> Numeric. Dielectric constant of material
<LossTangent> Numeric. Loss tangent of material
<MaskColour> String. Optional

<DataFile> String. Data filename for layer. This field is

most commonly used to identify the CAM
data file name (gerber file name) that
contains the X 'Y data for the solder mask
layer

<Colour> RGB colour

<ldent>

<ldentMaterial> Each Ident will have an IdentMaterial section.
Within Speedstack these fields are set using

the material library and / or stack up material

properties option

See <Foil> - <FoilMaterial> for a description
of the fields.

<ldentink> Each Ident will have an IdentInk section.
Within Speedstack these fields are set using
the material library and / or stack up material
properties option.

<InkThickness> Numeric. Thickness of ink

<InkColour> String. Optional

<DataFile> String. Data filename for layer. This field is
most commonly used to identify the CAM
data file name (gerber file name) that
contains the XY data for the ident layer

<Colour> RGB colour
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<Peelable>

<PeelableMaterial>

Each Peelable will have a PeelableMaterial
section. Within Speedstack these fields are
set using the material library and / or stack

up material properties option

See <Foil> - <FoilMaterial> for a description
of the fields.

<PeelableMask>

<InkThickness>

Each Peelable will have a PeelableMask
section. Within Speedstack these fields are
set using the material library and / or stack
up material properties option.

Numeric. Thickness of ink

<InkColour> String. Optional
<DataFile> String. Data filename for layer. This field is
most commonly used to identify the CAM
data file name (gerber file name) that
contains the X Y data for the peelable layer
<Colour> RGB colour
<FlexCore>

<FlexCoreMaterial>

<UpperCopperNotes1>
<UpperCopperNotes2>
<UpperCopperNotes3>
<UpperCopperNotes4>
<UpperCopperNotes5>

<DielectricNotes1>
<DielectricNotes2>
<DielectricNotes3>
<DielectricNotes4>

<DielectricNotes5>

<LowerCopperNotes1>
<LowerCopperNotes2>
<LowerCopperNotes3>
<LowerCopperNotes4>

<LowerCopperNotes5>

Each flexcore will have a FlexCoreMaterial
section. Within Speedstack these fields are
set using the material library and / or stack
up material properties option

See <Foil> - <FoilMaterial> for a description
of the fields.

String. Three element materials
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<CopperPresent> The CopperPresent section is used to
determine whether the core material being
used has copper on both, one or no sides.
These options are commonly used for single
sided copper cores and non-copper cores.

<TopCopperPresent> Boolean. True if copper on the top of the
core is present.

Boolean. True if copper on the bottom of the

<BottomCopperPresent> X
core is present.

<UpperCopper> The UpperCopper section describes the
copper on the upper side of the Core.

See <Foil> - <Copper> for a description of
the fields.

<CoreDielectric> The CoreDielectric section describes the
dielectric region of the Core.

See <Prepreg> - <Dielectric> for a
description of the fields.

<LowerCopper> The LowerCopper section describes the
copper on the lower side of the Core.

See <Foil> - <Copper> for a description of
the fields.

<Adhesive>

<AdhesiveMaterial> Each Adhesive will have a AdhesiveMaterial
section. Within Speedstack these fields are
set using the material library and / or stack
up material properties option

See <Foil> - <FoilMaterial> for a description
of the fields.

<Dielectric> The Dielectric section describes the dielectric
region of the Adhesive.

See <Prepreg> - <Dielectric> for a
description of the fields.
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<Bondply>

<BondplyMaterial>

Each Bondply will have a BondplyMaterial
section. Within Speedstack these fields are
set using the material library and / or stack
up material properties option

See <Foil> - <FoilMaterial> for a description
of the fields.

<Dielectric>

The Dielectric section describes the dielectric
region of the Bondply.

See <Prepreg> - <Dielectric> for a
description of the fields.

<Coverlay>

<CoverlayMaterial>

Each Coverlay will have a Coverlay Material
section. Within Speedstack these fields are
set using the material library and / or stack
up material properties option

See <Foil> - <FoilMaterial> for a description
of the fields.

<CoverlayFilm>

<DielectricBaseThickness>

<DielectricFinishedThickness>

<DielectricConstant>

<LossTangent>

<Colour>

Each Coverlay will have a CoverlayFilm
section. Within Speedstack these fields are
set using the material library and / or stack
up material properties option. The values of
these fields will have direct impact on the
impedance structure parameters.

Numeric. Base Thickness of dielectric
material

Numeric. Finished Thickness of dielectric
material

Numeric. Dielectric constant of material

Numeric. Loss tangent of material

RGB colour
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<Shield>

<ShieldMaterial> Each Shield will have a ShieldMaterial
section. Within Speedstack these fields are
set using the material library and / or stack

<CopperNotes1> up material properties option

<CopperNotes2>

<CopperNotes3> See <Foil> - <FoilMaterial> for a description

<CopperNotesd> of the fields.

<CopperNotes5>

String. Two element materials

<DielectricNotes1>
<DielectricNotes2>
<DielectricNotes3>
<DielectricNotes4>

<DielectricNotes5>

<ShieldCopper> The ShieldCopper section describes the
copper / metal of the Shield material

See <Foil> - <Copper> for a description of
the fields.

<ShieldDielectric> The ShieldDielectric section describes the
dielectric region of the Shield material

See <Prepreg> - <Dielectric> for a
description of the fields.

Drill Collection Section <DrillCollection>

This section defines each drill object included within the stack up and there is a separate drill object for
each drill operation within the stack up. The presence of a drill object affects the Copper Finishing
functionality of Speedstack, and determines which electrical layers have additional copper added to the
base copper thickness to allow for the electroplating fabrication process.

<Drill> A drill object defines each separate drill
operation.
<FirstElectricalLayer> Numeric. First electrical layer for the drill. It

is important to correctly define the first /
second electrical layers as this determines
the direction / shape of laser drills. For laser
drills the first electrical layer represents the
entry layer and therefore has the widest
dimension.

<SecondElectricalLayer> Numeric. Second electrical layer for the drill.
Not used with Back Drills
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<MechanicalDrill>

<LaserDrill>
<BackDrrill>

<ThroughPlated>

<FirstElectricalLayerCapped>

<SecondElectricalLayerCapped>

<DrillSpec>

<DataFile>

<HoleCount>
<DifferentHoleSizes>

<MinimumHoleSize>

<TraceColumn>

Boolean. True represents mechanical drill.
Used in conjunction with LaserDrill and
BackDrrill i.e. Only one of MechanicalDrill or
LaserDrill or BackDrill should be true
Boolean. True represents laser drill.
Boolean. True represents back drill.
Boolean. True denotes that drill is through
plated. Please note, when <BackDrill> is
True <ThroughPlated> must be False

Boolean. True denotes first electrical layer is
capped

Boolean. True denotes second electrical
layer is capped

Mechanical supports first and / or second
layer capped.

Laser supports first layer capped only.
Back Drill supports first layer capped only.

Numeric bitmask (binary). This is the drill
description as an integer

512 = Back Dirrill
256 = Laser
128 = Plated

64 = Copper paste
32 = Sintering paste
16 Conductive
Non-conductive
= Solder mask fill
= Resin fill

= Copper fill

= Mechanical

O =N~

E.g. for a Copper filled plated laser via = 385

String. Data filename for drill. This field is
most commonly used to identify the CAM
data file name (drill file name) that contains
the X 'Y data for the drill operation.

Numeric. Optional.
Numeric. Optional.

Numeric. Optional. Smallest drill diameter for
drill operation. Necessary if Speedstack
DRC — Aspect Ratio checks are required

Numeric. 0 based index as to where the drill
operation will be positioned on the stack up
graphic.

0 — left most column

10 — right most column
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Consideration must be given so that
Mechanical and Laser drill operations do not
overlap within the same trace column. Back
Drills may overlap Mechanical drills

<MinimumPadSize> Numeric. Optional.

<MinimumDrillSize> Numeric. Optional.
<MinimumDrillSizeTolerance> Numeric. Optional. Absolute tolerance
<MinimumBarrelWallThickness> Numeric. Optional.
<BackDrillMustCutLayer> Numeric. The electrical layer of the stack up

that has to be cut (drilled through). This
property must is used in conjunction with
FirstElectricalLayer and
BackDrillMustNotCutLayer to define the
direction and stopping layer of the Back Dirrill.
Only used with Back Drills

<BackDrillMustNotCutLayer> Numeric. The electrical layer of the stack up
that must not be cut. Only used with Back
Drills
<BackDrillMinimumDistanceFromCutLayer> Numeric. Optional.
<BackDrillMaximumDistanceFromCutLayer> | Numeric. Optional.

<BackDrillPrimaryDrillSize> Numeric. Optional.

<BackDrillMinimumDistanceFromNotCutLaye | Numeric. Optional.
r>

<BackDrillMaximumDistanceFromNotCutLay | Numeric. Optional.

er>
Numeric. Back Drill Type
Back Drill Type mapping is as follows:
<BackDrillType> Numeric. Back Drill Type
Back Drill Type mapping is as follows:
0=Pointed
1=Flat
2=Router
<Note1> String
<Note2> String
<Note3> String
<Note4> String
<Note5> String

Impedance Structure Collection Section <StructureCollection>

This section defines each impedance structure included within the stack up. Structures must be placed
appropriately within the stack up. Please use the guidance notes below.
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<Structure>

<StructureName>

<StructureNumber>

<UpperSignalLayer>

<LowerSignalLayer>

<UpperPlane>

<LowerPlane>

<H1>

<Er1>

<H2>

<Er2>

<H3>

A structure object defines each separate
impedance structure.

String. A valid impedance structure name
must be provided. See guidance notes below

Number. A valid impedance structure name
must be provided. See guidance notes below

Numeric. Electrical layer number to which
impedance signal is assigned, the <Copper>
<ElectricalLayer>. The <Copper>
<LayerType> must be set to Signal or Mixed.

Numeric. For Differential Broadside
structures this is the second electrical layer
number. The <Copper> < LayerType> must
be set to Signal or Mixed

Numeric. First reference plane electrical layer
number, the <Copper> <ElectricalLayer>.
The <Copper> < LayerType> must be set to
Plane, Mixed or Hatched.

Numeric. Second reference plane electrical
layer number, the <Copper>
<ElectricalLayer>. The <Copper>
<LayerType> must be set to Plane, Mixed or
Hatched.

When an impedance structure only has a
single reference plane (microstrip structures)
it is only necessary to specify the
UpperPlane.

Impedance structures with two reference
planes (stripline structures) must have both
the UpperPlane and LowerPlane specified

Numeric. Substrate 1 height

Numeric. Substrate 1 dielectric constant

Numeric. Substrate 2 height

Numeric. Substrate 2 dielectric constant

Numeric. Substrate 3 height
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<Er3> Numeric. Substrate 3 dielectric constant
<H4> Numeric. Substrate 4 height
<Er4> Numeric. Substrate 4 dielectric constant
<W1> Numeric. Lower trace width
<w2> Numeric. Upper trace width

W1 and W2 allows for a trapezoidal trace
shape to be defined. If the trace shape is
rectangular set W1 and W2 to the same
dimension

<S1> Numeric. Trace separation, for differential
structures only

<O1> Numeric. Trace offset, for broadside
structures only

<G1> Numeric. Lower ground strip width, for
coplanar ground strip structures only

<G2> Numeric. Upper ground strip width, for
coplanar ground strip structures only
G1 and G2 allows for a trapezoidal ground
strip shape to be defined. If the ground strip
is rectangular set G1 and G2 to the same
dimension

<D1> Numeric. Ground strip separation, for
coplanar structures only

<T1>
Numeric. Trace thickness

<REr> Numeric value for the Dielectric (REr) for
resin rich area structures only.

<C1>
Numeric. Coating above substrate

<C2>
Numeric. Coating above trace

<C3> Numeric. Coating between traces for

differential structures only
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<CEr>

<Impedance>

<Targetlmpedance>

<Tolerance>

<Note1>

<Note2>

<Note3>

<Note4>

<Noteb5>

<NetClass1>

<NetClass2>

<NetClass3>

<NetClass4>

<NetClass5>

Frequency Dependent Properties

<FD_LengthOfLine>

<FD_TraceConductivity>

Numeric. Coating dielectric constant

Numeric. Calculated impedance result in
ohms. Generated by Speedstack, so export
processor should leave this value at 0

Numeric. Structure target impedance value
in ohms

Numeric. Impedance + / - tolerance as a
percentage

String

String

String

String

String

String

String

String

String

String

Numeric. Length of transmission line in
current units

Numeric. Trace Conductivity in Siemens per
metre (S/m)
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Speedstack calculates insertion loss over a
frequency range. All frequency parameters
are in Hz

<FD_FrequencyMin>

<FD_FrequencyMax>

<FD_FrequencySteps>

<FD_FrequencyOfinterest>

<FD_ResultPresentation>

Extended Substrate Data causal
extrapolation reference points. See page 96
of the Speedstack manual for further info. All
XML elements are included regardless of
structure type, only substrates used by the
structure will impact on the calculation result

<FD_ESD_SetRefPointsFromStackup_Er>

<FD_ESD_SetRefPointsFromStackup_TanD
>

<FD_ESD_ H1RefFreg>

<FD_ESD_H1RefEr>

<FD_ESD_H1RefTanD>

<FD_ESD_H2RefFreqg>

<FD_ESD_H2RefEr>

Numeric. Hz

Numeric. Hz

Numeric integer. Number of frequency data
points to be calculated between Min and Max

Numeric. Hz

Numeric. Result presentation of frequency
dependent calculation. The mapping is as
follows:

O=per length of line (/LL)
1=per inch (/in)

2=per metre (/m)

Boolean. Controls the ‘Set Dielectric
Constant (Er) values from Stack Up
materials’ checkbox. Setting this value to
True auto-populates the Ref Er column,
False allows the user to key in the value(s)

Boolean. Controls the ‘Set Loss Tangent
(TanD) values from Stack Up materials’
checkbox. Setting this value to True auto-
populates the Ref TanD column, False allows
the user to key in the value(s)

Numeric. Hz

Numeric. Dielectric constant

Numeric. Loss tangent

Numeric. Hz

Numeric. Dielectric constant
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<FD_ESD_H2RefTanD>

<FD_ESD_H3RefFreqg>

<FD_ESD_H3RefEr>

<FD_ESD_H3RefTanD>

<FD_ESD_H4RefFreqg>

<FD_ESD_H4RefEr>

<FD_ESD_H4RefTanD>

<FD_ESD_RErRefFreqg>

<FD_ESD_RErRefEr>

<FD_ESD_RErRefTanD>

<FD_ESD_CErRefFreqg>

<FD_ESD_CErRefEr>

<FD_ESD_CErRefTanD>

Surface Roughness Compensation. See
pages 96 — 98 of the Speedstack manual for
further info. All XML elements are included
regardless of structure type, only roughness
surfaces used by the structure will impact on
the calculation result

<FD_SRC_Model>

<FD_SRC_RMS_R1>

Numeric. Loss tangent

Numeric. Hz

Numeric. Dielectric constant

Numeric. Loss tangent

Numeric. Hz

Numeric. Dielectric constant

Numeric. Loss tangent

Numeric. Hz

Numeric. Dielectric constant

Numeric. Loss tangent

Numeric. Hz

Numeric. Dielectric constant

Numeric. Loss tangent

Numeric. The mapping is as follows:
0=Smooth

1=Hammerstad

2=Groisse

3=Huray

5=Gradient

Numeric. Surface 1 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model
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<FD_SRC_RMS_R2>

<FD_SRC_RMS_R3>

<FD_SRC_RMS_R4>

<FD_SRC_RMS_R5>

<FD_SRC_RMS_R6>

<FD_SRC_Huray_RatioOfAreas>

<FD_SRC_Huray_EffectiveBallRadius>

<FD_SRC_Huray_NumberOfBallsinArea>

<FD_SRC_Huray_AreaOfBallCount>

<FD_SRC_Huray_EnableCannonballHuray>

<FD_SRC_Huray_RzMatte>

<FD_SRC_Huray_RzDrum>

<FD_IncludeOnReport>

<FD_LossBudget>

Numeric. Surface 2 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model

Numeric. Surface 3 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model

Numeric. Surface 4 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model

Numeric. Surface 5 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model

Numeric. Surface 6 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model

Numeric.

Numeric. Must be in microns (um)

Numeric.

Numeric. Area must be square microns (sq
Hm)

Boolean. Determines whether Cannonball-
Huray mode is enabled

Numeric. Must be in microns (um)

Numeric. Must be in microns (um)

Boolean. Controls the ‘Include Loss Graph
for this structure on the report’ checkbox.
Setting this value to True allows the user to
nominate which structures will contain a
separate loss graph page

Numeric. As shown on the All Losses plot
(dB)
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Impedance Structure Guidance
Impedance structures must be placed appropriately on the defined stack up.

When specifying <UpperSignalLayer> and <LowerSignalLayer> they must be placed on electrical layers
who'’s <LayerType> is defined as “signal” or “mixed”.

When specifying <UpperPlane> and <LowerPlane> they must be placed on electrical layers who’s
<LayerType> is defined as “plane” or “mixed”.

Often impedance structures do not require all parameters. Unused parameters fields should be set to 0.

The impedance calculation engine supplied with Speedstack contains 108 transmission line structures.
Explaining every structure is beyond the scope of this document, but details of the most commonly used
impedance structures are given below. Please contact polarcare@polarinstruments.com if you require
information on other structures

Surface Microstrip Structures

Name: Surface Microstrip 1B

Type: Single Ended Surface Microstrip 1B

Usage: Used on outer layers of a stackup
when no solder mask is present

Name: Edge Coupled Surface Microstrip 1B

Type: Differential Edge-Coupled Surface Microstrip 1B

Usage: Used on outer layers of a stackup
when no solder mask is present
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Coated Microstrip Structures

Name: Coated Microstrip 1B

Type: Single Ended Coated Microstrip 1B

Usage: Used on outer layers of a stackup
when solder mask is present

Name: Edge Coupled Coated Microstrip 1B

Type: Differential Edge-Coupled Coated Microstrip 1B

Usage: Used on outer layers of a stackup
when solder mask is present

Embedded Microstrip Structures

Name: Embedded Microstrip 1B1A

Type: Single Ended Embedded Microstrip 1B1A

Usage: Used on inner layers of a stackup
when no reference plane exists between the
impedance signal layer and the surface
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Name: Edge Coupled Embedded Microstrip
1B1A

Type: Differential

Usage: Used on inner layers of a stackup
when no reference plane exists between the
impedance signal layer and the surface

Edge-Coupled Embedded Microstrip 1B1A

Offset Stripline Structures

Name: Offset Stripline 1B1A

Type: Single Ended

Usage: Used on inner layers of a stackup
when a reference plane exists above and
below the impedance signal layer

Offset Stripline 1B1A

Name: Edge Coupled Offset Stripline 1B1A

Type: Differential

Usage: Used on inner layers of a stackup
when a reference plane exists above and
below the impedance signal layer

Edge-Coupled Offset Stripline 1B1A
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Speedstack Stackup XML Information (.SSX) v15.00

Document Date: 28" August 2024 — Draft 1

General Notes

The Speedstack XML format is divided into two main sections: the header section and the sub-stack
section(s).

The header describes details about the stack up construction, the units used for each of the sub-stacks
defined and number of sub-stacks etc.

The sub-stack sections describes a Stack Collection detailing the materials used, Drill Collection
describing the drills that exist on that sub-stack and a Structure Collection that includes the controlled
impedance structures that exist on that sub-stack.

The number of sub-stack sections included in the XML file will match the number of sub-stacks in the
construction; for a traditional rigid stack up a single sub-stack will be defined but for a complex rigid-flex
construction each cross-section will be described as a separate sub-stack.

Unused String fields should be set to a null string. Unused Numeric fields should be set to 0.

Header Section

<Version> This field defines the actual version of the
Speedstack Stack Up XML file. The Stack
Up XML file format may change in the future
as we introduce new features, so this field
can be used to verify whether an import /
export processors will support a particular
XML format.

Numeric field. 15.00 is the version number
described in this document.

<Units> Units used throughout the XML file.

Numeric field

The mapping is as follows:
3=microns

4=mils

5=mm

6=inch

<NumberOfSubStacks> The number of sub-stacks contained within
the XML file, this value should match the
number of <SubStack> sections.

A single rigid stack up would have a value of
1 whereas a rigid-flex construction contains
five separate sub-stack cross sections would
have a value of 5.

Numeric field
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<SubStackDisplayOrder>

Each <SubStack> has a unique zero-based
<Index> to identify the order in which it was
created. Speedstack allows the user to
display the sub-stacks in any order and the
<SubStackDisplayOrder> collection
describes this display order. The <Index>
entries within this collection describe the
rigid-flex construction from left to right. The
number of <Index> elements must match the
number of sub-stacks described by
<NumberOfSubStacks>

<FileProperties>

<DescriptiveStackName>
<StackTopSidelLabel>
<StackBottomSideLabel>
<DateCreated>
<Version>
<Revision1Number>
<Revision1Modification>
<Revision1Date>
<Revision1Editor>
<Revision2Number>
<Revision2Modification>
<Revision2Date>
<Revision2Editor>
<Revision3Number>
<Revision3Modification>
<Revision3Date>
<Revision3Editor>
<Revision4Number>
<Revision4Modification>
<Revision4Date>
<Revision4Editor>
<Author>

<Company>
<Department>

<Site>

<AssociatedDocuments>

Within Speedstack these field are set using
the File — Properties options

String fields
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SubStack Section <SubStack>

<Index> Unique zero-based <Index> to identify the
order in which the sub-stack was created.

Numeric field

<Name> Name allocated to the sub-stack from the
Speedstack Navigator.

The name does not have to be unique as the
<Index> is used as the sub-stack identifier.

String field

<FullName> Within Speedstack the full name of the sub-
stack is <DescriptiveStackName> & “/” &
<Name>

String field

<Notes> Stack up notes that are set using the Stack Up
Editor tab

String field

<ElectricalLayerCount> Number of electrical layers enabled within the
sub-stack

Numeric field

<CopperThickness> The thickness of all the enabled copper layers
in the sub-stack (foil, cores, flex core, rcc)

Numeric field

<DielectricThickness> The thickness of all the enabled dielectric
layers in the sub stack (prepreg, core,
adhesive etc)

Numeric field

<SolderMaskThickness> The thickness of the enabled top and / or
bottom soldermask

Numeric field

<TargetStackUpThickness> Each sub-stack can have a separate target
thickness as entered by the user

Numeric field

<TargetStackUpThicknessPosTolPercentage> | Positive tolerance percentage entered by user

Numeric field
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<TargetStackUpThicknessNegTolPercentage>

Negative tolerance percentage entered by
user.

Numeric field

Speedstack uses the
<TargetStackUpThickness>,
<TargetStackUpThicknessPosTolPercentage>
and the
<TargetStackUpThicknessNegTolPercentage>
to warn the user whilst they are editing the
stack when <StackUpThickness> exceeds
the target

<StackUpThickness>

= <CopperThickness> +
<DielectricThickness>

Numeric field

<StackUpThicknessWithSolderMask>

= <CopperThickness> +
<DielectricThickness> +
<SolderMaskThickness>

Numeric field

<MiniStacksPresent>

This element determines how impedance
structures are managed within the sub-stack.
Within Speedstack it is possible to enable non-
consecutive electrical layers, for instance on
an eight layer stack up just L2 /L3 and L6/ L7
cores are enabled. When an impedance
structure is added to L3 it is necessary for the
user to nominate how structures will be
managed, will L2 / L3 be a separate mini stack
up for impedance calculations than L6 / L7?

Numeric field

The mapping is as follows:
0=no impedance structures exist on sub stack

1=all enabled sub stack materials are treated
as one contiguous stack up

2=the enabled layers are treated as if an air
gap exists between them

3=consecutive enabled electrical layer
material groups are treated as separate mini
stack ups

<HatchProfile>

Hatched Plane profile section. A single set of
hatch properties can be set for a sub-stack; all
hatched planes within the sub-stack have the
same set of hatch properties. See Hatch
Configuration dialog within Speedstack for
more information
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<HatchSet> Boolean: True if hatch planes are used in the
sub-stack

<HatchPitch> Numeric. Hatch pitch

<HatchWidth> Numeric: Hatch width

Sub-stack Stack Collection Section <SubStack> <StackCollection>

This section defines each material object included within the sub-stack, starting from the
top of the stack. The following higher level material objects are supported: <Foil>,
<Core>, <RCC>, <Prepreg>, <SolderMask>, <FlexCore>, <Adhesive>, <Bondply>,
<Coverlay>, <ldent>, <Peelable>, <Shield>. Each <SubStack> <StackCollection> has
an identical set of materials, the materials that are actually used in a <SubStack> will
have the <EnableMaterial> element set to True, unused materials are set to False.

Lower level material objects

The higher level materials objects (<Foil>, <Core>, <RCC>, <Prepreg> etc) make use of these lower level
materials objects. The following section describes each of these objects.

<EnableMaterial>

Used by all higher level material objects.

<EnableMaterial> Set to True if material is used within the
<SubStack>

Boolean

<Generallnformation>

Used by all higher level material objects.

<Generallnformation> A series of descriptive fields used to describe
the material, accessible within Speedstack by
the material properties options

<Supplier> String
<SupplierDescription> String
<Description> String
<StockNumber> String
<Type> String
<Cost> Numeric
<LeadTime> Numeric

<Notes>, <UpperCopperNotes>, <DielectricNotes>, <LowerCopperNotes>

Used by all higher level material objects.

<Notes>, <UpperCopperNotes>, User-definable notes fields
<DielectricNotes> or <LowerCopperNotes>

<Note1> String
<Note2>
<Note3>
<Note4>

<Note5>
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<Attributes>

Used by all higher level material objects.

<Attributes> Used to store material attributes.

Speedstack will assign attributes in the
following format. The | (pipe) delimiter allows
for multiple attributes to be assigned to a
single material
<FieldID>=<Value> eg. INVDP=-1
String

<Copper>

<Foil>, <Core>, <RCC>, <FlexCore> and <Shield> all contain one or more copper definitions

<Copper>

<BaseThickness>

<FinishedThickness>

<CopperCoverage>

<LayerName>

<DataFilename>

<Tracelnverted>

Copper section. Within Speedstack these
fields are set using the material library and /
or stack up material properties option. The
values of these fields will have a direct
impact on the overall stack up thickness and
impedance structure parameters.

Numeric. Copper Base Thickness

Numeric. Copper Finished Thickness (after
plating)

Numeric. Percentage of copper coverage

String. Speedstack will use the automatic
layer numbers <ElectricalLayer> but this field
allows companies to also specify their own
descriptions to match existing layer naming
conventions

String. Data filename for layer. This field is
most commonly used to identify the CAM
data file name (gerber file name) that
contains the X 'Y data for the electrical layer

Boolean. Used to determine whether the
trapezoidal shape of the trace is mirrored.

False: Not mirrored, trapezoidal shape
pointing towards the top of stack up

True: Mirrored, trapezoidal shape pointing
towards the bottom of stack up
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<LayerType> Numeric. Layer Type

Layer type mapping is as follows:
0=Plane

1=Signal

2=Mixed

3=No Copper — used with <Core> or
<FlexCore>for single-sided copper cores and
non-copper cores. See <Core>
<CopperPresent> section for more info

5=Hatched

<ElectricalLayer> Numeric. Incrementing number representing
the electrical layer number. Electrical layers
start from 1 at the top of the stack. Duplicate
electrical layer numbers are not supported.

<Colour> RGB colour

<Dielectric>

<Core>, <RCC>, <Prepreg>, <FlexCore>, <Adhesive>, <Bondply> and <Shield> all contain one
dielectric definition.

<Dielectric> Dielectric section. Within Speedstack these
fields are set using the material library and /
or stack up material properties option. The
values of these fields will have a direct
impact on the overall stack up thickness and
impedance structure parameters.

For a description of Base, Finished and
Isolation thickness please see application
note AP507.

Numeric. Base Thickness of dielectric

< i > i
BaseThickness material

<FinishedThickness> Numeric. Finished Thickness of dielectric
material

<DielectricConstant> Numeric. Dielectric constant of material

<LossTangent> Numeric. Loss tangent of material

<ResinContentPercentage> Numeric. Resin content and as percentage

<Tg> Numeric. Transition temperature

<Td> Numeric. Decomposition temperature
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<CAFResistance>
<ZAxisExpansion>

<lIsolationDistance>

<ExcessResin>

<Colour>

Numeric.
Numeric.

Numeric. Isolation Distance of dielectric
material

Numeric. This field is only required if the
Speedstack Resin Starvation DRC check is
to be used. See application note AP509

RGB colour

<Mask>

<SolderMask> contains one definition.

<Mask>

<Thickness>

<DielectricConstant>

<LossTangent>

<MaskColour>

<DataFilename>

<Colour>

Mask section. Within Speedstack these
fields are set using the material library and /
or stack up material properties option. The
values of these fields will have a direct
impact on the overall stack up thickness and
impedance structure parameters.

Numeric. Thickness of mask material

Numeric. Dielectric constant of material

Numeric. Loss tangent of material

String. Text description of mask colour

String. Data filename for layer. This field is
most commonly used to identify the CAM
data file name (gerber file name) that
contains the X Y data for the electrical layer

RGB colour

<CoverlayFilm>

<Coverlay> contains one definition.

<CoverlayFilm>

<BaseThickness>

<FinishedThickness>

CoverlayFilm section. Within Speedstack
these fields are set using the material library
and / or stack up material properties option.
The values of these fields will have a direct
impact on the overall stack up thickness and
impedance structure parameters.

Numeric. Base Thickness of film material

Numeric. Finished Thickness of film material
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<DielectricConstant>

Numeric. Dielectric constant of material

<LossTangent> Numeric. Loss tangent of material
<Colour> RGB colour
<ldentink>

<ldent> contains one definition.

<ldentink>

<Thickness>

<InkColour>

<DataFilename>

<Colour>

Ink section. Within Speedstack these fields
are set using the material library and / or
stack up material properties option.

Numeric. Thickness of ink

String. Text description of ink colour
String. Data filename for layer. This field is
most commonly used to identify the CAM
data file name (gerber file name) that

contains the X Y data for the electrical layer

RGB colour

<PeelableMask>

<Peelable> contains one definition.

<PeelableMask>

<Thickness>

<InkColour>

<DataFilename>

<Colour>

PeelableMask section. Within Speedstack
these fields are set using the material library
and / or stack up material properties option.

Numeric. Thickness of peelable ink mask
material

String. Text description of peelable ink mask
colour

String. Data filename for layer. This field is
most commonly used to identify the CAM
data file name (gerber file name) that
contains the X Y data for the electrical layer

RGB colour
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Higher level material objects

The higher level materials make extensive use of the lower level materials objects. The following section
describes each higher level material and which objects it uses.

<Foil>

<EnableMaterial> See definitions above

<Generallnformation>

<Copper>

<Notes>

<Attributes>

<Core>

<EnableMaterial> See definitions above

<Generallnformation>

<CopperPresent> The CopperPresent section is used to
determine whether the core material being
used has copper on both, one or no sides.
These options are commonly used for single
sided copper cores and non-copper cores.

<UpperCopperPresent> Boolean. True if copper on the upper surface
of the core is present.

Boolean. True if copper on the lower surface

<BottomCopperPresent> |
of the core is present.

Upper surface copper — see <Copper>

< >
UpperCopper definition above
<Dielectric>
Lower surface copper — see <Copper>
<LowerCopper> definition above
<UpperCopperNotes>
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<DielectricNotes>

<LowerCopperNotes>

<Attributes>

<RCC>
<EnableMaterial> See definitions above

<Generallnformation>

<Copper> In the case of <RCC> the <Copper>

<Tracelnverted> Boolean element
determines whether the copper is positioned
above or below the dielectric. Above = False,
Below = True

<Dielectric>

<CopperNotes>

<DielectricNotes>

<Attributes>

<Prepreg>

<EnableMaterial> See definitions above

<Generallnformation>

<Dielectric>

<Notes>

<Attributes>
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<SolderMask>

<EnableMaterial>

<Generallnformation>

<Mask>

<Notes>

<Attributes>

See definitions above

<FlexCore>

This material is similar to <Core>

<EnableMaterial>

<Generallnformation>

<CopperPresent>

<UpperCopperPresent>

<BottomCopperPresent>

<UpperCopper>

<Dielectric>

<LowerCopper>

<UpperCopperNotes>

<DielectricNotes>

<LowerCopperNotes>

<Attributes>

See definitions above

The CopperPresent section is used to
determine whether the core material being
used has copper on both, one or no sides.
These options are commonly used for single
sided copper cores and non-copper cores.

Boolean. True if copper on the upper surface
of the core is present.

Boolean. True if copper on the lower surface
of the core is present.

Upper surface copper — see <Copper>
definition above

Lower surface copper — see <Copper>
definition above
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<EnableMaterial>

<Generallnformation>

<Dielectric>

<Notes>

<Attributes>

See definitions above

<Adhesive>

<EnableMaterial>

<Generallnformation>

<Dielectric>

<Notes>

<Attributes>

See definitions above

<Coverlay>

<EnableMaterial>

<Generallnformation>

<CoverlayFilm>

<Notes>

<Attributes>

See definitions above

<ldent>

<EnableMaterial>

<Generallnformation>

<ldentink>

<Notes>
<Attributes>

See definitions above
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<Peelable>

<EnableMaterial>

<Generallnformation>

<PeelableMask>

<Notes>

<Attributes>

See definitions above

<Shield>

<EnableMaterial>

<Generallnformation>

<Copper>

<Dielectric>

<CopperNotes>

<DielectricNotes>

<Attributes>

See definitions above

In the case of <Shield> the <Copper>

<Tracelnverted> Boolean element
determines whether the copper is positioned
above or below the dielectric. Above = False,
Below = True

Sub-stack Drill Collection Section <SubStack> <DrillCollection>

This section defines each drill object included within the sub-stack, there is a separate drill object for each
drill operation within the stack up. The presence of a drill object affects the Copper Finishing functionality
of Speedstack, and determines which electrical layers have additional copper added to the base copper
thickness to allow for the electroplating fabrication process. Each <SubStack> <DrillCollection> contains
drill objects that only belong to the sub-stack.

<Drill>

<Column>

A drill object defines each separate drill
operation.

Numeric. Zero-based index as to where
the drill operation will be positioned on the
stack up graphic.

0 — left most column

10 - right most column
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Consideration must be given so that drill
operations do not overlap within the same
trace column.

<FirstElectricalLayer> Numeric. First electrical layer for the drill.
It is important to correctly define the first /
second electrical layers as this determines
the direction / shape of laser drills. For
laser drills the first electrical layer
represents the entry layer and therefore
has the widest dimension. The first and
second electrical layers must be on
materials whose <EnableMaterial> is true

<SecondElectricalLayer> Numeric. Second electrical layer for the
drill

Not used with Back Dirills

<Mechanical> . .
Boolean. True represents mechanical drill.

Used in conjunction with LaserDrrill and
BackDrill i.e. Only one of MechanicalDrill
or LaserDrill or BackDrill should be true

<Laser>

Boolean. True represents laser drill.
<BackDrill>

Boolean. True represents back drill.
<ThroughPlated>

Boolean. True denotes that drill is through
plated. Please note, when <BackDrill> is
True <ThroughPlated> must be False

<FirstElectricalLayerCapped>

Boolean. True denotes first electrical layer
is capped

<SecondElectricalLayerCapped>
Boolean. True denotes second electrical

layer is capped

Mechanical supports first and / or second
layer capped.

Laser supports first layer capped only.

Back Drill supports first layer capped only.

<DrillSpec> Lo . . .
Numeric bitmask (binary). This is the drill

description as an integer

512 = Back Dirill
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<DataFilename>

<HoleCount>

<DifferentHoleSizes>

<MinimumHoleSize>

<MinimumPadSize>

<MinimumDirillSize>

<MinimumDirillSizeTolerance>

<MinimumBarrelWallThickness>

<BackDrillMustCutLayer>

<BackDrillMustNotCutLayer>

256 = Laser

128 = Plated

64 = Copper paste
32 = Sintering paste

16 = Conductive

8 = Non-conductive
4 = Solder mask fill
2 =Resinfill

1 = Copper fill

0 = Mechanical

E.g. for a Copper filled plated laser via =
385

String. Data filename for drill. This field is
most commonly used to identify the CAM
data file name (drill file name) that
contains the XY data for the drill
operation.

Numeric.

Numeric.

Numeric. Smallest drill diameter for drill
operation. Necessary if Speedstack DRC
— Aspect Ratio checks are required

Numeric. Optional.

Numeric. Optional.

Numeric. Optional. Absolute tolerance

Numeric. Optional.

Numeric. The electrical layer of the stack
up that has to be cut (drilled through). This
property must is used in conjunction with
FirstElectricalLayer and
BackDrillMustNotCutLayer to define the
direction and stopping layer of the Back
Drrill.

Only used with Back Drills Numeric. The
electrical layer of the stack up that must
not be cut. Only used with Back Drills
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<BackDrillMinimumDistanceFromCutLayer> Numeric. Optional.
<BackDrillMaximumDistanceFromCutLayer> Numeric. Optional.
<BackDirillPrimaryDrillSize> Numeric. Optional.

<BackDrillMinimumDistanceFromNotCutLayer> | Numeric. Optional.

<BackDrillMaximumDistanceFromNotCutLayer> | Numeric. Optional.

<BackDrillType> Numeric. Back Drill Type
Back Drill Type mapping is as follows:
0=Pointed
1=Flat
2=Router

<Notes> User-definable notes fields

<Note1> String

<Note2> String

<Note3> String

<Note4> String

<Noteb5> String
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Impedance Structure Collection Section <SubStack> <StructureCollection>
This section defines each impedance structure included within the sub-stack.

Structures must be placed appropriately within the sub-stack, the <UpperSignalLayer>,
<LowerSignalLayer>, <UpperPlaneLayer> and <LowerPlaneLayer> must be on materials whose
<EnableMaterial> is true. Each <SubStack> <StructureCollection> contains structure objects that only
belong to the sub-stack.

Different impedance structure types are identified by the <Name> and <Number> and will have a varying
number of used parameters depending on the structure complexity. The <Structure> object contains all
possible parameters, the parameters that are unused for a given structure should be set to 0.

Please use the guidance notes below.

<Structure> A structure object defines each separate
impedance structure.

<Name> String. A valid impedance structure name

must be provided. See guidance notes below

<Number> Number. A valid impedance structure name
must be provided. See guidance notes below

<UpperSignalLayer> Numeric. Electrical layer number to which
impedance signal is assigned, the <Copper>
<ElectricalLayer>. The <Copper>
<LayerType> must be set to Signal or Mixed.

<LowerSignalLayer> Numeric. For Differential Broadside
structures this is the second electrical layer
number. The <Copper> < LayerType> must
be set to Signal or Mixed

<UpperPlanelLayer> Numeric. First reference plane electrical layer
number, the <Copper> <ElectricalLayer>.
The <Copper> < LayerType> must be set to
Plane, Mixed or Hatched.

<LowerPlaneLayer> Numeric. Second reference plane electrical
layer number, the <Copper>
<ElectricalLayer>. The <Copper>
<LayerType> must be set to Plane, Mixed or
Hatched.

When an impedance structure only has a
single reference plane (microstrip structures)
it is only necessary to specify the
UpperPlane.

Impedance structures with two reference
planes (stripline structures) must have both
the UpperPlane and LowerPlane specified
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<H1> Numeric. Substrate 1 height
<Er1> Numeric. Substrate 1 dielectric constant
<H2> Numeric. Substrate 2 height
<Er2> Numeric. Substrate 2 dielectric constant
<H3> Numeric. Substrate 3 height
<Er3> Numeric. Substrate 3 dielectric constant
<H4> Numeric. Substrate 4 height
<Er4> Numeric. Substrate 4 dielectric constant
<W1> Numeric. Lower trace width
<W2> Numeric. Upper trace width

W1 and W2 allows for a trapezoidal trace
shape to be defined. If the trace shape is
rectangular set W1 and W2 to the same
dimension

<S1> Numeric. Trace separation, for differential
structures only

<01> Numeric. Trace offset, for broadside
structures only

<G1> Numeric. Lower ground strip width, for

coplanar ground strip structures only

<G2> Numeric. Upper ground strip width, for
coplanar ground strip structures only

G1 and G2 allows for a trapezoidal ground
strip shape to be defined. If the ground strip
is rectangular set G1 and G2 to the same
dimension

Numeric. Ground strip separation, for

<D1> coplanar structures only
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<T1>

<REr>

<C1>

<C2>

<C3>

<CEr>

<Calculatedimpedance>

<Targetlmpedance>

<Tolerance>

<Notes>

<Note1>

<Note2>

<Note3>

<Note4>

<Note5>

<NetClasses>

<NetClass1>

<NetClass2>

<NetClass3>

Numeric. Trace thickness

Numeric value for the Dielectric (REr) for
resin rich area structures only.

Numeric. Coating above substrate

Numeric. Coating above trace

Numeric. Coating between traces for
differential structures only

Numeric. Coating dielectric constant

Numeric. Calculated impedance result in
ohms. Generated by Speedstack, so export
processor should leave this value at 0

Numeric. Structure target impedance value
in ohms

Numeric. Impedance + / - tolerance as a
percentage

User-definable notes fields

String

String

String

String

String

NetClass fields

String

String

String
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<NetClass4>

<NetClass5>

Frequency Dependent Properties

<FD_LengthOfLine>

<FD_TraceConductivity>

Speedstack calculates insertion loss over a
frequency range. All frequency parameters
are in Hz

<FD_FrequencyMin>

<FD_FrequencyMax>

<FD_FrequencySteps>

<FD_FrequencyOfinterest>

<FD_ResultPresentation>

Extended Substrate Data causal
extrapolation reference points. See page 96
of the Speedstack manual for further info. All
XML elements are included regardless of
structure type, only substrates used by the
structure will impact on the calculation result

<FD_ESD_SetRefPointsFromStackup_Er>

String

String

Numeric. Length of transmission line in
current units

Numeric. Trace Conductivity in Siemens per
metre (S/m)

Numeric. Hz

Numeric. Hz

Numeric integer. Number of frequency data
points to be calculated between Min and Max

Numeric. Hz

Numeric. Result presentation of frequency
dependent calculation. The mapping is as
follows:

O=per length of line (/LL)
1=per inch (/in)

2=per metre (/m)

Boolean. Controls the ‘Set Dielectric
Constant (Er) values from Stack Up
materials’ checkbox. Setting this value to
True auto-populates the Ref Er column,
False allows the user to key in the value(s)
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<FD_ESD_SetRefPointsFromStackup_TanD
>

<FD_ESD_H1RefFreqg>

<FD_ESD_H1RefEr>

<FD_ESD_H1RefTanD>

<FD_ESD_ H2RefFreg>

<FD_ESD_H2RefEr>

<FD_ESD_H2RefTanD>

<FD_ESD_H3RefFreqg>

<FD_ESD_H3RefEr>

<FD_ESD_H3RefTanD>

<FD_ESD_ H4RefFreqg>

<FD_ESD_H4RefEr>

<FD_ESD_H4RefTanD>

<FD_ESD_RErRefFreqg>

<FD_ESD_RErRefEr>

<FD_ESD_ RErRefTanD>

<FD_ESD_CErRefFreqg>

<FD_ESD_CErRefEr>

<FD_ESD_CErRefTanD>

Boolean. Controls the ‘Set Loss Tangent
(TanD) values from Stack Up materials’
checkbox. Setting this value to True auto-
populates the Ref TanD column, False allows
the user to key in the value(s)

Numeric. Hz
Numeric. Dielectric constant
Numeric. Loss tangent
Numeric. Hz
Numeric. Dielectric constant
Numeric. Loss tangent
Numeric. Hz
Numeric. Dielectric constant
Numeric. Loss tangent
Numeric. Hz
Numeric. Dielectric constant
Numeric. Loss tangent
Numeric. Hz
Numeric. Dielectric constant
Numeric. Loss tangent
Numeric. Hz

Dielectric constant

Numeric.

Numeric. Loss tangent
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Surface Roughness Compensation. See
pages 96 — 98 of the Speedstack manual for
further info. All XML elements are included
regardless of structure type, only roughness
surfaces used by the structure will impact on
the calculation result

<FD SRC Model> Numeric. The mapping is as follows:
0=Smooth

1=Hammerstad

2=Groisse

3=Huray

5=Gradient

<FD SRC RMS R1> Numeric. Surface 1 roughness RMS value in
- - - current units for Hammerstad / Groisse /
Gradient model

<FD_SRC_RMS_R2> Numeric. Surface 2 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model

<FD_SRC_RMS R3> Numeric. Surface 3 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model

<FD_SRC_RMS_R4> Numeric. Surface 4 roughness RMS value in

current units for Hammerstad / Groisse /
Gradient model

<FD_SRC_RMS_R5> Numeric. Surface 5 roughness RMS value in
current units for Hammerstad / Groisse /
Gradient model

Numeric. Surface 6 roughness RMS value in
<FD_SRC_RMS_R6> current units for Hammerstad / Groisse /
Gradient model

<FD_SRC_Huray_ RatioOfAreas> Numeric.
<FD_SRC_Huray_EffectiveBallRadius> Numeric. Must be in microns (um)
<FD_SRC_Huray NumberOfBallsinArea> Numeric.

<FD_SRC_Huray_AreaOfBallCount> Numeric. Area must be square microns (sq
pm)
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<FD_SRC_Huray_EnableCannonballHuray>

<FD_SRC_Huray_ RzMatte>

<FD_SRC_Huray_RzDrum>

<FD_IncludeOnReport>

Boolean. Determines whether Cannonball-
Huray mode is enabled

Numeric. Must be in microns (um)

Numeric. Must be in microns (um)

Boolean. Controls the ‘Include Loss Graph

for this structure on the report’ checkbox.
Setting this value to True allows the user to
nominate which structures will contain a
separate loss graph page

Numeric. As shown on the All Losses plot
(dB)

<FD_LossBudget>

Impedance Structure Guidance
Impedance structures must be placed appropriately on the defined sub-stack.

When specifying <UpperSignalLayer> and <LowerSignalLayer> they must be placed on electrical layers
where the <LayerType> is defined as “signal” or “mixed”.

When specifying <UpperPlaneLayer> and <LowerPlaneLayer> they must be placed on electrical layers

where the <LayerType> is defined as “plane”, “mixed” or “hatched”.
Often impedance structures do not require all parameters. Unused parameters fields should be set to 0.

The impedance calculation engine supplied with Speedstack contains 108 transmission line structures.
Explaining every structure is beyond the scope of this document, but details of the most commonly used
impedance structures are given below. Please contact polarcare@polarinstruments.com if you require
information on other structures

Surface Microstrip Structures
Name: Surface Microstrip 1B

Surface Microstrip 1B

Number: 11

Type: Single Ended

Usage: Used on outer layers of a stackup
when no solder mask is present
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Name: Edge Coupled Surface Microstrip 1B Edge-Coupled Surface Microstrip 1B

Number: 111
Type: Differential

Usage: Used on outer layers of a stackup
when no solder mask is present

Coated Microstrip Structures

Name: Coated Microstrip 1B Coated MiCI"OStI’ip 1B
Number: 51
Type: Single Ended

Usage: Used on outer layers of a stackup
when solder mask is present

Name: Edge Coupled Coated Microstrip 1B

Number: 151

Type: Differential

Usage: Used on outer layers of a stackup
when solder mask is present

Embedded Microstrip Structures

Name: Embedded Microstrip 1B1A

Embedded Microstrip 1B1A

Number: 22

Type: Single Ended

Usage: Used on inner layers of a stackup
when no reference plane exists between the
impedance signal layer and the surface
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Name: Edge Coupled Embedded Microstrip
1B1A

Number: 122

Type: Differential

Usage: Used on inner layers of a stackup
when no reference plane exists between the
impedance signal layer and the surface

Edge-Coupled Embedded Microstrip 1B1A

Offset Stripline Structures

Name: Offset Stripline 1B1A

Number: 32

Type: Single Ended

Usage: Used on inner layers of a stackup
when a reference plane exists above and
below the impedance signal layer

Offset Stripline 1B1A

Name: Edge Coupled Offset Stripline 1B1A

Number: 132

Type: Differential

Usage: Used on inner layers of a stackup
when a reference plane exists above and
below the impedance signal layer
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